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The Programs (which include both the software and documentation) contain proprietary information; they are
provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright,
patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the
Programs, except to the extent required to obtain interoperability with other independently created software or as
specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the
documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may
be expressly permitted in your license agreement for these Programs, no part of these Programsmay be reproduced or
transmitted in any form or by anymeans, electronic or mechanical, for any purpose.
If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of
the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS
Programs, software, databases, and related documentation and technical data delivered to U.S. Government
customers are “commercial computer software” or “commercial technical data” pursuant to the applicable Federal
Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure,
modification, and adaptation of the Programs, including documentation and technical data, shall be subject to
the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the
additional rights set forth in FAR 52.227-19, Commercial Computer Software–Restricted Rights (June 1987). Oracle
Corporation, 500 Oracle Parkway, Redwood City, CA 94065.
The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous
applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other
measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim
liability for any damages caused by such use of the Programs.
The Programsmay provide links toWeb sites and access to content, products, and services from third parties.
Oracle is not responsible for the availability of, or any content provided on, third-partyWeb sites. You bear all risks
associated with the use of such content. If you choose to purchase any products or services from a third party, the
relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party
products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of
products or services and warranty obligations related to purchased products or services. Oracle is not responsible for
any loss or damage of any sort that youmay incur from dealing with any third party.
Oracle, JD Edwards, PeopleSoft, and Retek are registered trademarks of Oracle Corporation and/or its affiliates.
Other namesmay be trademarks of their respective owners.
Open Source Disclosure
Oracle takes no responsibility for its use or distribution of any open source or shareware software or documentation
and disclaims any and all liability or damages resulting from use of said software or documentation. The following
open source software may be used in Oracle’s PeopleSoft products and the following disclaimers are provided.
This product includes software developed by the Apache Software Foundation (http://www.apache.org/). Copyright
© 1999-2000 The Apache Software Foundation. All rights reserved. THIS SOFTWARE IS PROVIDED “AS
IS’’ ANDANYEXPRESSEDOR IMPLIEDWARRANTIES, INCLUDING, BUTNOTLIMITEDTO, THE
IMPLIEDWARRANTIESOFMERCHANTABILITYANDFITNESS FORAPARTICULARPURPOSEARE
DISCLAIMED. INNOEVENT SHALLTHEAPACHE SOFTWAREFOUNDATIONOR ITSCONTRIBUTORS
BELIABLE FORANYDIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, ORCONSEQUENTIAL
DAMAGES (INCLUDING, BUTNOTLIMITEDTO, PROCUREMENTOF SUBSTITUTEGOODSOR
SERVICES; LOSSOFUSE, DATA, OR PROFITS; ORBUSINESS INTERRUPTION)HOWEVERCAUSED
ANDONANYTHEORYOFLIABILITY,WHETHER INCONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOROTHERWISE) ARISING INANYWAYOUTOFTHEUSEOFTHIS
SOFTWARE, EVEN IFADVISEDOF THE POSSIBILITYOF SUCHDAMAGE.
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About This PeopleBook Preface

PeopleBooks provide you with the information that you need to implement and use PeopleSoft applications.

This preface discusses:

• PeopleSoft application prerequisites.
• PeopleSoft application fundamentals.
• Documentation updates and printed documentation.
• Additional resources.
• Typographical conventions and visual cues.
• Comments and suggestions.
• Common elements in PeopleBooks.

Note. PeopleBooks document only page elements, such as fields and check boxes, that require additional
explanation. If a page element is not documented with the process or task in which it is used, then either
it requires no additional explanation or it is documented with common elements for the section, chapter,
PeopleBook, or product line. Elements that are common to all PeopleSoft applications are defined in this
preface.

PeopleSoft Application Prerequisites
To benefit fully from the information that is covered in these books, you should have a basic understanding
of how to use PeopleSoft applications.

You might also want to complete at least one PeopleSoft introductory training course, if applicable.

You should be familiar with navigating the system and adding, updating, and deleting information by using
PeopleSoft menus, and pages, forms, or windows. You should also be comfortable using the World Wide Web
and the Microsoft Windows or Windows NT graphical user interface.

These books do not review navigation and other basics. They present the information that you need to use the
system and implement your PeopleSoft applications most effectively.

PeopleSoft Application Fundamentals
Each application PeopleBook provides implementation and processing information for your PeopleSoft
applications.

Note. Application fundamentals PeopleBooks are not applicable to the PeopleTools product.
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For some applications, additional, essential information describing the setup and design of your system appears
in a companion volume of documentation called the application fundamentals PeopleBook. Most PeopleSoft
product lines have a version of the application fundamentals PeopleBook. The preface of each PeopleBook
identifies the application fundamentals PeopleBooks that are associated with that PeopleBook.

The application fundamentals PeopleBook consists of important topics that apply to many or all PeopleSoft
applications across one or more product lines. Whether you are implementing a single application, some
combination of applications within the product line, or the entire product line, you should be familiar with
the contents of the appropriate application fundamentals PeopleBooks. They provide the starting points
for fundamental implementation tasks.

Documentation Updates and Printed Documentation
This section discusses how to:

• Obtain documentation updates.
• Order printed documentation.

Obtaining Documentation Updates
You can find updates and additional documentation for this release, as well as previous releases, on the
PeopleSoft Customer Connection website. Through the Documentation section of PeopleSoft Customer
Connection, you can download files to add to your PeopleBook Library. You’ll find a variety of useful and
timely materials, including updates to the full PeopleSoft documentation that is delivered on your PeopleBooks
CD-ROM.

Important! Before you upgrade, you must check PeopleSoft Customer Connection for updates to the upgrade
instructions. PeopleSoft continually posts updates as the upgrade process is refined.

See Also
PeopleSoft Customer Connection, https://www.peoplesoft.com/corp/en/login.jsp

Ordering Printed Documentation
You can order printed, bound volumes of the complete PeopleSoft documentation that is delivered on your
PeopleBooks CD-ROM. PeopleSoft makes printed documentation available for each major release shortly
after the software is shipped. Customers and partners can order printed PeopleSoft documentation by using
any of these methods:

• Web
• Telephone
• Email

Web
From the Documentation section of the PeopleSoft Customer Connection website, access the PeopleBooks
Press website under the Ordering PeopleBooks topic. The PeopleBooks Press website is a joint venture
between PeopleSoft and MMA Partners, the book print vendor. Use a credit card, money order, cashier’s
check, or purchase order to place your order.
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Telephone
Contact MMA Partners at 877 588 2525.

Email
Send email to MMA Partners at peoplebookspress@mmapartner.com.

See Also
PeopleSoft Customer Connection, https://www.peoplesoft.com/corp/en/login.jsp

Additional Resources
The following resources are located on the PeopleSoft Customer Connection website:

Resource Navigation

Application maintenance information Updates + Fixes

Business process diagrams Support, Documentation, Business Process Maps

Interactive Services Repository Interactive Services Repository

Hardware and software requirements Implement, Optimize + Upgrade, Implementation Guide,
Implementation Documentation & Software, Hardware and
Software Requirements

Installation guides Implement, Optimize + Upgrade, Implementation Guide,
Implementation Documentation & Software, Installation
Guides and Notes

Integration information Implement, Optimize + Upgrade, Implementation Guide,
Implementation Documentation and Software, Pre-built
Integrations for PeopleSoft Enterprise and PeopleSoft
EnterpriseOne Applications

Minimum technical requirements (MTRs) (EnterpriseOne
only)

Implement, Optimize + Upgrade, Implementation Guide,
Supported Platforms

PeopleBook documentation updates Support, Documentation, Documentation Updates

PeopleSoft support policy Support, Support Policy

Prerelease notes Support, Documentation, Documentation Updates,
Category, Prerelease Notes

Product release roadmap Support, Roadmaps + Schedules

Release notes Support, Documentation, Documentation Updates,
Category, Release Notes
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Resource Navigation

Release value proposition Support, Documentation, Documentation Updates,
Category, Release Value Proposition

Statement of direction Support, Documentation, Documentation Updates,
Category, Statement of Direction

Troubleshooting information Support, Troubleshooting

Upgrade documentation Support, Documentation, Upgrade Documentation and
Scripts

Typographical Conventions and Visual Cues
This section discusses:

• Typographical conventions.
• Visual cues.
• Country, region, and industry identifiers.
• Currency codes.

Typographical Conventions
This table contains the typographical conventions that are used in PeopleBooks:

Typographical Convention or Visual Cue Description

Bold Indicates PeopleCode function names, business function
names, event names, system function names, method
names, language constructs, and PeopleCode reserved
words that must be included literally in the function call.

Italics Indicates field values, emphasis, and PeopleSoft or other
book-length publication titles. In PeopleCode syntax,
italic items are placeholders for arguments that your
program must supply.

We also use italics when we refer to words as words or
letters as letters, as in the following: Enter the letterO.

KEY+KEY Indicates a key combination action. For example, a plus
sign (+) between keys means that you must hold down
the first key while you press the second key. For ALT+W,
hold down the ALT key while you press the W key.

Monospace font Indicates a PeopleCode program or other code example.
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Typographical Convention or Visual Cue Description

“ ” (quotation marks) Indicate chapter titles in cross-references and words that
are used differently from their intended meanings.

. . . (ellipses) Indicate that the preceding item or series can be repeated
any number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode
syntax. Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

Visual Cues
PeopleBooks contain the following visual cues.

Notes
Notes indicate information that you should pay particular attention to as you work with the PeopleSoft system.

Note. Example of a note.

If the note is preceded by Important!, the note is crucial and includes information that concerns what you must
do for the system to function properly.

Important! Example of an important note.

Warnings
Warnings indicate crucial configuration considerations. Pay close attention to warning messages.

Warning! Example of a warning.

Cross-References
PeopleBooks provide cross-references either under the heading “See Also” or on a separate line preceded by
the word See. Cross-references lead to other documentation that is pertinent to the immediately preceding
documentation.
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Country, Region, and Industry Identifiers
Information that applies only to a specific country, region, or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a country-specific heading: “(FRA) Hiring an Employee”

Example of a region-specific heading: “(Latin America) Setting Up Depreciation”

Country Identifiers
Countries are identified with the International Organization for Standardization (ISO) country code.

Region Identifiers
Regions are identified by the region name. The following region identifiers may appear in PeopleBooks:

• Asia Pacific
• Europe
• Latin America
• North America

Industry Identifiers
Industries are identified by the industry name or by an abbreviation for that industry. The following industry
identifiers may appear in PeopleBooks:

• USF (U.S. Federal)
• E&G (Education and Government)

Currency Codes
Monetary amounts are identified by the ISO currency code.

Comments and Suggestions
Your comments are important to us. We encourage you to tell us what you like, or what you would like to
see changed about PeopleBooks and other PeopleSoft reference and training materials. Please send your
suggestions to:

PeopleSoft Product Documentation Manager PeopleSoft, Inc. 4460 Hacienda Drive Pleasanton, CA 94588

Or send email comments to doc@peoplesoft.com.

While we cannot guarantee to answer every email message, we will pay careful attention to your comments
and suggestions.
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Common Elements Used in PeopleBooks
Address Book Number Enter a unique number that identifies the master record for the entity. An

address book number can be the identifier for a customer, supplier, company,
employee, applicant, participant, tenant, location, and so on. Depending on the
application, the field on the form might refer to the address book number as
the customer number, supplier number, or company number, employee or
applicant id, participant number, and so on.

As If Currency Code Enter the three-character code to specify the currency that you want to use
to view transaction amounts. This code allows you to view the transaction
amounts as if they were entered in the specified currency rather than the
foreign or domestic currency that was used when the transaction was originally
entered.

Batch Number Displays a number that identifies a group of transactions to be processed by
the system. On entry forms, you can assign the batch number or the system
can assign it through the Next Numbers program (P0002).

Batch Date Enter the date in which a batch is created. If you leave this field blank, the
system supplies the system date as the batch date.

Batch Status Displays a code from user-defined code (UDC) table 98/IC that indicates the
posting status of a batch. Values are:
Blank: Batch is unposted and pending approval.
A: The batch is approved for posting, has no errors and is in balance, but it
has not yet been posted.
D: The batch posted successfully.
E: The batch is in error. You must correct the batch before it can post.
P: The system is in the process of posting the batch. The batch is unavailable
until the posting process is complete. If errors occur during the post, the
batch status changes to E.
U: The batch is temporarily unavailable because someone is working with
it, or the batch appears to be in use because a power failure occurred while
the batch was open.

Branch/Plant Enter a code that identifies a separate entity as a warehouse location, job,
project, work center, branch, or plant in which distribution and manufacturing
activities occur. In some systems, this is called a business unit.

Business Unit Enter the alphanumeric code that identifies a separate entity within a
business for which you want to track costs. In some systems, this is called a
branch/plant.

Category Code Enter the code that represents a specific category code. Category codes are
user-defined codes that you customize to handle the tracking and reporting
requirements of your organization.

Company Enter a code that identifies a specific organization, fund, or other reporting
entity. The company code must already exist in the F0010 table and must
identify a reporting entity that has a complete balance sheet.
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Currency Code Enter the three-character code that represents the currency of the transaction.
PeopleSoft EnterpriseOne provides currency codes that are recognized by
the International Organization for Standardization (ISO). The system stores
currency codes in the F0013 table.

Document Company Enter the company number associated with the document. This number, used
in conjunction with the document number, document type, and general ledger
date, uniquely identifies an original document.
If you assign next numbers by company and fiscal year, the system uses the
document company to retrieve the correct next number for that company.
If two or more original documents have the same document number and
document type, you can use the document company to display the document
that you want.

Document Number Displays a number that identifies the original document, which can be a
voucher, invoice, journal entry, or time sheet, and so on. On entry forms, you
can assign the original document number or the system can assign it through
the Next Numbers program.

Document Type Enter the two-character UDC, from UDC table 00/DT, that identifies the origin
and purpose of the transaction, such as a voucher, invoice, journal entry,
or time sheet. PeopleSoft EnterpriseOne reserves these prefixes for the
document types indicated:
P: Accounts payable documents.
R: Accounts receivable documents.
T: Time and pay documents.
I: Inventory documents.
O: Purchase order documents.
S: Sales order documents.

Effective Date Enter the date on which an address, item, transaction, or record becomes
active. The meaning of this field differs, depending on the program. For
example, the effective date can represent any of these dates:

• The date on which a change of address becomes effective.
• The date on which a lease becomes effective.
• The date on which a price becomes effective.
• The date on which the currency exchange rate becomes effective.
• The date on which a tax rate becomes effective.

Fiscal Period and Fiscal
Year

Enter a number that identifies the general ledger period and year. For many
programs, you can leave these fields blank to use the current fiscal period and
year defined in the Company Names & Number program (P0010).

G/L Date (general ledger
date)

Enter the date that identifies the financial period to which a transaction will be
posted. The system compares the date that you enter on the transaction to the
fiscal date pattern assigned to the company to retrieve the appropriate fiscal
period number and year, as well as to perform date validations.

xxvi PeopleSoft Proprietary and Confidential



PeopleSoft EnterpriseOne Tools Development
Tools: Report Design Aid Preface

This preface discusses Development Tools: Report Design Aid companion documentation.

Development Tools: Report Design Aid Companion
Documentation

Additional, essential information describing the setup and design of the PeopleSoft EnterpriseOne Tools
resides in companion documentation. The companion documentation consists of important topics that apply
to Development Tools: Report Design Aid as well as other PeopleSoft EnterpriseOne Tools. You should be
familiar with the contents of these companion PeopleBooks:

• Object Management Workbench
• Development Tools: Batch Versions
• Development Tools: Event Rules and System Functions
• Development Tools: Tables and Business Views
• Development Tools: APIs and Business Functions
• Development Tools: Data Structure Design
• Development Tools: Data Dictionary
• Development Guidelines for Application Design
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See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Object Management Workbench, “Understanding Object
Management Workbench”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Batch Versions, “Getting Started with
PeopleSoft EnterpriseOne Tools Development Tools: Batch Versions”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Event Rules and System Functions,
“Getting Started with PeopleSoft EnterpriseOne Tools Development Tools: Event Rules and Systems
Functions”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Tables and Business Views, “Getting
Started with PeopleSoft EnterpriseOne Tools Development Tools: Tables and Business Views”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: APIs and Business Functions, “Getting
Started with PeopleSoft EnterpriseOne Tools Development Tools: APIs and Business Functions”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Data Structure Design, “Getting
Started with PeopleSoft EnterpriseOne Tools Development Tools: Data Structure Design”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Data Dictionary, “Getting Started
with PeopleSoft EnterpriseOne Tools Development Tools: Data Dictionary”

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Guidelines for Application Design, “Getting
Started with PeopleSoft EnterpriseOne Tools Development Guidelines for Application Design”
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CHAPTER 1

Getting Started with PeopleSoft EnterpriseOne
Tools Development Tools: Report Design Aid

This chapter discusses:

• Development Tools: Report Design Aid overview
• Development Tools: Report Design Aid implementation

Development Tools: Report Design Aid Overview
Development Tools: Report Design Aid is used to present business data stored in the PeopleSoft EnterpriseOne
database. PeopleSoft EnterpriseOne data is stored in databases using relational tables. The data is typically
presented using batch applications that access the data through business views.

Development Tools: Report Design Aid Implementation
This section provides an overview of the steps that are required to implement Development Tools: Report
Design Aid.

Development Tools: Report Design Aid Implementation Steps
In the planning phase of your implementation, take advantage of all PeopleSoft sources of information,
including the installation guides and troubleshooting information. A complete list of these resources appears in
the preface in About These PeopleBooks with information about where to find the most current version of each.

This table lists the steps for the Development Tools: Report Design Aid implementation.

Step Reference

1. Set up permission to access and use Object Management
Workbench (OMW) using Security Workbench.

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Security
Administration, “Using Security Workbench,” Managing
Application Security

2. Add yourself to the system in a developer role so
that you have permissions to create PeopleSoft
EnterpriseOne objects.

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Object
Management Workbench, “Configuring User Roles and
Allowed Actions,” Setting Up User Roles

3. Set up permissions to create OMW projects. PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Object
Management Workbench, “Configuring User Roles and
Allowed Actions,” Setting Up Allowed User Actions
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Step Reference
4. Set up activity rules to allow you to promote projects

in OMW.
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Object
Management Workbench, “Configuring Activity Rules”

5. Set up save locations to enable you to save PeopleSoft
EnterpriseOne objects that are not ready to be checked
in.

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Object
Management Workbench, “Configuring Object Save
Locations”

6. Set up default locations and printers. PeopleSoft EnterpriseOne Tools 8.95 PeopleBook:
Development Tools: Report Printing Administration
Technologies, “Working with Report Printing
Administration”
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CHAPTER 2

Understanding PeopleSoft EnterpriseOne
Report Writing

This chapter discusses:

• Report writing.
• Report Design Aid.
• Report processing.
• Report components.

Report Writing
PeopleSoft EnterpriseOne provides fully integrated applications for managing information across the
enterprise. This information includes employee data, accounts receivable and payable information, financial
data, and product information. PeopleSoft EnterpriseOne enables you to view and evaluate this information to
make critical decisions to improve the business operation and profitability. You can also distribute this data to
others with whom you do business, such as shareholders, employees, and business consultants.

PeopleSoft EnterpriseOne provides reports across the Financial Management, Human Capital Management,
Logistics, and Manufacturing systems to meet many business needs. These reports can be easily processed to
be viewed online, in Portable Document Format (PDF), and exported to a spreadsheet program. However, to
help you meet all of the business needs, custom reports can be created using the PeopleSoft EnterpriseOne
report design tool. Using this tool, you can extract and present information that is vital to the business.

Reports that are used primarily to manipulate data are referred to as batch processes. Reporting and batch
processing can be combined in a single report.

The PeopleSoft EnterpriseOne reporting solution includes a report design tool to create reports and batch
processes, a batch engine for processing, and an output management system to output information.

Report Design Aid
You can use Report Design Aid to create a variety of simple and complex reports. The interface is simple
enough to use without programming expertise, yet powerful enough to create the most complex reports. You
can also use Report Design Aid to create batch processes and reports.
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Report Design Aid includes a director to guide you through the process of creating report templates. This
Report Director presents multiple reporting options from which to choose. You can create custom Directors to
aid in the creation of report templates. These Directors are configured to use report components to meet a
specific reporting requirement.

After using the director to create the initial report, you can enhance the report by:

• Inserting additional report sections
• Modifying properties
• Adding logic
• Further organizing the data
• Calculating totals

The design work space in Report Design Aid can be configured to compliment individual work preferences.
You can:

• Modify the report view options.

• Select which toolbars and windows to display.

• Arrange windows.

You can use Report Design Aid with terminal server. Just like in a traditional client server configuration, a
report template that is checked out using terminal server cannot be accessed by other users.

Report Processing
You cannot process a report without a batch version. The batch version is submitted for processing and can
be processed either locally or on the server. Typically, servers are faster, so processing on a server is more
efficient. Once submitted, a batch version runs without user interaction. You do not interact with the report
again until processing is complete.

Once you have submitted a batch version for processing, you have no control over the flow of the logic
attached. You must make changes to the flow of logic in Report Design Aid and resubmit the batch version.

Report Components
This section discusses:

• Introduction to reports

• Report objects

• Report templates

• Batch versions

• Report sections
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Introduction to Reports
A report exists as a set of specifications that are read by the PeopleSoft EnterpriseOne batch engine for
processing. You can create variations of a single report template using batch versions. The first step in creating
a report is to create a report object within PeopleSoft EnterpriseOne. This report is actually a template from
which multiple versions can be created.

Each report is comprised of sections. These sections are the building blocks of all reports. Within the template,
you can add, hide, remove, and rearrange sections as needed.

Report Objects
PeopleSoft EnterpriseOne is object-based. Each report template is considered a batch application with an
object type of Universal Batch Engine (UBE). When you add a report object, the system creates a header record
in the F9860 table. This header record contains information about the report, such as its name and description.

Report Templates
Report templates are the master specifications created in Report Design Aid. These specifications describe the
report to the batch engine and define how the data is selected, sorted, displayed, and formatted.

Note. When you create batch versions from the Report Director, the system uses the current report level
values. If you change the report level values prior to saving the report template and exiting Report Design Aid,
the new values transfer to the version. However, if you save the report template and exit Report Design Aid,
then reenter Report Design Aid and change the report level values, the modified report level values do not
affect any existing versions. New batch versions that you create do reflect the modified report level values.
Batch versions that you copy reflect the template specifications at the time the original version was created.

Batch Versions
Batch versions read the master specifications from the report template. However, batch versions typically
differ slightly from the report template. You can define different data selection, data sequencing, and
processing options for each batch version. There are also several report specifications that can be overwritten
at the version level, including data selection, data sequencing, event rules, and section layout. Batch versions
enable you to preserve template integrity while providing custom processing to meet a specific business
need. Instead of creating a separate template for multiple variations of a report, you can create one report
template with multiple batch versions.

See PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Batch Versions

Report Sections
Report sections are the basic components of a report. Most reports include more than one section. You can use
some sections for special purposes, such as performing calculations and totaling. Section types include:

• Report header sections
• Report footer sections
A report header section appears once at the beginning of the report. A report footer section appears once at
the end of the report on its own page. You typically populate these sections using constants and variables.
You can only define one of each of these sections per report.

• Page header sections
• Page footer sections
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A page header section appears at the beginning of each page of the report. A page footer section appears at
the bottom of each page of the report. You typically populate these sections using constants and variables.
You can only define one of each of these sections per report.

• Detail sections
Detail sections present the information that the report was designed to convey. The three types of detail
sections are:
- Columnar
- Group
- Tabular

From the Report Director in Report Design Aid, there is a fourth option for creating Application Reports. This
option actually uses one of the three types of detail sections already mentioned, columnar, group or tabular.
The section layout of a detail section is typically populated using fields from a business view. Business views
are used to access data from one or more database tables. Business views present a subset of data relevant to
the immediate business requirement. Selecting fields from a business view provides a link between the data in
the database and the report that you are creating.

In addition to the business view fields you select, you can define and add data fields to the detail report section,
such as data dictionary fields, constants, and variables.

• Level break header sections
You can define level break fields for use in level break header sections. Level break header sections are
used to further organize data.

• Level break footer sections

You define level break fields for use in level break footer sections. Level break footer sections are used
to calculate and display totals.

A level break occurs during the processing of a report when the value of a data sequencing field, which is also
defined as a level break field, changes. A set of records all with the same value for this defined field is in the
same level. For example, in a report that is sequenced by telephone numbers, where the area code is defined as
a level break field, all of the records having the same area code are in the same level. When the value of the
area code field changes, a level break occurs. Level breaks are used to group large amounts of data into more
manageable units. Level break headers provide a descriptive heading prior to the associated data. Level break
footers are used to include aggregates with descriptive labels in the report.

Detail Sections
Detail sections present the data required by the business need. This data is fetched from the PeopleSoft
EnterpriseOne database using a business view.

Within detail sections, you can:

• Attach a business view.
• Sequence data using business view fields.
• Define level breaks using fields from data sequencing.
• Filter data based on designated criteria.
• Present totals.
• Attach event rules (logic statements that you create and attach to report objects).
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You can include multiple detail sections in a report template. The guideline for the size of a report template is
not the number of sections but rather the physical size. A report design should not exceed a physical page
size of 45 inches in length and width. The Report Design interface includes rulers to help you keep the
report template within these parameters. Report templates that exceed this 45 inch parameter guideline may
encounter problems at runtime.

Characteristics of Columnar Sections
The columnar section format consists of column headings with rows of data under the headings. Each row is
considered a record. Due to the format of the columnar section, the column headings cannot be disconnected
from their associated variables. If either the column heading or column variable is deleted, the other is
also deleted.

This is an example of a columnar section:

Address Number Alpha Name Region Code Search Type

1001

1556

1785

3452

ABC Office Suppliers

XYZ Manufacturing

Abbot, Dominique

Paper Suppliers, Inc.

DEN

NYC

TOR

CHI

C

C

E

V

A columnar section

You can include multiple columnar sections in a report.

You can include level break headers and level break footers in columnar section reports. The level break
header displays above the column headings in columnar section reports. The level break footer displays totals
and other aggregates.

When to Use Columnar Sections
Use columnar sections when you want to display rows of data with column headings. This format is beneficial
when reviewing a large number of records with specific fields of interest. For example, you want to review the
salary of all the employees in the company.

Columnar sections can be joined to other columnar sections or group sections. Each section can have a
different business view attached. The sections are then joined on common fields.

You can define columnar sections as conditional, that is, the section is called from event rules only when
stated criteria is met.

Characteristics of Group Sections
Group sections enable you to arrange fields in a free-form layout; they are not restricted to a standard column
and row format. The group section type is the most flexible because you can place fields anywhere in the
section. Business view fields within group sections are composed of constants and variables. Initially, the
constant and variable are linked; however, you can disconnect the constant from the variable to meet the
reporting needs. Because of the free-form layout, group sections are almost always used for level break
footers and grand total sections.

This is an example of a group section:
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1001

1556

1785

3452

ABC Office Suppliers
DEN

XYZ Manufacturing
NYC

Abbot, Dominique
TOR

Paper Suppliers, Inc.
CHI

A group section

You can include multiple group sections in a report. You must insert level break header and footer sections in
group section reports to print organizational headers and totals.

When to Use Group Sections
Use group sections when a free-form layout is required to meet the reporting needs.

Group sections can be joined to other group sections or columnar sections. Each section can have a different
business views attached. The sections are then joined on common fields.

You can define group sections as conditional, that is, the section is called from event rules only when stated
criteria is met.

Characteristics of Tabular Sections
Tabular sections appear in the same column-and-row format as columnar sections. Three major differences
between columnar and tabular sections are that tabular sections offer:

• Spreadsheet functionality.
• Drill-down functionality.
• Row description columns.

These features make tabular sections suitable for presenting numerical data that needs to be summarized
with subtotals and grand totals. Typically, financial reports use tabular sections but tabular sections are not
exclusive to financial reporting.

This is an example of a tabular section:

Account Description

Revenue

Cost of Good

Gross Profit

General Expenses

Net Income

Net June Posting

376,697

272,091

104,606

63,911

168,517

A tabular section
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Within tabular sections, you can:

• Automatically calculate and display totals using level break fields.

• Automatically calculate and display grand totals.

• Define data selection at the column level.

• Define data selection at the row level.

• Define calculations at the cell level.

• Define the drill-down feature.

The drill-down feature enables you to research values in the report by creating a link between the report
output file and the associated PeopleSoft EnterpriseOne application.

You can include multiple tabular sections in a report. Tabular sections processes data based on the fields
you have defined as level break fields.

Tabular sections do not use level break headers or footers. You cannot join tabular sections to other sections.

Tabular sections automatically include a Row Description column. This column displays descriptions for rows,
based on data sequencing and level break fields. It is typically the first column in the tabular section.

Totaling is dynamic in a tabular section. If a column does not require totaling, you can override the totaling
function. Because the totaling logic is built into a tabular section, you do not have to use the level break footer
sections for totals. Therefor you can change the totaling without redesigning the report.

Advantages of Using Tabular Sections
These are the advantages of using tabular sections:

• Totaling is automatic.
• Audit trails can be created using the drill-down feature.
• Totaling levels can be changed easily by changing which fields are designated as level breaks.
• Multiple descriptions can be displayed in the Row Description column.

When to Use Tabular Sections
Use this criteria to help you determine when tabular sections will meet the reporting needs. You need to:

• Perform row level processing, such as calculations.
• Work with individual cell properties.
• Include totaling that is flexible enough to change easily.
• Define data selection at the column, row, or cell level.
• Calculate grand totals.
• Review detail at the application level using the drill-down functionality.

Characteristics of Report Header Sections
A report can contain only one report header, which prints once at the beginning of the report. The report header
can include the report title, the date when the report was processed, and a list of the names of the people who
receive the report. Typically, report headers include data fields such as, constants, alpha, numeric, and date
variables. You cannot attach business views to report headers.

This is an example of a report header on a report:
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XYZ Manufacturing

Fourth Quarter Financial Report

For the Period Ending 12/31/05

For Internal Use Only

A report header

Characteristics of Page Header Sections
A report can contain only one page header, which prints once at the beginning of each page of the report.
Page headers include a company name, page number, and date. Page headers are typically generated by
the system. However, you can manually create the page header and include data fields such as, constants,
runtime fields, alpha, numeric, and date variables.

This is an example of a page header on a report:

R55905                                           XYZ Manufacturing                               9/24/2006 09:15:03
                                                         Quarterly Sales                                                       Page:1

A page header

Characteristics of Page Footer Sections
A report can contain only one page footer, which prints once at the end of each page of the report. Page footers
might present an explanation of the contents of the report. Typically, page footers include data fields such
as, constants, alpha, numeric, and date variables.

This is an example of a page footer on a report:

This page reflects the revenue earnings for a single region or branch/plant.

Characteristics of Report Footer Sections
A report can contain only one report footer, which prints once at the end of the report. The report footer can
contain a reminder that the contents of the report are for internal use only. Typically, report footers include data
fields such as, constants, alpha, numeric, and date variables.

This is an example of a report footer on a report:

All information contained in this report is the legal and exclusive property of this company.
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CHAPTER 3

Creating Report Objects

This chapter provides overviews of the report design process and report object naming, and discusses how to:

• Create report objects.

• Create detail sections.

Understanding the Report Design Process
Before you create a report, you should design it so that it is functional, useful, and complete. A successful
report design begins with planning. Determine the report requirements by asking questions of the stakeholders,
create a model of the report, and determine which sections to include.

Surveying Stakeholders
Answer these questions to determine the report requirements:

• What is the purpose of the report?

• Who will use the report?

• What do the users want to see in the report?

• What information in the report will come directly from the database and what information needs to be
calculated?

• What are the best business views to use?

• Which data fields and records should be included in the report?

• In what order should the data be presented?

• What is the most effective format in which to present the information?

• Which reports are used to produce this information now?

• Does a report already exist that could be copied or modified?

• Will a new version of an existing report meet the business needs?

• How frequently will the report be run?

• Does the report output need to be exported to another software package using Output Stream Access (OSA)
or Comma Separated Values (CSV)?

Creating Report Models
Once you have determined the report requirements, create a report model. The report model helps you
determine the format of the data and what section types will meet the requirements.
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For example, you are creating a report to be used for invoicing or ordering. This example illustrates a report
model that meets this requirement:

R09450 34
Quarterly
Revenues

12/31/05
Page: 1

09:15:54

ABC Office Supplies - 1244

Doc Type

PV
PV

Doc Number

101
102

Due Date

07/31/05
08/15/05

Amount

225.00
225.00

Total Revenue  250.00

XYZ Manufacturing - 8856

Doc Type

PV
PV

Doc Number

505
506

Due Date

07/31/05
08/15/05

Amount

225.00
225.00

Total Revenue  450.00

Grand Total    700.00

Page Header Section

Level-Break Header
(Group Section)

Columnar Section

Level-Break Footer
(Group Section)

Grand Total
(Group Section)

Report model

Determining the Report Sections
After the you and the report requester agree on the model, determine the sections that are required to support the
model. You might conclude that the report needs a page header section to provide general information, a level
break header section to display each company’s address number and description, a columnar section to display
the business data, a level break footer section to calculate and display subtotals, and a grand total section.

To determine the sections that are required for a report, consider these questions:

• Is a report header required at the beginning of the report for clear and meaningful presentation of the
information?

• Is a report footer required at the end of the report to highlight an important function or fact about the report?
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• Is a page header required to present information on each page of the report?
• Is a page footer required to give the reader vital information on each page of the report?
• Does a business view exist that contains all of the data fields required by the report?
• Do you need to join two detail sections that use different business views?
• What is the best format to present the required information?
• Is the data best displayed in the free-form format of a group section?
• Is the data better presented in a columnar format of a columnar or tabular section?
• Do you need the flexibility of a tabular section to create rows in the report?
• If you use a group or columnar section, do you need to include level break footers for totaling?
• Would the automatic totaling features of a tabular section be more efficient?
• Can you use a Director template to help you create the report?
• Do you need to modify a Director template or create a new one?
• How should you sequence the fields and records from the business view?
• How should you filter the data from the business view?
• What enhancements can you apply to report objects to make the report more useful?
For example, do you want to emphasize the information in one column by changing the column spacing? Do
you want to change the font size of the contents of a column to call attention to the information?

• Are event rules required to define conditional, mathematical, or other logic for the report?
• Is an audit trail required?

After you have finished planning the design of the report, create the report in Report Design Aid.

Understanding Report Object Naming
To provide consistency for developers and users, all PeopleSoft EnterpriseOne objects follow standard naming
conventions. The naming conventions require that each object, such as a table, report, interactive application,
or business view, has a unique name. The naming conventions help you identify objects and prevent users
from creating objects with duplicate names.

See PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Guidelines for Application Design,
“Understanding PeopleSoft EnterpriseOne Naming Conventions,” Object Naming Conventions.

Creating Report Objects
This section provides overviews of default settings for reports, report objects, deleting report objects from
multiple locations, opening existing reports, and discusses how to:

• Create report objects from Report Design Aid.
• Create report objects from Object Management Workbench.
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• Copy report templates from Object Management Workbench.
• Delete report objects.
• Open report objects from Object Management Workbench.

Understanding Default Settings for Reports
A report is a UBE (Universal Batch Engine) object type. You must provide a report with an object name, a
description, and a product code to which the object is connected. After you create a report object, you can
save it and add object specifications at a later time.

When you create a new report, or other batch application, the system automatically applies these standards:

Report Component Default Standard

Font Appears in 7 point, Arial font.

Report name Appears in the upper-left corner of the page header.

Actual run date and runtime values Appears in the upper-right corner of the page header.

Page number Appears in the upper-right corner of the page header, under
the date and time.

Company name Appears in the center at the top of the page header.

Report titles Appears in the center at the top of the page header under the
company name.

Understanding Report Objects
When you create a new report object using Report Design Aid, you create a report template and, optionally, a
batch version. This instance is the only time that you can use Report Design Aid to create batch versions; all
other batch versions are created from the batch versions tools.

When you create a new report object, you need to provide information about the report:

Object Name Identifies the name of the report. Begin report names with the letter R,
followed by the product code, and then a unique identifier. The object name
displays in the upper-left corner of the page header.

Description Describes the purpose of the report. Enter a description that serves as a useful
identifier, such as “General Ledger by Batch.” The description displays in the
center of the page header below the company name.

Product Code Use product codes to ensure that the custom objects remain unaltered by
PeopleSoft EnterpriseOne software upgrades. Product codes 55–59 are
reserved for customers.

Product System Code Identifies the system where the required data resides. Typically, the report
shares the same product system code as the business view to be attached.

Object Use Use this range of codes to classify the report. Object use codes 160–166
are report-related classifications.
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Update Report/No Update
Report

Indicates whether the report updates data in the database. Only report
developers with permissions can design an Update Report. If the developer
has permissions, the Update Report option is selected by default.

Note. If you do not have permission to create an Update Report, the option does not display and the No
Update Report option is selected. The system administrator defines permissions for the update option through
PeopleSoft EnterpriseOne security.

Understanding Deleting Report Objects From Multiple Locations
You can delete batch versions and report templates from the system. If you delete a report template, all of its
batch versions are deleted automatically.

You can delete report objects from these locations:

• The check-in server.
• The local environment.
• The Save location.
• The Transfer locations.
• All locations.

Note. The objects must be checked in and you must possess the proper role and permissions to delete objects.

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Object Management Workbench, “Working with Objects,”
Deleting Objects

Understanding Opening Existing Reports
You can open an existing report in Report Design Aid and make modifications.

You can open either a report template or a batch version. If you open and modify a report template, the changes
are reflected in the associated versions (unless prohibited by overrides in the batch versions). You can open a
batch version to modify it without affecting the report template or other associated versions.

When you open an existing report, the Report Director is not available to assist with changes. Rather, the
report template or batch version opens automatically to the Report Design form. You can open a report object
in the Report Design form, which you access directly from Solution Explorer or from Object Management
Workbench. To open a report object in Object Management Workbench, you must add the report object
to a project

Creating Report Objects From Report Design Aid
In Solution Explorer, select the Report Management menu (GH9111) and select Report Design Aid to access
the PeopleSoft Report Design Aid form.

1. Click New.
2. On the Create New Report form, in the Report Name field, enter a name for the report template.
3. In the Description field, enter a description that identifies the purpose of the report.
4. In the Product Code field, enter a value between 55–59.
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5. Select either the Update Report or No Update Report option and click OK.
6. Use the Report Director to design the report.
7. On the final page of the Report Director, select to create a version of the report template and name the
version.

Creating Report Objects From Object Management Workbench
In Solution Explorer, from the Tools menu, select Object Management Workbench to access the Object
Management Workbench form.

1. Click Find.
2. In the project view, expand the project to which the new report object will be added.

3. Click the Objects node of the project and click Add.

4. On the Add EnterpriseOne Object to the Project form, select to create a Batch Application, and click OK.

5. On the Add Object form, in the Object Name field, enter the name of the report template.

6. In the Description field, enter a description that identifies the purpose of the report.

7. In the Product Code field, enter a value between 55–59.

8. In the Product System Code field, enter the system code that reflects where the required data resides.

9. In the Object Use field, enter a value between 160–166.

10. Select either the Update Report or No Update Report option and click OK.

11. On the Batch Application Design form, select the Design Tools tab, and click Start Report Design Aid.

12. Use the Report Director to design the report.

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Object Management Workbench, “Working with Objects,”
Adding Objects to Projects

Copying Report Templates FromObject ManagementWorkbench
Access the Object Management Workbench form.

1. Click Find.
2. In the project view, expand the project where the report template you want to copy resides.

3. Expand the Objects node, click the report, and then click Copy.

4. On the Copy Object form, in the Copy to field, enter the name of the new report template.

5. In the Description field, enter a description that identifies the purpose of the report.

6. In the Product Code field, enter a value between 55–59.

7. In the Product System Code field, enter the system code that reflects where the required data resides

8. In the Object Use field, enter a value between 160–166.

9. Select either the Update Report or No Update Report option and click OK.

10. On the Batch Application Design form, select the Design Tools tab, and click Start Report Design Aid.

11. Use the Report Director to design the report.
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Deleting Report Objects
Access the Object Management Workbench form.

1. Click Find.
2. In the project view, expand the project where the report object resides.
3. Expand the Objects node, click the report, and then click Delete.
4. On the Delete of form, select one of these options and click OK:
• Delete Object from Server.
• Delete Object Locally.
• Delete Object from the SAVE Location.
• Mark Object to be Deleted from Transfer Locations.
• Remove Object from ALL Locations.
Select this option to select all delete options.
The deleted object appears in bold text in the project view. If the system administrator has set options
to allow immediate deletion, the system deletes the object when you exit PeopleSoft EnterpriseOne.
Otherwise, the object is deleted when the project is advanced.

Opening Report Objects From Object Management Workbench
Access the Object Management Workbench form.

1. Click Find.
2. In the project view, expand the project where the report object resides.
3. Expand the Objects node, click the report object you want to open, and then click the Design action button.
4. If you select a report template, on the Batch Application Design form, select the Design Tools tab, and
click Start Report Design Aid.

5. If you select a batch version, on the Batch Version Design form, select the Tools tab, and click Report
Design.

Warning! Batch versions beginning with XJDE or ZJDE are owned by PeopleSoft EnterpriseOne and
should not be modified. If you want to modify one of these batch versions, copy the version, name it
according to the naming conventions, and modify the copied version. This ensures that the custom version
is not altered by future releases or software updates.

Creating Detail Sections
This section provides an overview of detail sections and discusses how to:

• Add detail sections.
• Select business views.
• Select business views form the Select Business View tab.
• Select business views form the Favorite Business Views tab.
• Add business view columns using Quick Section.
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• Define section data sequencing.
• Define sort properties.
• Define section data selection.

Understanding Detail Sections
In Report Design Aid, the Report Director initially guides you through the steps of creating a report template.
You might, however, need to modify an existing section or add columnar, group, or tabular sections to an
existing report template. You can accomplish these tasks in Report Design Aid.

To add detail sections to an existing report template, select the section type from the menu in Report Design
Aid. The Report Director guides you through the steps of creating the new detail section. This topic describes
how to add a detail section to a report template.

Note. PeopleSoft EnterpriseOne supports Arabic and the right-to-left display preferences for the Microsoft
Windows client, web client, and UBEs. However, when designing a report, you must design it from left to
right. When you generate the report by printing it or generating a PDF, it displays information right to left,
including the alignment of text and numeric strings. The system displays strings that contain a mixture of
Arabic and non-Arabic characters in accordance with generally accepted bidirectional standards.

Add Detail Sections
In Report Design Aid, you can create as many group, columnar, and tabular sections in a report template as
required. You design each detail section by attaching a business view and then selecting individual columns
from that business view to include in the section layout.

Select Business Views
Business views are the link between the report and the data in the PeopleSoft EnterpriseOne database.
They present data fields from one or more tables and limit the column selection to columns relevant to the
business requirement of the report. Business views also improve performance by moving only the required
fields across the network.

You can select a business view for a detail section using one of two methods:

• Favorite Business Views
Select from a list of business views users have defined as favorites.

• Select Business Views
Use the QBE (Query by Example) line to filter through all business views in the system. You can filter by
product code, business view name, entire or partial description, or leave the QBE line empty to return all
business views.
Business view names begin with the letter V and contain a maximum of 10 characters. The name is formatted
as VxxzzzzzzzA, where the variable characters represent this information:
- xx is the product code (55-59 is reserved for clients).
- zzzzzzz is the characters of the primary table.
- A indicates the sequence in which the business view was created over the primary table.

No matter which method you use to select a business view, the title bar of the detail section reflects the
selected business view.
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See PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Tables and Business Views,
“Designing Business Views”.

Add Business View Columns to Detail Sections
Business views present data fields from one or more tables. They limit the column selection to only those
columns that are relevant to the business requirement of the report. You select the required fields for the report
layout from the attached business view.

Use Quick Section to manually select data fields from a business view for the initial section layout. This
is necessary when you create a detail section manually, without the aid of the Report Director. After the
design of the report template is complete, insert additional business view columns into a detail section using
the Business View Columns Browser.

Define Section Data Sequencing
Use data sequencing to indicate the order in which the system should read records from the database and
display them in the report section. For example, define data sequencing to display records in a report section
by address book number and then by name.

PeopleSoft EnterpriseOne sorts records in a report section by any column included in the attached business
view, regardless of whether you included the column in the section layout. Therefore, the business view
columns that you select for data sequencing do not need to match the business view columns selected on the
Section Layout form.

Define Sort Properties
After you select business view fields for use in data sequencing, you can define sort properties for those fields.
The sort properties determine whether:

• Records are sorted in ascending or descending order.
The system displays an up arrow for ascending order by default. Click the arrow once to display a down
arrow for descending order.

• Sequencing fields should trigger level breaks.
Select this option to trigger a level break when the value of the field changes.

• Level break field should produce a page break.
Select this option to begin each unique value for the level break field on a new page.

Note. To set an field as a page break, you must first define the field as a level break.

For example, you can sequence records by search type in ascending order, designate search type as a level
break, and begin each unique search type on a new page.

Define Section Data Selection
Use data selection to define criteria whereby only specific, relevant records are included in the report section.
For example, define data selection to display records for hourly employees only.

PeopleSoft EnterpriseOne filters data in a report section by any column included in the attached business view,
regardless of whether you included the column in the section layout.

The operator for the first line of data selection is Where. The operator for additional lines of data selection is
either And or Or. You complete the first line of the data selection by selecting a left operand, a comparison, and
a right operand. The left operand must be a column from the attached business view.
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To limit the records retrieved from the PeopleSoft EnterpriseOne database, specify data selection criteria
using one of these comparisons:

• is equal to.
• is equal to or empty.

• is greater than.

• is greater than or equal to.

• is less than.
• is less than or equal to.

• is not equal to.

Use the valid comparisons between the left operand, data fields included in the business view, and the
right operand. The options available in the right operand column depend on the selection you made in the
Comparison column. Available options include:

Option Description

<Blank> Enters a blank (space) value.

<Literal> Enables you to enter specific values.

<Null> Indicates that no value is associated with the field.

<Zero> Enters a value of zero.

BC Indicates a business view column.

RI Indicates a value passed through a report interconnect to
this report.

PC Indicates a previous business view column.

PO Indicates a processing option value available for this report.

PV Indicates the previous value for the variable.

RC Indicates a constant from this report.

RV Indicates a variable from this report.

SV Indicates a system variable.

SL Indicates a system value.

TV Indicates a text variable.

VA Indicates an event rule variable.

The Range of Values form enables you to enter:

• A single value
A single value might be a specific company.
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• A range of values
A range of values might include companies 00001 to 00060. Only is equal to and is not equal to are valid
comparisons when using range of values.

• A list of values
Enter a list of values that are not sequential and click Add after each entry. Delete a value by selecting the
value, and then click Delete.
A list of values might include several user defined codes for search types such as C for Customers, E for
Employees, and V for Suppliers. Only is equal to and is not equal to are valid comparisons when creating
a list of values.

Adding Detail Sections
Access Report Design Aid.

1. Open a report template.

2. From the Section menu, select Create, and select one of these detail section types:

• Group
• Columnar
• Tabular

3. Use the Report Director to design the section.

Selecting Business Views
Open a report template in Report Design Aid.

1. Click inside the detail section of the report.
2. From the Section menu, click Select Business View.
3. On the Business View Director, select a tab and proceed to the appropriate instructions:
• Select Business View
• Favorite Business Views

Selecting Business Views from the Select Business View Tab
Access the Business View Director.

1. Select the Select Business View tab.
2. On the Select Business View form, enter the business view name on the Object Name QBE line and
click Find or press ENTER.

3. Select a business view, and click OK.

Selecting Business Views from the Favorite Business Views Tab
Access the Business View Director.

1. Select the Favorite Business Views tab.

2. From the Favorites view, click the + button to expand each folder until you locate the required business view.
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3. Select the Description tab to view a brief description of the business view that you have selected.
4. Select the Columns tab to view the data fields that are included in the business view that you have selected.
5. When you are certain that you have selected the appropriate business view, click OK.

See Also
Chapter 14, “Setting Up Business Views as Favorites,” page 123

Adding Business View Columns Using Quick Section
Open a report template in Report Design Aid.

1. Click a detail section of the report that includes an attached business view but no fields.
2. From the Section menu, select Quick Section.
3. On the Quick Section form, from the Available Business View Columns, click a required column and
perform one of these tasks:
• Click the right arrow to move the column to Selected Columns.
• Drag the column to Selected Columns.
You can move multiple columns to Selected Columns by using the SHIFT or CTRL keys.

• Click the right double-arrow to move all columns to Selected Columns.
4. To remove columns from the report layout, click a column from the Selected Columns list and perform
one of these tasks:
• Click the left arrow or press Delete to remove the selected column.
You can remove multiple columns by using the SHIFT or CTRL keys.

• Click the left double-arrow to remove all columns.
5. To change the order that the columns display on the report, click a column from the Selected Columns list
and perform one of these tasks:
• Click the up or down arrows to move the selected column up or down one position in the list.
• Drag the selected column to another position in the list.
• Click the up or down double arrows to move the selected column to the top or bottom of the list.

6. Complete the layout of the section and click OK.

Defining Section Data Sequencing
Open a report in Report Design Aid.

1. Click a detail section of the report in which the section layout is defined.

2. From the Section menu, select Define Data Sequence.

3. On the Data Sequencing form, select the Section Data Sequencing tab.

4. To select columns for data sequencing, from the Available Columns list, click a column, and perform
one of these tasks:

• Click the right arrow to move the column to Selected Columns.
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• Drag the column to Selected Columns.
You can move multiple columns to Selected Columns by using the SHIFT or CTRL key.

• Click the right double-arrow to move all columns to Selected Columns.
5. To remove columns from the data sequencing, from the Selected Columns list, click a column, and
perform one of these tasks:
• Click the left arrow or press Delete to remove the selected column.
You can remove multiple columns by using the SHIFT or CTRL key.

• Click the left double-arrow to remove all columns.
6. To change the order of the fields that are used to sort the section data, click a column in the Selected
Columns list, and perform one of these tasks:
• Click the up or down arrow to move the selected column up or down one position in the list.
• Drag the selected column to another position in the list.
• Click the up or down double arrows to move the selected column to the top or bottom of the list.

Defining Sort Properties
Access the Data Sequencing form.

1. Click the Define Sort Properties tab.

2. Complete the Sort Order field for each sort column.

3. Click these fields as appropriate and click OK:

• Level Break
• Page Break

Defining Section Data Selection
Open a report in Report Design Aid.

1. Click a detail section of the report that has a business view attached.
2. From the Section menu, select Define Data Selection.
3. On the Data Selection form, Where is displayed in the Operator column for the first set of criteria.
4. Click in the Left Operand column to display the list of available business view fields, and perform one of
these tasks:
• Scroll through the list until you find the required business view field, then double-click the field to
populate the Left Operand column.

• Begin entering the business view field name in the Left Operand field. The system presents the first
business view field in the list that matches the criteria, continue entering the field name until the required
field appears, then double-click the field.
When you double-click the business view field for the Left Operand column, the list in the Comparison
column appears.

5. Select a comparison operator.
When you double-click the comparison operator, the list in the Right Operand column appears.
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6. In the Right Operand column, select from the available objects, special values, and variables.
7. To delete a line of criteria on the Data Selection form, click the row header to highlight the row, and
then click the Delete button at the top of the form.

8. To change the order of the criteria, click the row header to highlight the row, and then click the up
or down button.
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Using the Report Director

This chapter provides an overview of the Report Director and discusses how to:

• Create columnar sections.
• Create group sections.
• Create tabular sections.
• Create application reports.
• Save and review reports.

Understanding the Report Director
The Report Director (Director) provides a quick start to designing reports by guiding you through a linear
process to set up basic elements for a report template. Using the Director, you can include only one detail
section in the report template. As you proceed through the Director, you answer simple questions, such as
whether to include header and footer sections, which type of detail section to create, which business view to
use to fetch the required data, which fields to include in the detail section, and how to sequence and sort the
records in the detail section. Based on the answers to these questions, the Director creates a report template
and opens it in Report Design Aid. You can then use Report Design Aid to format the data, enhance the
report, and add additional detail sections.

The Director uses templates to guide you through the creation of application reports. These templates
define default criteria, such as a recommended business view, smart fields, data selection, data sequencing
and processing options. When you select a template from the Director, the Director reads the template
specifications (which are stored in PeopleSoft EnterpriseOne tables) and presents the default criteria through
the Director forms. Several Director templates are included in the PeopleSoft EnterpriseOne software. You can
create custom templates from the Report Director Templates (P91400) application.

On the Welcome to the Report Design Director form, you can select from these section options:

• Report header
• Page header
• Columnar
Columnar report sections include a columnar format that includes column headings with rows of data.

• Group
Group report sections provide a free-form layout that enables you to place fields exactly where you want
them.

• Tabular
Tabular report sections include a columnar format with additional features unique to the tabular section type.
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• Application Reports
Application reports are reports that use the Report Director templates. The default application report is
Financial Reports. Use the drop-down to select from available Report Director templates. The Report
Director template determines the detail section type created by the system.

• Page footer
• Report footer

If you want to design a report without the assistance of the Director, you can click Finish or Cancel to exit the
Director. Finish accepts the selections you have already made using the Director. Cancel ignores any options
that you have selected. You can then build the report manually, section by section, within Report Design Aid.

Creating Columnar Sections
This section provides an overview of columnar sections, lists the prerequisite, provides a sample columnar
section report, and discusses how to:

• Select sections to include in columnar section reports.
• Select business views.
• Select business view columns.
• Define section data sequencing.
• Define sort properties.
• Select records to include.
• Create batch versions of reports from the Director.

Understanding Columnar Sections
The columnar section report presents information from a business view in a columnar format. Each data field
is a column and each record is a row.

Use the Report Director to design a columnar section report. The Report Director guides you through the
process for creating a columnar section report by asking you questions about the structure and content of the
report. The Report Director includes a navigation assistant that tracks where you are in the report development
process. You can right-click the navigation assistant and click Hide to hide it for the current design process.

After you finish creating the report, you can enhance it by using additional features of Report Design Aid.

See Also
Chapter 14, “Setting Up Business Views as Favorites,” page 123

Part 3, “Advanced Report Enhancements,” page 131

Prerequisite
Create a batch application object. The system automatically opens the Welcome form of the Report Director as
the last step in creating a batch application object.
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Selecting Sections to Include in Columnar Section Reports
Access the Welcome to the Report Design Director form.

1. Select from the header and footer options available.
2. Select the Columnar option, and click Next.
If you selected to include a page header in the report, the Page Header Details form appears.

Note. If you did not select to include a page header in the report, the Business View Selection Option form
appears. You may skip the rest of the steps in this task.

3. On the Page Header Details form, select these options to allow the system to automatically populate the
page header section:

• Automatically add the default informational fields shown below to my page header section.

• Automatically add the default informational fields Page n or Total to my page header section.

Select this option to include the Page n of Total field in the page header. You must also select the first
option if you want to include all fields in the page header.

Note. After you complete the design of the entire report using the Report Director, you can add or delete
fields from the page header.

If you do not select either of these page header options, the system creates an empty page header. You
can manually add fields to the page header from the Section menu in Report Design Aid.

4. Click Next.
The Business View Selection Option form appears.

Selecting Business Views
Access the Business View Selection Option form.

1. Select one of these business view options and click Next:

• I’d like help finding an appropriate business view.

• I’ll find a business view myself.

2. Select the required business view and click Next.

Selecting Business View Columns
Access the Section Layout form.

1. From the Available Business View Columns list, select the columns to include in the columnar section,
and click the right arrow to move them to the Selected Columns list.
You can select multiple columns using the CTRL or SHIFT keys. You can also drag each column
individually into the Selected Columns list, or you can click the right double arrow to move all of the
columns from the Available Business View Columns list to the Selected Columns list.
Columns appear in the columnar section from left to right in the order that they are listed in the Selected
Columns list.
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2. To remove columns from the section layout, select a column in the Selected Columns list, and click the
left arrow to move it to the Available Business View Columns list.
You can also click the left double arrow to remove all of the columns from the Selected Columns list.

3. To change the display order of the columns in the columnar section, select a column in the Selected
Columns list, and click the up or down arrows to move the selected column up or down one line in the list.
You can also drag a column to a new location in the list, or you can click the up or down double arrows to
move the selected column to the top or bottom of the list.

4. When you complete the section layout, click Next.

Defining Section Data Sequencing
Access the Section Data Sequencing form.

1. Select columns for sequencing from the Available Columns list, and click the right arrow to move them
to the Selected Columns list.

You can select multiple columns, remove columns and change the order of columns in the same manner as
on the Section Layout form.

Note. To define sort properties in the next task, you must select columns in this task.

2. When you complete the data sequencing for the section, click Next.

Defining Sort Properties
Access the Define Sort Properties form.

1. Click the arrow in the Sort Order field until it reflect your preference of ascending or descending order.

2. To specify level and page breaks, click these fields:

• Level Break
• Page Break

3. When you are finished, click Next.

Selecting Records to Include
Access the Data Selection form.

1. Click the Operator field and select Where as the operator.
2. In the Left Operand field, select from the list of available business view columns.
3. In the Comparison field, select from the list of available options.
4. In the Right Operand field, select from the list of available objects.
5. To delete a line of criteria on the Data Selection form, click the row header to highlight the row, and
then click the Delete button at the top of the form.

6. To change the order of the criteria, click the row header to highlight the row, and then click the up
or down button.

7. When you have completed the selection criteria, click Next.
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Creating Batch Versions of Reports From the Director
Access the Finish form of the Report Director.

1. Select Yes, create a version of this report to automatically generate a batch version of the report template.
2. Enter the version name in the field beneath Yes, create a version of this report.
3. To review the selections, click Back to move backwards through the Director forms.
On the Navigation Assistant, you can also click the name of the form that you want to review.

4. When you are satisfied, click Finish.

Important! When you click Finish, you can no longer access the Director for this report. Before you click
Finish, you have an opportunity to review the selections on all forms of the Report Director.

Creating an Example Columnar Section Report
This sample columnar section report, which is used for annual salary reviews, was created using the Report
Director. The V060116A - Employee Master business view is attached to the columnar section, and these
business view columns were selected for the section layout:

• Address Number

• Name - Alpha
• Business Unit - Home

• Pay Class (H/S/P)

• Date - Original Employment

• Rate - Salary, Annual

A columnar section format was selected for this report because the information is best displayed in rows and
columns. The columnar format makes it easy to review the salary column by employee.

Access Report Design Aid.

1. From the File menu. select New.

2. On the Create New Report form, in the Report Name field, enter R55060116.

3. In the Description field, enter Annual Salary Review.

4. In the Product Code field, enter 55.

5. Select the No Update Report option and click OK.

6. On the Welcome to the Report Design Director form, select Page Header and Columnar, and click Next.

7. On the Page Header Details form, click Next to accept the default.

8. On the Business View Selection Option form, select the option I’ll find a business view myself, and
click Next.

9. On the Select Business View form, locate and select the V060116A - Employee Master business view,
and click Next.

10. On the Section Layout form, use the horizontal arrow buttons to select these columns, in the order listed,
and move them to the Select Columns list:

• Address Number
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• Name - Alpha
• Business Unit - Home
• Pay Class (H/S/P)
• Date - Original Employment
• Rate - Salary, Annual

11. When the selected columns are arranged as indicated, click Next.
12. On the Data Sequencing form, use the horizontal arrow buttons to select and move the Name - Alpha
column to Selected Columns, and click Next.

13. On the Define Sort Properties form, sort the Name - Alpha field in ascending order and click Next.
14. On the Data Selection form, click Next.
No data selection is required for this example.

15. On the Finish form, select Yes, create a version of this report and enter VER0001 as the version name.
16. Click Finish.
17. On the PeopleSoft Report Design Aid form, click Save on the toolbar to save the report.
18. Select the Preview tab to view the report.
19. On the Preview tab, select Yes.
20. From the File menu, select Exit to exit Report Design Aid.

Creating Group Sections
This section provides an overview of group sections, lists the prerequisite, provides a sample group section
report, and discusses how to:

• Select sections to include in group section reports.

• Select business views.

• Select business view columns.

• Define section data sequencing.

• Define sort properties.

• Select records to include.

• Create batch versions of reports from the Director.

Understanding Group Sections
Group sections provide flexibility in arranging the data in the report section. A group of fields in a group
section represents data from one record. Each business view field consists of a constant, or field description,
and a variable.
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When you select business view columns for the group section layout, you specify how many of the fields to list
vertically before the next vertical grouping begins. The Number of Columns field appears below the Available
Business View Columns list. The Number of Columns value determines how Report Design Aid organizes
fields in a group section. For example, if you select six fields and enter 3 in the Number of Columns field, the
fields in the section are organized in three columns, each including two business view fields. The first two
fields display in the first column in the same order that they appear in the Selected Columns list. The next two
fields display in the second column in the same order that they appear in the Selected Columns list. The last
two fields display in the third column in the same order that they appear in the Selected Columns list. If you
enter 2 in the Number of Columns field, the business view fields are arranged in two columns, each column
includes three business view fields. The Number of Columns default value is 2.

This example illustrates how the columns are organized in a group section based on the number of columns
indicated:

BV Column  1

BV Column 2

BV Column  3

BV Column 4

BV Column  5

BV Column 6

Number of Columns = 3

BV Column  1

BV Column 2

BV Column 3

Number of Columns = 2

BV Column  1

BV Column 2

BV Column 3

Number of columns

Note. The term business view column might be confusing when talking about group sections because group
sections are not organized in a columnar format. A business view column refers to the column name in the
table. In group sections, the business view column data is displayed in a columnar format, in columnar and
tabular sections, and in a free-floating field in group sections.

After you create a new report object, use the Report Director to design a group section report. The Report
Director directs you through a linear process for creating a group section report by asking you questions about
its structure and content. When you have finished creating the report, you can enhance it by using additional
features of Report Design Aid.

See Also
Part 2, “Basic Report Enhancements,” page 51

Part 3, “Advanced Report Enhancements,” page 131

Prerequisite
Create a batch application object. The system automatically opens the Welcome form of the Report Director as
the last step in creating a batch application object.
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Selecting Sections to Include in Group Section Reports
Access the Welcome to the Report Design Director form.

1. Select from the header and footer options available.
2. Select the Group option, and click Next.
If you choose to include a page header in the report, the Page Header Details form appears. If you do not
choose to include a page header, the Business View Selection Option form appears. You may skip the
rest of the steps in this task.

3. On the Page Header Details form, select these options to automatically populate the page header section:
• Automatically add the default informational fields shown below to my page header section.
• Automatically add the default informational fields "Page n or Total" shown below to my page header
section.

4. Click Next.

Selecting Business Views
Access the Business View Selection Option form.

1. Select one of these business view options and click Next:
• I’d like help finding an appropriate business view.
• I’ll find a business view myself.

2. Select the required business view and click Next.

Selecting Business View Columns
Access the Section Layout form.

1. From the Available Business View Columns list, select the columns to include in the columnar section,
and click the right arrow to move them to the Selected Columns list.

2. To remove columns from the section layout, select a column in the Selected Columns list, and click the
left arrow to move it to the Available Business View Columns list.

3. To change the display order of the columns in the columnar section, select a column in the Selected
Columns list, and click the up or down arrows to move the selected column up or down one line in the list.

4. Enter a value in the Number of Columns field.

5. When you complete the section layout, click Next.

Defining Section Data Sequencing
Access the Data Sequencing form.

1. Select columns for sequencing from the Available Columns list, and click the right arrow to move them
to the Selected Columns list.
You can select multiple columns, remove columns and change the order of columns in the same manner as
on the Section Layout form.

Note. To define sort properties in the next task, you must select columns in this task.
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2. When you complete the data sequencing for the section, click Next.

Defining Sort Properties
Access the Define Sort Properties form.

1. Click the arrow in the Sort Order field until it reflect your preference of ascending or descending order.

2. To specify level and page breaks, click these fields:

• Level Break
• Page Break

3. When you are finished, click Next.

Selecting Records to Include
Access the Data Selection form.

1. Click the Operator field and select Where as the operator.
2. In the Left Operand field, select from the list of available business view columns.
3. In the Comparison field, select from the list of available options.
4. In the Right Operand field, select from the list of available objects.
5. To delete a line of criteria on the Data Selection form, click the row header to highlight the row, and
then click the Delete button at the top of the form.

6. To change the order of the criteria, click the row header to highlight the row, and then click the up
or down button.

7. When you have completed the selection criteria, click Next.

Creating Batch Versions of Reports From the Director
Access the Finish form of the Report Director.

1. Select Yes, create a version of this report to automatically generate a batch version of the report template.
2. Enter the version name in the field beneath Yes, create a version of this report.
3. To review the selections, click Back to move backwards through the Director forms.
On the Navigation Assistant, you can click the name of the form that you want to review.

4. When you are satisfied, click Finish.

Important! When you click Finish, you can no longer access the Director for this report. Before you click
Finish, you have an opportunity to review the selections on all forms of the Report Director.

Creating an Example Group Section Report
This sample group section report, which is used for reviewing inventory on hand, was created using the Report
Director. The V41021E - Item Location, Item Master Join business view is attached to the group section,
and these business view columns were selected for the section layout:

• Location.
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• Item Number - Short.
• Primary Location (P/S).
• Category G/L.
• Quantity on Hand - Primary Units.
• Quantity on Backorder.
• Business Unit.

A group section format was selected for this report because all of the information for a specific inventory item
is easily reviewed in a group. The data selection defined filters the data so that inventory items display for
only one business unit, Business Unit 27.

Access Report Design Aid.

1. From the File menu, select New.
2. On the Create New Report form, in the Report Name field, enter R5541021.
3. In the Description field, enter Inventory on Hand.
4. In the Product Code field, enter 55.
5. Select the No Update Report option and click OK.
6. On the Welcome to the Report Design Director form, select Page Header and Group, and click Next.
7. On the Page Header Details form, click Next to accept the default.
8. On the Business View Selection Option form, select the option I’ll Find a business view myself, and
click Next.

9. On the Select Business View form, locate and select the V41021E - Item Location, Item Master Join
business view, and click Next.

10. On the Section Layout form, use the horizontal arrow buttons to select these columns, in the order listed,
and move them to the Selected Columns list:
• Location.
• Item Number - Short.
• Primary Location (P/S).
• Category G/L.
• Quantity on Hand - Primary units.
• Quantity on Backorder.
• Business Unit.
Use the vertical buttons to change the order of the selected columns, if necessary.

11. When the selected columns are arranged as indicated, enter 3 in the Number of Columns field, and click
Next.

12. On the Data Sequencing form, use the horizontal arrow buttons to select and move the Location and
Item Short columns to the Selected Columns list.

13. When the selected columns are arranged as indicated, click Next.
14. On the Define Sort Properties form, sort the data for both fields in ascending order, and click Next.
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Note. These data selection steps filter the data so that the system displays only records that are associated
with Business Unit 27.

15. On the Data Selection form, complete these fields:
• Operator - Where
• Left Operand - Business Unit (F41021) (MCU) (BC)
• Comparison - is equal to
• Right Operand - <Literal>

16. Select the Single value tab, enter 27 in the Business Unit field, and click OK.
17. On the Data Selection form, click Next.
18. On the Finish form, enter the version name.
19. Click Finish.
20. On the PeopleSoft Report Design Aid form, click Save to save the report.
21. Select the Preview tab to view the report.
22. On the Preview tab, select Yes.
23. From the File menu, select Exit to exit Report Design Aid.

Creating Tabular Sections
This section provides an overview of tabular sections, lists the prerequisite, provides a sample tabular section
report, and discusses how to:

• Select sections to include in tabular section reports.
• Select business views.
• Select business view columns.
• Define section data sequencing.
• Define sort properties.
• Select records to include.
• Create batch versions of reports from the Director.

Understanding Tabular Sections
The format of tabular sections is similar to columnar sections; however, tabular sections provide additional
features such as:

• Drill down
The drill down feature enables you to link the data in tabular sections to the data in the associated
application. This enables users to click the data in the online PDF and review the entries in the application.
This drill-down feature is especially beneficial to auditors and other users who need to view how an
amount was derived.
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See Chapter 20, “Working with the Drill Down Feature,” page 163.
• Row description columns
The system creates Row Description columns based on the fields that you define as level break fields. Row
description columns can display multiple fields, and include all fields defined as level break fields. The
description of the level break fields are displayed when a description business function is attached to the
data item in data dictionary, otherwise, the field value is displayed.

See Chapter 8, “Working with Objects Unique to Tabular Sections,” Working with Row Description
Columns, page 74.

• Automatic totalling

Automatic totalling is calculated by the system based on the fields that you define as level break fields.

• Spreadsheet functionality

You can add data to tabular sections using rows, defining each row individually. You can override individual
cells of the rows by selecting Cell Mode.

See Chapter 8, “Working with Objects Unique to Tabular Sections,” Working with Rows, page 76.

See Chapter 8, “Working with Objects Unique to Tabular Sections,” Overriding the Properties of Individual
Cells, page 80.

After you create a new report object, use the Report Director to design a tabular section report. The Report
Director guides you through a linear process for creating a tabular section report by asking you questions about
its structure and content. When you have finished creating the report, you can enhance it by using additional
features of Report Design Aid.

See Also
Chapter 8, “Working with Objects Unique to Tabular Sections,” page 71

Chapter 20, “Working with the Drill Down Feature,” page 163

Chapter 13, “Working with Smart Fields,” page 119

Prerequisite
Create a batch application object. The system automatically opens the Welcome form of the Report Director as
the last step in creating a batch application object.

Selecting Sections to Include in Tabular Section Reports
Access the Welcome to the Report Design Director form.

1. Select from the header and footer options available.
2. Select the Tabular option, and click Next.
If you choose to include a page header in the report, the Page Header Details form appears. If you do not
choose to include a page header, the Business View Selection Option form appears. You may skip the
rest of the steps in this task.

3. On the Page Header Details form, select these options to automatically populate the page header section:
• Automatically add the default informational fields shown below to my page header section.
Select this option to automatically populate the page header section.
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• Automatically add the default informational field "Page n of Total" shown below to my page header
section.

4. Click Next.

Selecting Business Views
Access the Business View Selection Option form.

1. Select one of these business view options and click Next:

• I’d like help finding an appropriate business view.

• I’ll find a business view myself.

2. Select the required business view and click Next.

Selecting Business View Columns
Access the Section Layout form.

1. From the Available Business View Columns list, select the columns to include in the columnar section,
and click the right arrow to move them to the Selected Columns list.
You can select multiple columns using the CTRL or SHIFT keys. You can also drag each column
individually into the Selected Columns list, or you can click the right double arrow to move all of the
columns from the Available Business View Columns list to the Selected Columns list.
Columns appear in the columnar section from left to right in the order that they are listed in the Selected
Columns list.

2. To remove columns from the section layout, select a column in the Selected Columns list, and click the
left arrow to move it to the Available Business View Columns list.
You can also click the left double arrow to remove all of the columns from the Selected Columns list.

3. To change the display order of the columns in the columnar section, select a column in the Selected
Columns list, and click the up or down arrows to move the selected column up or down one line in the list.
You can also drag a column to a new location in the list, or you can click the up or down double arrows to
move the selected column to the top or bottom of the list.

4. When you complete the section layout, click Next.

Defining Section Data Sequencing
Access the Data Sequencing form.

1. Select columns for sequencing from the Available Columns list, and click the right arrow to move them
to the Selected Columns list.
You can select multiple columns, remove columns and change the order of columns in the same manner as
on the Section Layout form.

Note. To define sort properties in the next task, you must select columns in this task.

2. When you complete the data sequencing for the section, click Next.
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Defining Sort Properties
Access the Define Sort Properties form.

1. Click the arrow in the Sort Order field until it reflect your preference of ascending or descending order.
2. To specify level and page breaks, click these fields:
• Level Break
• Page Break

3. When you are finished, click Next.

Selecting Records to Include
Access the Data Selection form.

1. Click the Operator field and select Where as the operator.
2. In the Left Operand field, select from the list of available business view columns.
3. In the Comparison field, select from the list of available options.
4. In the Right Operand field, select from the list of available objects.
5. To delete a line of criteria on the Data Selection form, click the row header to highlight the row, and
then click the Delete button at the top of the form.

6. To change the order of the criteria, click the row header to highlight the row, and then click the up
or down button.

7. When you have completed the selection criteria, click Next.

Creating Batch Versions of Reports From the Director
Access the Finish form of the Report Director.

1. Select Yes, create a version of this report to automatically generate a batch version of the report template.

2. Enter the version name in the field beneath Yes, create a version of this report.

3. To review the selections, click Back to move backwards through the Director forms.

On the Navigation Assistant, you can click the name of the form that you want to review.

4. When you are satisfied, click Finish.

Important! When you click Finish, you can no longer access the Director for this report. Before you click
Finish, you have an opportunity to review the selections on all forms of the Report Director.

Creating an Example Tabular Section Report
This sample tabular section report, which is used to review outstanding purchase orders by business unit, was
created using the Report Director. The V4311A - Purchase Order Detail Browse business view is attached to
the tabular section, and these columns were selected for the section layout:

• Description
• Business Unit
• Order Type
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• Amount Open

The report is organized by company and displays item descriptions. The data is filtered to display only
purchase orders (as opposed to items that were ordered by other methods, such as purchase requisitions) for
stocked parts. These parts carry a balance and are not yet closed

A tabular section format was selected for this report for the automatic totaling and Row Description column
features that are available in tabular sections.

Access Report Design Aid.

1. From the File menu, select New.

2. On the Create New Report form, in the Report Name field, enter R554311.

3. In the Description field, enter Outstanding Purchase Orders.

4. In the Product Code field, enter 55.

5. Select the No Update Report option and click OK.

6. On the Welcome to the Report Design Director form, select Page Header and Tabular, and click Next.

7. On the Page Header Details form, click Next to accept the default.

8. On the Business View Selection Option form, select the option I’ll find a business view myself, and
click Next.

9. On the Select Business View form, locate and select the V4311A - Purchase Order Detail Browse business
view, and click Next.

10. On the Section Layout form, use the horizontal arrow buttons to select these columns, in the order listed,
and move them to theSelect Columns list:

The system has already added a Description column for you in the Selected Columns list.

• Business Unit
• Order Type
• Amount - Open

11. When the selected columns are arranged as indicated, click Next.

12. On the Data Sequencing form, move the Order Company column (from table F4311) and the 2nd Item
Number column to the Selected Columns list, and click Next.

Note. The data in this tabular section is sorted on business view columns that are not included in the
section layout.

13. On the Define Sort Properties form, sort the data for both fields in ascending order.
14. Select the Level Break option for both fields, and click Next.
The Row Description Column will include both of these columns, and the system will calculate totals for
open orders each time the system displays a new record.

15. To filter data to include only open purchase orders that have a balance and include only stock items, on
the Data Selection form, complete these fields:

Note. Each succeeding line of the filter is connected with an And operator. You must use And because
every data item must meet all of the criteria to be displayed in the section.
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• Operator - Where
• Left Operand - Amount - Open (F4311) (AOPN) (BC)
• Comparison - is greater than
• Right Operand - <Zero>
Do not enter a value of zero as a literal value.
This definition meets the balance criteria.

• Operator - And
• Left Operand - Order Type (F4311) (DCTO) (BC)
• Comparison - is equal to
• Right Operand - OP
OP is a literal value for Purchase Order and is entered by selecting <Literal>.
This definition meets the purchase order criteria.

• Operator - And
• Left Operand - Status Code - Next (F4311) (NXTR) (BC)
• Comparison - is not equal to
• Right Operand - 999
999 is a literal value for Complete.
This definition meets the open, or not complete, criteria.

• Operator - And
• Left Operand - Line Type (F4311) (LNTY) (BC)
• Comparison - is equal to
• Right Operand - S
S is a literal value for Stock Item.
This definition meets the stock items criteria.

16. On the Data Selection form, click Next.
17. On the Finish form, select No, I will create a version of this report later, and click Finish.
18. On the PeopleSoft Report Design Aid form, click Save to save the report.
19. Select the Preview tab to view the report.
20. On Preview, select Yes.
21. From the File menu, select Exit to exit Report Design Aid.

Creating Application Reports
This section provides overviews of application reports, smart fields, and calculation columns, lists the
prerequisite, and discusses how to:

• Select application report templates.
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• Select business views.
• Select smart fields.
• Create calculation columns.
• Define section data sequencing.
• Define section data sequencing using the Advanced option.
• Select records to include.
• Define additional properties.
• Create batch versions of reports from the Director.

Understanding Application Reports
You must create application reports using the Report Director. The Report Director uses Director templates that
define default criteria for creating report templates over specific PeopleSoft EnterpriseOne systems. When you
select one of the templates from the Report Director, the system reads the template specifications and presents
the default criteria through the Director forms. You can modify these templates or create custom templates.

Director templates enable you to use smart fields, which are data dictionary items (glossary group K) with
attached business functions. They are designed to retrieve and manipulate specific PeopleSoft EnterpriseOne
table data. For example, by adding the smart field FINRPTAB - Account Balance to a report, you create a
column that calculates the account balance as of a specified financial period and fiscal year.

Since the Report Director only recognizes the smart fields that are attached to the Director template, you must
add business view columns to the detail section after the Report Director process is complete. Business view
fields are not available for application reports from the Report Director. However, the system automatically
includes the Description column in the Columns in Report Section list. When you are finished with the initial
design of the application report using the Director, you can use Report Design Aid to change the Description
column size, column heading name, and position on the report.

The data sequencing fields for application reports are defined in the Director template. The first two
fields defined in the Director template become the level break fields. These fields are presented on the
Data Sequencing Help form of the Director. You can modify the predefined data sequencing or override it
completely. If you select to override the data sequencing, the Director presents you with a Section Data
Sequencing form. On this form you can select from fields included in the attached business view.

Application reports enable you to define additional properties. Additional properties control how the report
processes information and displays that information. The additional properties are defined in the Report
Director Templates program. If the Display Financial Criteria option is not selected in the Director template,
the Additional Properties form is not presented in Report Design Aid.

Additional properties available for selection in the Director template:

• AAI Subtotaling
Generates interim subtotals in the report based on the Automatic Accounting Instructions.

• Reverse Sign For.
Reverses the signs for dollar values from how they are displayed in the database. For example, if you do not
want to display revenues as a negative value (–) and expenses as a positive value (+), as they appear in the
database tables, you can select to display them both as positive values in the report section.

• Account Level of Detail Rollup
Indicates the level of account detail to display in the report.
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• Drill Down
Creates a link between the data in the report and the detail in the associated application.

See Chapter 20, “Working with the Drill Down Feature,” page 163.

• Zero Row Suppression

Displays header accounts even if the detail accounts have a zero balance.

Because each application report template is unique, you will not necessarily see all forms described in the tasks
below. Some forms might not be relevant for the Director template that you select.

See Also
Part 2, “Basic Report Enhancements,” page 51

Part 3, “Advanced Report Enhancements,” page 131

Understanding Smart Fields
Smart fields use business functions and named event rules to provide the required logic. Business functions
are programs that use data structures to:

• Request specific data from PeopleSoft EnterpriseOne tables.
• Return the data to the established parameters in the data structure.
• Perform calculations or other manipulation on the data.
• Send the desired information, such as column headings and complex calculations, to the report section.

There are two types of business functions in PeopleSoft EnterpriseOne:

• C business functions
You create C business functions in the C programming language. These business functions include a .c,
source file, and a .h, header file.

• Business function event rules
Business function event rules are also known as named event rules (NER). You create named event rules
using the event-rules scripting language. This scripting language is platform-independent and stored in a
database as a PeopleSoft EnterpriseOne object. When you build business function event rules, the system
generates C code and creates corresponding .c and .h files.

Several smart fields are shipped with PeopleSoft EnterpriseOne. You can create custom smart fields to meet
specific business needs. Once smart fields are created, you can use them to include complex logic in report
sections without having to do any programming.

For each smart field that you include in a section, you are prompted to define parameters that are specific
to that smart field using a series of forms. Although the number and content of the forms vary based on
the smart field, the process occurs in three phases:

• First, you are prompted to define how you want the column to appear in the section.
• Second, you are prompted to define parameters, such as period number offset, journal entry amount, fiscal
year offset, and so on.
Some smart fields have only one parameter and, therefore, only one form in this phase. Others have multiple
parameters that you specify using a series of forms.

• Third, you are prompted to filter the data that is displayed in the section using data selection.
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See Also
Chapter 13, “Working with Smart Fields,” page 119

Chapter 32, “Creating Smart Fields,” page 247

Understanding Calculation Columns
Application reports enable you to define calculation columns. Calculation columns display the results of a
calculation involving two or more smart field columns or other calculation columns. In a report created using a
Director template, the Director only recognizes the smart fields that are attached to the template; therefore,
business view fields included in the section layout cannot be used in calculations. After you complete the
design process using the Report Director, you can use Report Design Aid to add calculation columns based
on other columns in the report.

Note. Values in calculation columns are based on the amounts that are displayed in the report, not on the
values stored in the database.

These calculation types are available when creating calculation columns:

• Difference between.
Presents you with two operands fields. Use the field drop-downs to select the columns to use for calculating
the difference between.

• Percent variance between.
Presents you with two operands fields. Use the field drop-downs to select the columns to use for calculating
the percent variance between.

• Undefined.
Creates a numeric variable column in the report section for which you can manually define a calculation.
Select the column variable in Report Design Aid and from the Column menu, select Define Calculation.

• Total of.
Presents you with columns from the report layout. Click each field to be included in the total.

• Product of.
Presents you with two operands fields. Use the field drop-downs to select the columns to use for calculating
the product of.

See Also
Chapter 8, “Working with Objects Unique to Tabular Sections,” Creating Calculation Columns, page 73

Prerequisite
Create a batch application object. The system automatically opens the Welcome form of the Report Director as
the last step in creating a batch application object.

Selecting Application Report Templates
Access the Welcome to the Report Design Director form.

1. Select from the header and footer options available.
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2. Under the Application Reports heading, select the Director template that is most appropriate for the
type of report that you are creating and click Next.
If you selected to include a page header in the report, the Page Header Details form appears.
If you do not select to include a page header, Business View Selection Option appears. You may skip the
rest on the steps in this task.

3. On the Page Header Details form, select these options to automatically populate the page header section:
• Automatically add the default informational fields shown below to my page header section.
Select this option to automatically populate the page header section.

• Automatically add the default informational field "Page n of Total" shown below to my page header
section.

4. Click Next.

Selecting Business Views
Access the Business View Selection Option form.

1. Select the option I’ll use the pre-defined business view.

The predefined business view is defined in Report Director Templates for the specific Director template
selected.
You can select one of the other options on the Business View Selection Options form to select a business
view.

Note. The business functions that are attached to smart fields require specific fields to process the logic. If
the business view you select does not include these fields required by the smart fields that are attached to
the Director template you selected, the smart fields will not function.

2. Click Next.

Selecting Smart Fields
Access the Select Columns form.

1. Drag the appropriate smart field from the Available Smart Fields list to the Columns in Report Section list.

The Smart Field Name form appears and marks the first phase of defining data for the smart field.

2. On the Smart Field Name form, enter a unique but descriptive name in the Variable Name field.

You can easily identify the field when creating event rules or calculations by using the variable name.

3. Enter a descriptive name in the Report Column Headings fields.

These fields appear on the report as the column heading unless the Smart Column Heading option
is selected.

4. Select from these options and click Next.:

• Smart Column Heading

Select this option if you want the system to populate the column heading using a smart field. This feature
enables you to create a report with column headings that change based on a rolling time period.
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• Show Multiples Parameters per Page
Select this option if you want the Director to combine multiple smart field parameters on a page. The
system then displays five smart field parameters on each page of the Director for easier viewing.

Note. The Smart Field Parameters form varies, depending on which smart field you select. For example,
if you select the FINRPTAB smart field, the appropriate Smart Field Parameter forms appear.

5. On the Smart Field Parameters (Period Number Offset) form, complete the Enter the Literal field, and
click Next.
Leave this field blank to use current values, such as current period. You can enter a specific period number
in this field, or enter a number that is an offset to the current period number. For example, entering 6 in
this field displays data for period six. Entering an offset of –1 displays data for the month before the
current month.

6. On the Smart Field Parameters (Fiscal Year Offset) form, complete the Enter the Literal field, and click
Next.
Leave this field blank to use current values, such as current year; enter the last two digits of a specific fiscal
year, such as 05; or enter a number that is an offset to the current fiscal year, such as +1 or –1.

7. On the Smart Field Parameters (Column Heading Offset) form, complete the Enter the Literal field,
and click Next.
This form appears only if you selected the Smart Column Heading option on the Smart Field Name form.
The value you enter on this form should match the value entered on the Smart Field Parameters (Period
Number Offset) form. The column heading should reflect the data included in the column.

8. On the Smart Field Data Selection form, complete the fields to define the data that you want to appear in
the smart field column and click Next.
The fields on this form vary depending on the Director template selected.

9. If the fields that appear on the Smart Field Data Selection form do not reflect the data selection criteria
required for the smart field column, select the Advanced option, define data selection manually, and
click Finish.
You can click a selected smart field on the Select Columns form, click the Define Smartfield button, and
review or revise the associated smart field parameters.

Creating Calculation Columns
Access the Select Columns form.

1. Click the Define Calculation button.
2. On the Define Calculation form, complete the Calculation Name field.
This name appears on the report as the column heading.

3. Select a calculation type.
4. Define the Operands for the calculation type you selected and click Finish.

Defining Section Data Sequencing
Access the Data Sequencing Help form.

1. Select to sequence the section data using the predefined fields in the Report Grouping list.
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2. Select to further sequence the data using predefined field in the Report Detail list, and click Next.

Defining Section Data Sequencing Using the Advanced Option
Access the Data Sequencing Help form.

1. Select the Advanced option to append additional data sequencing.

2. Clear the predefined fields and select the Advanced option to override the predefined data sequencing.

3. Click Next.
4. On the Section Data Sequencing form, select business view columns from the Available Columns list, and
move them to the Selected Columns list.

5. When you complete the section data sequencing for the section, click Next.

6. On the Define Sort Properties form, define sort order, level breaks and page breaks, and click Next.

Selecting Records to Include
Access the Help with Section Data Selection form.

Define data selection using one of these options:

1. Click Select only BALANCE SHEET accounts from the automatic accounting instructions to display data
from the balance sheet accounts only.
This selection includes data fields established in the General Purpose (GLGxx) automatic accounting
instructions as balance sheet accounts.

2. Click Select only INCOME STATEMENT accounts from the automatic accounting instructions to display
data from the income statement accounts only.
This selection includes data fields established in the General Purpose (GLGxx) automatic accounting
instructions as income statement accounts.

3. Select I’ll add my own data selection to the above balance sheet or income statement criteria. to append
data selection to the default income statement or balance-sheet data selection.
The system provides the criteria for including the balance sheet accounts and enables you to define
additional criteria.

4. Select Set up data selection manually to define data selection manually.
5. On the Data Selection form, define data selection and click Next.

Defining Additional Properties
Access the Additional Properties form.

1. Select from the properties options presented, as applicable.

2. Click Next.

Creating Batch Versions of Reports From the Director
Access the Finish form of the Report Director.

1. Select Yes, create a version of this report to automatically generate a batch version of the report template.
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2. Enter the version name in the field below Yes, create a version of this report.
3. Click Back to move backwards through the Director forms to review the selections.
You can also click the name of the form that you want to review on the Navigation Assistant.

4. When you are satisfied, click Finish.

Important! When you click Finish, you can no longer access the Director for this report. Before you click
Finish, you have the opportunity to review the selections on all forms of the Director, as described in step 3.

PeopleSoft Report Design Aid appears.

Saving and Reviewing Reports
This section provides overviews of saving reports and reviewing reports, lists the prerequisites, and discusses
how to:

• Save reports.
• Review results of the Director.
• Preview reports.

Understanding Saving Reports
When you click Finish on the Report Director, the initial design process is complete. Based on the selections
that you made during the design process, Report Design displays the sections of the report and the fields that
you selected for the layout. You cannot return to the Report Director once you have clicked Finish.

You cannot save the report template while using the Report Director. Save the report template from the
PeopleSoft Report Design Aid form after completing the initial design.

Understanding Reviewing Reports
Use the Preview tab to view how the report will appear when you process it. Use the preview feature to
review the report for content and format as you make design changes. The system will prompt you to save
the report before previewing.

Note. Once you have previewed the report, you must refresh the Preview tab each time you return to preview
the report after making modifications.

Report Design Aid uses the Adobe Acrobat Reader to present the report preview. You can use all of the
available functions to view the report.

Prerequisites
Before you begin saving reports, ensure that you:

• Create a batch application object.

• Complete the design of the report template.
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Saving Reports
Open a report in Report Design Aid.

Perform one of these actions to save the report template:

• From the File menu, click Save.
• Click the Save button on the toolbar.

Reviewing Results of the Director
Open a report in Report Design Aid.

Each report section includes:

• An icon on the section tile that indicates the section type.
• An optional funnel-shaped icon on the section tile that indicates that data selection is defined for the section.
• A title description on the section tile.
The title reflects the name of the business view attached to the report section. The title of the main detail
section of the report is in a bold font to distinguish it from the other report sections.

• Corner brackets enclosing each field within the section

Previewing Reports
Open a report in Report Design Aid.

1. Select the Preview tab.
The Report Preview form appears and prompts you to run the preview.

2. Click Yes on Report Preview.
3. Click Yes to save the changes.
4. Perform one of these actions to refresh the preview:
• From the View menu, select Refresh Preview Window.
• If the system displays the View toolbar, click the Refresh Preview Window button.
• Press F5 on the keyboard.

5. Select User Options from the View menu to modify the number of records that are processed and displayed
in Preview mode.

6. On the User Options form, complete the Rows to Preview field to indicate how many table records to
process in the preview.
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CHAPTER 5

Configuring the Design Workspace

This chapter provides an overview of the design workspace and discusses how to customize the design
workspace.

Understanding the Design Workspace
You can modify the design workspace in Report Design Aid to accommodate your work style. Report Design
Aid offers a variety of ways to configure the design workspace:

• Set user options.
• Set grid alignment.
• Show and hide the display tree.
The display tree is a dockable window that displays the sections and fields of the report in a hierarchical tree
structure. You can select to show the display tree, and you can dock it or float it over the Report Design
area. The display tree displays the sections that are included in the report, as well as the objects that are
associated with each section. Invisible fields appear in the tree structure. The highest component of the
tree displays the name of the report. Under the report name, the system displays the first created section.
Next to each component is a + or – sign.
Expand a section to display a Fields folder. Expand this folder to display a list of objects that are included in
the section (rows and cells do not appear in the display tree). If you expand the Fields folder of a detail
section, two entries display for each field. One entry represents the constant (header portion of the field), and
the other represents the variable (data portion of the field).

• Show and hide the Business View Column browser.
The business view column browser is a dockable window that displays the columns from the business view
attached to the selected detail section. You can select to show the browser, and you can dock it or float it
over the Report Design area.

• Show and hide the data dictionary browser.
The data dictionary browser is a dockable window that enables you to search the data dictionary for fields
to include in the section layout. You can select to show the browser, and you can dock it or float it over
the Report Design area.

Customizing the Design Workspace
This section provides overviews of user options and grid alignment, lists the prerequisites, and discusses
how to:
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• Set user options.
• Set the grid alignment.
• Show and hide the display tree.
• Show and hide the business view column browser.
• Show and hide the data dictionary browser.

Understanding User Options
You can set user options to show or hide the elements of the user interface, such as rulers and tabs. You can
also control the number of rows to process for preview. All of the user options affect the design workspace.

User options are also referred to as report view options. There are three categories of user options:

• General.
• Rulers.
• Preview.

General user options affect the hiding and showing of elements of the design workspace. General user
options include:

• Show Invisible Sections at Startup.

Shows sections that are defined as invisible when you open the report. You must have sections of the report
defined as invisible for this option to affect the Report Design view.

• Show Section Titles.

Displays the section title and icon in the tile to the left of each section.

• Show Right Margin.

Shows the right margin to indicate when fields of a section are outside the page margins. This is helpful
when you change the orientation of the report to view fields that fall outside the page margins.

• Show Tabs.
Displays the Report, Preview, Attachments, and other section-specific tabs at the top of the design workspace.

• Show Navigational Assistant.

Displays the navigation assistant with the Report Director. Hiding the navigation assistant from User
Options hides the navigation assistant for all future design sessions.

• Show Data Dictionary Text Overrides.

Displays a small green triangle in the bottom right corner of column headings when the display name is
different from the data dictionary name. The indicator appears in Report Design Aid only; it does not
print on the report.

• Allow Smart Field Template Selection.

Enables you to select smart field templates from the General tab of the section properties form.

• Enable System Language Font Override and Reposition.

Dynamically repositions fields based on font changes that affect field size. This option is beneficial for
global reporting when you must display data in different languages with fonts of different widths and
heights. This option is disabled by default.

• Show CSV Tip Dialog.
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Displays the CSV Tip dialog box, which indicates the spacing recommendation for exporting reports to CSV.
• Show Object Count Warning after Row Generation.
Displays a warning message that indicates when the report has exceeded the recommended size. This is
typically an issue with reports that use the automatic row generation feature.

Understanding Grid Alignment
The grid alignment feature enables you to tighten or loosen the dots of the grid for flexibility in positioning
fields in a group section layout. Set the horizontal spacing to 52 if you are exporting the report to a CSV
(Comma Separated Values) file. This number corresponds to the default width of a column in Microsoft
Excel. Also select the Snap to Grid option.

The vertical spacing value represents pixels on the workstation that are used for designing the report. The
value is converted to a workstation-independent measurement when it is saved. Set this option to ensure that
the report maintains the same proportions when it is displayed on a different workstation.

Options available for grid alignment:

• Horizontal spacing.
Adjusts the horizontal grid spacing for the entire report template. If you designed the report to be exported to
a CSV file, the horizontal spacing should be set to 52.

• Vertical spacing.
Adjusts the vertical grid spacing for the entire report template.

• Display the grid.
Displays a grid of dots to assist in positioning fields. When deselected, no grid appears in the Report
Design workspace.

• Snap to grid.
Aligns fields with the nearest grid line intersection even if the grid is not displayed. When deselected, you
can position fields that do not line up with the grid. If you designed the report to be exported to a CSV file,
the snap to grid option should be selected.

Prerequisites
Before you begin customizing the design workspace, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Setting User Options
Access Report Design Aid.

1. From the View menu, select User Options.
2. On the User Options form, select from the available options under the General heading, and click Apply to
view the changes without leaving the form.

3. Select the Show Rulers option under the Rulers heading, and then select from these options in the Ruler
Units field:
• Inches
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• Centimeters
• Points

4. Select the Prompt Before Running Preview option under the Preview heading to display a prompt before
running the preview.

5. Enter the number of rows to process in the Rows to Preview field and click OK.
Select a number to provide enough records to verify the format of the report and review any totaling or
other logic that is included, while keeping the number of rows processed to a minimum.

Setting the Grid Alignment
Access Report Design Aid.

1. From the Layout menu. select Grid Alignment.

2. On the Alignment Grid form, modify these spacing options as required:

• Horizontal
• Vertical

3. Select from these options and click OK.

• Display Grid
• Snap to Grid

Showing and Hiding the Display Tree
Open a report in Report Design Aid.

1. From the View menu, select Report Tree View.
2. Click the + or – sign to expand (+) and collapse (–) the display tree.
3. Double-click the object in the tree structure to view or change object properties.

Note. The display tree displays only the structure of the report; it does not represent the processing flow
of the report. Use the Preview tab to view the format of the report.

Showing and Hiding the Business View Column Browser
Access Report Design Aid.

1. Click a detail section in the report.

2. From the View menu, select Business View Column Browser.

Note. Because only the detail sections of a report have business views attached, the business view column
browser is only populated when you select a detail section with an attached business view. Selecting other
sections results in an empty business view column browser window.

3. Drag fields from the business view column browser and drop them in the detail section.

Showing and Hiding the Data Dictionary Browser
Access Report Design Aid.
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1. Click a detail section in the report.
2. From the View menu, select Data Dictionary Browser.
3. Use the QBE line to search for a data item.
4. Drag the data item from the data dictionary browser and drop it in the section.
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Viewing Properties for Report Sections,
Fields, Columns, and Rows

This chapter provides an overview of properties and discusses how to view properties.

Understanding Properties
Properties are available in Report Design Aid at the report, section and object levels. Properties enable you to
change fonts, change field justifications, change decimals, and select additional advanced settings.

Some properties are available at all levels, while other properties are specific to the level. Properties that are
available at all levels are processed using a hierarchy. Properties defined at the lowest level are the properties
that are processed by the system. For example, if you define a font size of 8 in the report properties, then
define a font size of 10 in field properties, the individual field appears in a font size of 10 while the rest
of the report appears in a font size of 8.

• Report properties affect the entire report.
• Section properties affect the current section only
Section properties include general properties, font, color, fields, and advanced properties.
You can view section properties using either the menu method or the double-click method.

• Field properties affect only the field you have selected.
Field properties include general properties, font, color, style, display, options, and advance properties.
You can view data field properties using either the report section method or the double-click method.

• Columns (both the headings and the variables) are treated by Report Design Aid as fields, so you can use the
same methods of viewing column properties as you can for viewing field properties.
In addition, Report Design Aid offers a third way to view column properties: the column tab method.

• Rows exist in tabular sections only.
You can view row properties by using either the report section method or row tab method.

Viewing Properties
This section provides overviews of report properties and section properties, lists the prerequisites, and
discusses how to:

• View report properties.

PeopleSoft Proprietary and Confidential 59



Viewing Properties for Report Sections, Fields, Columns, and Rows Chapter 6

• View section properties.
• View field properties.
• View column properties.
• View row properties .

Understanding Report Properties
Report properties affect the entire report and include these tabs:

• Report Properties.

Use this tab to select totalling, output, and performance options.

• Font/Color.
Use this tab to modify fonts, font styles, font size, and font colors.

• Cover Page Options.

Use this tab to select the cover page option. Select from general and section options to include on the
cover page

• Decimal Scaling.

Use this tab to select options to apply decimal scaling to numeric fields. This option affects only tabular
section reports.

• Advanced.
Use this tab to select options for subsystem jobs, paper size, dynamic positioning, transaction processing
and overriding environments.

Understanding Section Properties
Section properties for group and columnar section are the same. There are several more section properties
available for tabular sections.

Group and columnar section properties affect the current section only and include these tabs:

• General.
Use this tab to modify the section description.

• Font/Color.
Use this tab to modify fonts, font styles, font size, and font colors.

• Fields.
Use this tab to access properties for the fields in the section layout and make fields invisible. When fields are
invisible, a circle with a line through it displays next to the icon. When column headers are invisible, their
associated column variable is also invisible. Double-click the icon to toggle the visible or invisible property.
The various field types are represented by different icons in the Visible column:
- XXX.
This icon represents constant fields.

- Dual-shaded box.
This icon represents columns. If the arrow points to the top section, the icon refers to the column heading.
If the arrow points to the bottom section, the icon refers to the column variable.
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- Gray, black, and white diamond.
This icon represents runtime fields, such as report date, report time, page number, company title, or
report title.

- Multicolored diamond.
This icon represents variables located in group sections.

• Advanced.
Use this tab to select Visible, Absolute Position (text wrapping), Page Break After, Conditional, Reprint
At Page Break.

Tabular section properties affect the current section only and include these tabs:

• General.
Use this tab to modify the section description.

• Font/Color.
Use this tab to modify fonts, font styles, font size, and font colors.

• Financial Reports.
Use this tab to select Drill Down, Perform AAI Subtotaling, Reverse Sign for:, Zero Row Suppression:,
Level of Detail Rollup, Financial Descriptions.

• Fields.
Use this tab to access properties for the fields in the section layout and make fields invisible.

• Row List.
Use this tab to access row properties and make rows invisible.

• Cell Overrides.
Use this tab to access cell override properties and make cells invisible.

• Column Override.
Use this tab to select a section from another report from which to import columns.

• Row Override.
Use this tab to select a section from another report from which to import rows.

• Decimal Scaling.
Use this tab to select options to apply decimal scaling to numeric fields.

• Advanced.
Use this tab to select Visible, Absolute Position (text wrapping), Page Break After.

Prerequisites
Before you begin viewing properties, ensure that you:

• Create two batch application objects.
• Complete the design of one report template using a columnar or tabular section.
• Complete the design on the second report template using a tabular section with rows.
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Viewing Report Properties
Open a report in Report Design Aid.

1. From the File menu, select Report Properties.
2. On the Report Properties tab, review totalling, output and performance options.
3. Select the appropriate tab to review additional report properties.

Viewing Section Properties
Open a report in Report Design Aid.

1. Click the section for which you want to view properties.

2. From the Section menu, select Section Properties.

You can also double-click the section to access the Section Properties form.

The appropriate Section form appears.

3. On the General tab, review the business view attached to the section.

4. Select the appropriate tab to review section properties.

Viewing Field Properties
Open a report in Report Design Aid.

1. Double-click the section containing the field for which you want to view properties.
You can also double-click the field to view its properties.
The appropriate Section form appears.

2. Select the Fields tab.
3. Select the field for which you want to view properties and click Field Properties.

Viewing Column Properties
Open a tabular or columnar section report in Report Design Aid.

1. Click the detail section for which you want to view column properties.
2. Select the Column tab at the top of the Report Design workspace.
You can also double-click the column heading for which you want to view properties.

3. Right-click anywhere on the row or column headers of the grid.
4. Click Field Selection.
5. On the Object Design Properties form, select or clear any of the available field options on the Basic or
Advanced tabs to show or hide field options, and click OK.
This action enables you determine which fields appear on the Column tab.

6. To modify a property, double-click the property for a column to access an appropriate control.
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Viewing Row Properties
Open a tabular row report in Report Design Aid.

1. Double-click the tabular section that contains the row for which you want to view properties.
You can also select the Row tab at the top of the Report Design workspace. The Row tab is used in
the same manner as the Column tab.

2. On the Tabular Section form, select the Row List tab.
The Row List tab lists all of the rows in the tabular section. The various row types are represented by
different icons in the Visible column.

3. Select the row for which you want to view properties and click Row Properties.
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CHAPTER 7

Working with Objects in Report Sections

This chapter provides an overview of report objects and discusses how to work with report objects.

Understanding Report Objects
You can include multiple sections in a report template, even multiple detail sections. In each of these sections,
you can include multiple report objects. These objects are either business view fields or other data fields.
Some report objects are only available in specific section types. For example, runtime fields are typically used
in page headers, and are not available in columnar and tabular sections.

Working With Report Objects
This section provides overviews of business view columns and data fields, lists the prerequisites, and discusses
how to:

• Add and remove business view columns.

• Add and remove data fields.

• Add and remove data dictionary items.

• Change column heading names.

• Change data field names.

• Disconnect constants from variables in group sections.

• Perform in-section totaling.

Understanding Business View Columns
You can add or remove business view columns from any detail section that has a business view attached.
Business views are subsets of columns that reside in one or more tables. The columns included in a business
view have been selected to meet specific business needs.

When adding business view columns, or other data fields, to columnar and tabular sections, the new column is
inserted to the right of any column on which you place the cursor. When you do not place the cursor on a
column, the inserted column is inserted to the left of the first column, becoming the first column in the section.
You can then drag the new column to another location in the same section.

When adding business view columns, or other data fields, to group sections, you must click in the group
section to position the data field after selecting it from the Insert menu. You can position the new field
anywhere in the group section because of the free-form layout.
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Understanding Data Fields
Data fields are individual data containers that reside in report sections. Page numbers, dates, and report names
are all examples of data fields. You can add data fields to any type of report section, although you cannot add
every data field type to every report section type. For example, you typically add data fields (such as report
name, date, and so forth) to the page header of a report.

Business view columns fetch associated data from the database. Data dictionary fields, on the other hand,
are fields with specifications attached but do not have data associated with them. These fields are defined
in the data dictionary and can have edit codes and special triggers attached. You populate data dictionary
fields using event rules. Typically, you want to select a data dictionary field that includes the specifications
required by the report section. For example, you are adding a field to the salary report to calculate raises. Use
the Data Dictionary Browser to select the Rate-Salary, Annual (SAL) data dictionary field so that the raise
amount is formatted the same as the salary amount.

After creating the report, you can:

• Insert data fields.
• Delete data fields.
• Change data field names.
• Change column heading text.
• Disconnect a constant’s text from its variable in a group section.
In a group section, you can separate the text from the variable that it describes. For example, you can modify
a report that contains the Business Unit field and the Description field by changing the Business Unit
constant to read Business Unit Number and Name. By disconnecting the Description text from the variable,
you can delete the text and still retrieve the value for Description from the PeopleSoft EnterpriseOne table.

• Perform in-section totaling.
When you want to format and display totals in a columnar or group section report, perform the calculations
in a level break footer. You can provide descriptive labels for the aggregates in level break footers.
Occasionally, when you are not concerned with how the calculations are displayed, you can include
calculations within a columnar or group section. For example, you can perform calculations in one hidden
section for use in another. You can calculate a total, a grand total, or both.

This table describes the data fields available in Report Design Aid:

Field Description

Constants Static fields that display a string of text, such as a company
name inserted in the page header. You can insert constant
fields into any report section.

Alpha Variables Fields that contain alphanumeric data that are populate
using an event rule. You can insert alpha variables into any
report section.

Numeric Variable Fields that contain numbers and are typically used for
calculations. You can insert numeric variables into any
report section.

Date Variables Fields that contain dates. You can insert date variables into
any report section.
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Field Description

Report Date Runtime fields that contain the date when the report is run.
Report dates are typically used in page headers, but you can
insert them into any report section except columnar and
tabular.

Report Time Runtime fields that contain the time at which the report is
run. Report times are typically used in page headers but
you can insert them into any report section except columnar
and tabular.

Page Number Runtime fields that display the current page number. Page
numbers are typically used in page headers but you can
insert them into any report section except columnar and
tabular.

Page n of Total Runtime fields that display both the current page number
and the total number of pages in the report (such as Page
4 of 10). Page n of Total fields are typically used in page
headers but you can also insert them into page footers.

Company Title Runtime fields that contains the name of the default
company (company 00000). Company titles are typically
used in page headers but you can insert them into any report
section except columnar and tabular.

Report Title Runtime fields that contain the report title. Report titles are
typically used in page headers but you can insert them into
any report section except columnar and tabular.

Data Dictionary Field Fields from the data dictionary that require event rules. You
can insert data dictionary fields into any report section.

Text Variables Text fields are user create fields that are used in event rules.
You can create text variables in any report section.

Data fields that you insert into columnar and tabular sections appear in columnar format. Column headings
are constants with associated variables. The constant and variable are attached so that if you move or delete
one, Report Design Aid moves or deletes the other.

In group sections, data fields also comprise constants and variables but they appear side-by-side instead of in a
columnar format. Unlike columnar and tabular sections, you can move constant and variable independently
of each other. Furthermore, by disconnecting the two, you can separate the constant from the variable and
delete one without deleting the other. When you delete the constant, you retain the variable and the associated
data will appear in the report.

You can modify the appearance of data fields by changing the headings, moving them, changing the size,
font, or color, or by associating them with lines or boxes. You can modify the behavior of data fields by
attaching event rules.

Prerequisites
Before you begin working with report objects, ensure that you:

• Create two batch application objects.
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• Complete the design of one report template using a group section.
• Complete the design on the second report template using a columnar or tabular section.

Adding and Removing Business View Columns
Open a report in Report Design Aid.

1. Click a detail section with an attached business view.

2. From the View menu, select Business View Columns Browser.

This form displays columns from the business view that is attached to the detail section.

3. Drag one or more columns into the detail section.

4. From the View menu, select Business View Columns Browser to close the browser.

5. Drag the inserted column to the appropriate location.

6. To remove business view columns, select the column (either the header or the variable), and select Delete
from the Edit menu.

Adding and Removing Data Fields
Open a report in Report Design Aid.

1. Click the report section that you want to modify.
2. From the Insert menu, select the data field that you want to add.
The data field selection varies, based on the report section that you selected.

3. Drag the inserted data field to the appropriate location.
4. To remove data fields, select the field (either the header or the variable), and select Delete from the
Edit menu.

Adding and Removing Data Dictionary Items
Open a report in Report Design Aid.

1. Click the report section that you want to modify.
2. From the View menu, select Data Dictionary Browser.
3. Use the QBE line to search for and select an appropriate data dictionary field.
4. Drag one or more data dictionary fields into the report section.
5. From the View menu, select Data Dictionary Browser to close the browser.
6. Drag the inserted data dictionary field to the appropriate location.
7. To remove data dictionary fields, select the field (either the header or the variable), and select Delete
from the Edit menu.

Changing Column Heading Names
Open a columnar or tabular section report in Report Design Aid.

1. Double-click the column heading that you want to change.
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2. On the Column Heading Properties form, if the column is from the business view, you must override the
business view column name by selecting one of these options:
• Change Name
Selecting this option enables you to enter a new name for the column heading in the Variable Name field.
The variable name of a column heading appears in event rules with the prefix of RC (Report Constant).

• Override Col Headings
Selecting this option enables you to enter a new name in the Col Heading 1 and Col Heading 2 fields.
The column heading fields appear as the column heading on the report.

3. Change the text in the Col Heading 1 and Col Heading 2 fields and click OK.

Note. You should always change the variable name of a data field to match its column name. This action
makes managing the data field easier (especially if you plan to attach event rules to the data field).

4. Clear the Change Name and Override Col Headings options to return the column heading names back to
the default.

Changing Data Field Names
Open a report in Report Design Aid.

1. Double-click the data field that you want to change.
2. Change the text in the Variable Name field.

Note. A change in the variable name of a constant field in any section, except for columnar and tabular
sections, is reflected on the report. All other variable name changes do not affect the appearance of the
data field directly. If you change the variable name of a constant field, you should change the name of
the associated variable to make managing the data field easier (especially if you plan to attach event
rules to the data field).

3. Change the text in the Col Heading 1 and Col Heading 2 fields and click OK.

Disconnecting Constants From Variables in Group Sections
Open a group section report in Report Design Aid.

1. In the group section, click either the constant or the variable of the field that you want to modify.
2. From the Edit menu, select Disconnect.

Important! After you disconnect the constant from its variable, there is no option for you to reconnect
them on the report. From the Edit menu, you can select Undo to undo one action only. If necessary, you
can delete the disconnected text and variable and then reinsert the business view column. The new data
field appears as it did originally with a constant field that is linked to its variable.

Performing In-Section Totaling
Open a columnar or group section report in Report Design Aid.

1. Click the variable of a numeric field.
2. From the Edit menu, select Item Properties.
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3. On the properties form, select the Totaling tab.
4. Select one or both of these options:
• Total.
• Grand Total.

5. Select from these aggregate functions available and click OK:
• Sum.
• Average.
• Minimum.
• Maximum.
• Count.

6. From the File menu, select Report Properties.
7. On the Report Properties tab, select one or both of these options:
• Print Totals Only.
• Print Grand Totals.
These two options correspond to the options that you selected in step two. You must select Print Totals
Only for the total function to work correctly. Likewise, you must select Print Grand Totals for the
grand total function to work correctly.

Note. Depending on the options that you selected, the system adds one or two lines to the bottom of
each column before each section break. If you selected both the total and grand total options, the total
line appears before the grand total line. The totals are not labeled; in fact, except for the column that
displays the total, information from the last record is repeated in the total line. You can suppress totals
for fields that you do not want to display on this line.
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Working with Objects Unique to Tabular Sections

This chapter provides an overview of tabular sections and discusses how to:

• Define decimal scaling.
• Create calculation columns.
• Work with Row Description columns.
• Create percent calculations.
• Work with rows.
• Override the properties of individual cells.

Understanding Tabular Sections
Tabular sections are specialized types of columnar sections. Tabular sections present report data in columns,
rows, and cells. When you include fields that display numeric values, tabular sections automatically total
the values. For example, if you include an object that displays open amounts, tabular sections calculate a
grand total of all the open amounts in the section.

When you create a tabular section, observe these guidelines for columns, rows, and cells:

Condition Guideline

Define columns only. Define columns when the information in the report is based
solely on the data that is contained in tables. When you
define the columns, rows are generated at runtime based
on the selection, sequence, and level break criteria that you
defined.

Define columns and rows. Define rows in addition to columns when you include
details in the report (such as underlines, spaces, and blank
lines) as well as special calculations, such as interim totals.
Row information is set up horizontally on the report.

Define columns, rows, and cells. Define cells to override information that is defined by
columns and rows. A cell is the intersection of a column
and row.
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Defining Decimal Scaling
This section provides an overview of decimal scaling, lists the prerequisites, and discusses how to:

• Change decimal scaling for individual fields.

• Change decimal scaling for all fields in a tabular section.

• Change decimal scaling for all fields in all tabular sections of a report.

Understanding Decimal Scaling
Decimal scaling enables you to simplify the way large numbers appear in tabular sections. You can change
decimal scaling for a single field in a tabular section, for all fields in a tabular section, or for all fields in all
tabular sections of a report. For example, this table illustrates how the amounts in a report display if the
numerical data is scaled to 1000:

Original Value Displayed Value

100,000.42 100

10,041.62 10

1,021.75 1

1,512.69 1.5

Prerequisites
Before you begin working with objects unique to tabular sections, ensure that you:

• Create a batch application object.
• Complete the design of the report template using a tabular section.

Changing Decimal Scaling for Individual Fields
Open a tabular section report in Report Design Aid.

1. In the tabular section, double-click the variable of the numeric column that you want to change.
2. On the Column Variable Properties form, select the Decimal Scaling tab, select the appropriate level
of decimal scaling and then click OK.
To return all of the fields to their default decimal scaling settings, click Defaults.

Changing Decimal Scaling for All Fields in a Tabular Section
Open a tabular section report in Report Design Aid.

1. Double-click the tabular section that you want to change.

2. On the Section form, select the Decimal Scaling tab, select the appropriate level of decimal scaling and
then click OK.

To return all of the fields to their default decimal scaling settings, click Defaults.
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The changes that you make on this form affect all of the numbers in the section, except for those fields that
have been modified individually. To override individual settings and apply the changes to all fields in
the section without exception, select Apply settings to all Objects.

Changing Decimal Scaling for All Fields in All
Tabular Sections of a Report
Open a tabular section report in Report Design Aid.

1. From the File menu, select Report Properties.
2. On the Properties form, select the Decimal Scaling tab, select the appropriate level of decimal scaling and
then click OK.
To return all of the fields to their default decimal scaling settings, click Defaults.
The changes that you make on this form affect all numbers in the report except for those fields that have
been modified individually. To override individual settings and apply the changes to all of the fields in
the report without exception, select Apply settings to all Objects.

Note. Changes to properties at the report level are not reflected in existing versions of the report if the
report template has already been saved and you have exited Report Design Aid prior to making the change.

Creating Calculation Columns
This section provides an overview of calculation columns, lists the prerequisites, and discusses how to:

• Define calculation columns.

• Remove column calculations.

Understanding Calculation Columns
Calculation columns contain the result of a mathematical calculation. You can perform a calculation involving
any number of columns. When creating a calculation column, you can include any column from the section,
including columns that contain smart fields or other calculations.

When you create an application report using the Report Director, you have the option to create calculation
columns on the Select Columns form. You can also insert calculation columns after the design of the report
template is complete.

Important! Calculation columns are based on the amount signs (debit or credit) as they appear in the report,
not the actual value stored in the database.

Prerequisites
Before you begin working with calculation columns, ensure that you:

• Create a batch application object.
• Complete the design of the report template using a tabular section.
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Defining Calculation Columns
Open a tabular section report in Report Design Aid.

1. Select the tabular section in which you need to add a calculation column.
2. Insert a data dictionary field or numeric variable to hold the calculated value.
3. Drag the field to the appropriate location.
4. Click the newly created column.
5. From the Column menu, select Define Calculation.
6. On the Expression Manager form, define the calculation by performing these actions and click OK:

a. Double-click fields from the Available Information list.
b. Click the calculator functions to build the expression.

Removing Column Calculations
Open a tabular section report that contains calculation columns in Report Design Aid.

1. Click the column variable for which you want to remove the calculation.
2. From the Column menu, select Remove Calculation.
You can create a new calculation on the column or delete the column.

Working with Row Description Columns
This section provides an overview of Row Description columns, lists the prerequisites, and discusses how to:

• Create Row Description columns manually.
• Delete Row Description columns.

Understanding Row Description Columns
When you create a tabular section, the Description column is automatically included in the section layout.
The data in this column is based on data sequencing fields that are defined as level break fields. If the system
cannot retrieve a description for the field, the system prints the key for the field. The field must include a
data dictionary trigger in order for the system to retrieve a description. For example, if you define company
as a level break field and are retrieving records for Company 00001, the description of Financial Reporting
Company displays in the Row Description column if the company field includes a trigger. If no trigger is
attached to the company data dictionary field, the system displays the field key of 00001.

The Row Description column has a special capability for level breaks that are associated with the Subledger,
Cost Object, and Object Subsidiary fields. When a row of a tabular section prints due to a level break that is
caused by a change in one of these fields, the Description row automatically displays:

• Subledger and Subledger Type.
• Cost Object and Cost Object Type.
• Object Subsidiary and Object Subsidiary Type.
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Prerequisites
Before you begin working with row description columns, ensure that you:

• Create a batch application object.
• Complete the design of the report template using a tabular section.

Creating Row Description Columns Manually
Open a tabular section report in Report Design Aid.

1. Click the tabular section in which you want to insert a Row Description column.

2. From the Column menu, select Create, and then select Row Description Column.

The Description column appears.

3. Drag the column to the appropriate location.

Deleting Row Description Columns
Open a tabular section report that contains Row Description columns in Report Design Aid.

1. Select the Description column.
2. From the Edit menu, select Delete.

Creating Percent Calculations
This section provides an overview of percent calculations, lists the prerequisites, and discusses how to define
percent calculations.

Understanding Percent Calculations
You can display numbers in a column as a percent of the total in another column. This type of calculation is
used in all reporting types but most often in financial reports such as standard income statements. When used
in income statements, the percent calculation is referred to as the percent of revenue.

Prerequisites
Before you begin working with percent calculations, ensure that you:

• Create a batch application object.
• Complete the design of the report template using a tabular section or application report.
• Perform one of these actions:
- Create a percent calculation column from the Report Director. For example, if you are creating a financial
report that is based on account balances, create a column called Percent of Revenue.

- Insert a numeric variable column from Report Design Aid.
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- Add rows to the tabular section.
This step is necessary to create the 100 percent cell to use in the denominator. For example, add data rows
to hold the revenue sales and a calculation row to hold the total revenue.

Defining Percent Calculations
Open a tabular section report in Report Design Aid.

1. After adding the appropriate rows to the tabular section, click the column that you inserted for the percent
calculation.

2. From the Column menu, select Define Calculation.

3. On the Expression Manager form, define the percent calculation and click OK.

Working with Rows
This section provides an overview of tabular rows, lists the prerequisites, and discusses how to:

• Add data rows.
• Add calculation rows.
• Add sum rows.
• Add underline rows.
• Add constant rows.
• Generate rows automatically.

Understanding Tabular Rows
In tabular sections, rows consist of information that is set up horizontally. Typically, rows contain data that
is read from individual database records; however, you can add rows to include details in the report section
such as underlines, blank lines, and special calculations. Tabular sections are the only detail sections for
which you can define rows. In all cases, after you create a row, you can drag it to a new location or delete it
by selecting Delete from the Edit menu.

Rows can be defined manually or through automatic row generation. Automatic row generation is used
primarily in financial reports. A report that displays a chart of accounts is an example of data that can be
generated using the automatic row generation feature.

Rows that are defined manually are defined individually and each data row includes its own data selection.

By using Report Design Aid, you can manually add these types of rows:

• Data rows
Data rows fetch data from PeopleSoft EnterpriseOne tables. They represent groups of data fields that are
associated with the columnar amounts. For example, you can have a data row that displays revenue (column)
for a range of items. In addition, you can add a row that displays the direct costs for another range of fields.
You must define the rows and identify the data using the business view attached to the tabular section.

• Calculation rows
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Calculation rows display amounts that are calculated from other rows. For example, you can calculate the
gross margin of the revenue and direct costs rows.

• Sum rows
Sum rows define a special type of calculation. The calculation performs totaling for all numeric columns
in a range of rows. The total can include or exclude rows within the sum range that are themselves row
calculations.

• Underline rows
Underline rows enable you to create underlines to separate various rows in the report.

• Constant rows
Constant rows contain only text. They describe or label information in the tabular section, such as
identification information for a group of rows.

• Automatically generated rows
In tabular sections, the system can automatically generate rows that define a chart of accounts for a business
unit or represent the merging of accounts from several business units. Additionally, you can create rows
that calculate account roll-up totals at various levels of detail. For example, you might want the system
to automatically generate rows to create a balance sheet report that is based on the current month and the
prior year’s account balance.

The system optimizes rows with two or fewer logical expressions (nodes) that are joined by an AND operator.
The optimization accelerates report processing speed. If you include a cover page with the report, you can
review which rows the system is optimizing. In the Optimized Row column of the cover page, the system
prints a Y next to the rows that are optimized and an N next to the rows that are not. The cover page also
includes the total number of rows that are optimized (Number of Optimized Inclusion Rows) and the total
number that are not (Number of Non Optimized Inclusion Rows). You can also find the total number of
optimized rows in the UBE log file (Tabular Optimization).

Row optimization is enabled by default. As a troubleshooting measure, you can disable row optimization. To
do so, add this line to the UBE section of the jde.ini:

UBETabOpt=0

To enable row optimization, set the variable to 1 or delete the row from the jde.ini file.

Prerequisites
Before you begin working with tabular rows, ensure that you:

• Create a batch application object.
• Complete the design of the report template using a tabular section.

Adding Data Rows
Open a tabular row section report in Report Design Aid.

1. Click the tabular section.
2. From the Row menu, select Create, Data.
3. On the Data Row Properties form, on the General tab, enter the name of the data row in the Name field.
The name appears in the Name field on the Row List tab of Tabular Section properties and on the Data
Row Properties form.

PeopleSoft Proprietary and Confidential 77



Working with Objects Unique to Tabular Sections Chapter 8

4. In the Description field enter a meaningful description of the data.
The description appears on the report in the description column of the Tabular section, on the Row List
tab of the Tabular Section properties, and in the Description field of the Data Row Properties form. This
description can consist of multiple lines to accommodate as much text as required. Enter spaces in front of
the text where appropriate to indent the text on the report.

5. Set other properties as desired on other tabs and click OK.
6. On the Data Selection form, define the criteria that you want to apply to the data row, and click OK.
At any time in the future, you can modify the data selection by selecting Define Data Selection from
the Row menu.
To add rows directly beneath the last row, click the last row (indicated by a black box around the row)
and add another row.

Adding Calculation Rows
Open a tabular row section report in Report Design Aid.

1. Click the tabular section.

2. From the Row menu, select Create, Calculation.

3. On the Calculation Row Properties form, on the General tab, enter the name of the calculation row in
the Name field.

The name appears in the Name field on the Row List tab of Tabular Section properties and on the
Calculation Row Properties form.

4. In the Description field enter a meaningful description of the data.

The description appears on the report in the description column of the Tabular section, on the Row List tab
of the Tabular Section properties, and in the Description field of the Calculation Row Properties form.

5. Set other properties as desired on other tabs and click OK.

6. On the Expression Manager form, define the calculation, and click OK.

To add rows directly beneath the last row, click the last row (indicated by a black box around the row)
and add another row.

Adding Sum Rows
Open a tabular row section report in Report Design Aid.

1. Click the tabular section.
2. From the Row menu, select Create, Sum Row.
3. On the Sum Row Properties form, on the General tab, enter the name of the calculation row in the Name
field.
The name appears in the Name field on the Row List tab of Tabular Section properties and on the Sum
Row Properties form.

4. In the Description field enter a meaningful description of the data.
The description appears on the report in the description column of the Tabular section, on the Row List tab
of the Tabular Section properties, and in the Description field of the Sum Row Properties form.

5. In the From Row list, select a row to use as the beginning in a range of rows to be included in the sum.
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6. In the To Row list, select a row to use as the ending in a range of rows to be included in the sum.
7. Select the option Include Intermediate Calculation if you want the sum to include calculation rows that
reside between the From and To rows.

8. Set other properties as desired on other tabs and click OK.
To add rows directly beneath the last row, click the last row (indicated by a black box around the row)
and add another row.

Adding Underline Rows
Open a tabular row section report in Report Design Aid.

1. Click the tabular section.

2. From the Row menu, select Create, Underline.

3. On the Underline Row Properties form, on the General tab, complete the Name field.

4. Set other properties as desired on other tabs and click OK.

For example, select the Font/Color tab to modify the color of the line or the Options tab to modify the
thickness and spacing of the line.

To add rows directly beneath the last row, click the last row (indicated by a black box around the row)
and add another row.

Adding Constant Rows
Open a tabular row section report in Report Design Aid.

1. Click the tabular section.
2. From the Row menu, select Create, Constant.
3. On the Constant Row Properties form, on the General tab, enter the name of the constant row in the
Name field.
The name appears in the Name field on the Row List tab of Tabular Section properties and on the Constant
Row Properties form.

4. In the Description field enter a meaningful description of the data.
The description appears on the report in the description column of the Tabular section, on the Row List tab
of the Tabular Section properties, and in the Description field of the Constant Row Properties form.

5. Set other properties as desired on other tabs and click OK.
To add rows directly beneath the last row, click the last row (indicated by a black box around the row)
and add another row.

Generating Rows Automatically
Open a tabular row section report in Report Design Aid.

1. Click the tabular section.
2. From the Row menu, select Automatic Row Generation.

Note. Depending on how the section is designed, some fields might not appear on the form.
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3. On the Financial Account Level of Detail Row Generation form, in the Business Unit field, enter the
business unit for which you want to generate account information.

4. In the From Account field, enter the beginning account number to display on the report.
If you leave the From Account field blank, no accounts are generated.

5. In the Thru Account field, enter the ending account number to display on the report.
If you leave the Thru Account field blank, no accounts are generated.

6. In the Ledger Type (Optional) field, enter the ledger type to display on the report.
If specified, the ledger type is included in the data selection for that row.

7. In the Level of Detail field, enter the level of detail to display on the report.
Optional account level of detail rows can be generated at level of detail breaks. The default is to generate
total rows. The row amounts are based on account ranges that are specified through selection criteria.

8. Select the Totals option to generated totals for each level of detail.
9. Select one of these options under the Add Row Options heading:
• Replace
Replaces all previously defined rows with the automatically generated rows. This is the default option.

• Insert
Inserts automatically generated rows after the row you clicked before selecting the automatic row
generation option.

• Append
Appends automatically generated rows to the bottom of previously defined rows. Use the Append and
Insert options to build hybrid account structures from several different business units.

Overriding the Properties of Individual Cells
This section provides an overview of cell properties and overrides, lists the prerequisites, and discusses how to:

• Override data row variables.

• Override data row variable properties.

• Override calculation row variables properties.

• Override underline row variables properties.

• Override constant row variables properties.

Understanding Cell Properties and Overrides
Cells contain information that is located at the intersection of a column and a row of a tabular section. Cells
are populated based on how you defined the row. You can define cell overrides to override the properties
of a cell. For example, to emphasize the data in a specific cell, you can override its properties, increase the
size of the font, and make the font bold.
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You can define cell overrides to override the data that is displayed in the cell. For example, to review the
results of possible salary increases for a group of employees, you can override the monthly salary cell for an
employee to change the annual income calculation.

To override a cell, you must first enter cell mode. In Report Design Aid, you can toggle cell mode from the
Cell menu. When you are in cell mode, you can click an individual cell and the cell is outlined by a solid-line
rectangle. When you are not in cell mode and you click an individual cell, the entire row is outlined by
a solid-line rectangle.

Cells that include cell overrides are outlined by a dashed-line rectangle. You can override variable cells
in these types of rows:

• Data rows.
• Calculation rows.
• Underline rows.
• Constant rows.

Prerequisites
Before you begin overriding individual cells, ensure that you:

• Create a batch application object.

• Complete the design of the report template using a tabular section.

Overriding Data Row Variables
Open a tabular row section report in Report Design Aid.

1. Click the tabular section.
2. From the Cell menu, select Cell Mode.
3. Click the cell that you want to override.
4. From the Cell menu, select Create Override, Data.
5. On the Cell Properties form, on the General tab, modify the name and description as required.
6. On the Expression Manager form, define the expression to populate the cell with a new value and click OK.

Overriding Data Row Variable Properties
Open a tabular row section report in Report Design Aid.

1. Click the tabular section.
2. From the Cell menu, select Cell Mode.
3. Click the cell that you want to override.
4. From the Cell menu, select Create Override, Calculation.
5. On the Cell Properties form, on the General tab, modify the name and description as required and click OK.
6. Set properties as desired on available tabs, and click OK.
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Overriding Calculation Row Variable Properties
Open a tabular section report in Report Design Aid.

1. Click the tabular section.
2. From the Cell menu, select Cell Mode.
3. Click the cell that you want to override.
4. From the Cell menu, select Create Override, Calculation.
5. On the Cell Properties form, on the General tab, modify the name and description as required.
6. Set properties as desired on available tabs, and click OK.
7. On the Expression Manager form, define the calculation by performing these actions, and click OK:
• Double-click fields from the Available Information list.
• Click the calculator functions to build the expression.

Overriding Underline Row Variable Properties
Open a tabular section report in Report Design Aid.

1. Click the tabular section.
2. From the Cell menu, select Cell Mode.
3. Click the cell that you want to override.
4. From the Cell menu, select Create Override, Underline.
5. On the Cell Properties form, on the General tab, modify the name and description as required.
6. Set properties as desired on available tabs, and click OK.

Overriding Constant Row Variable Properties
Open a tabular section report in Report Design Aid.

1. Click the tabular section.

2. From the Cell menu, select Cell Mode.

3. Click the cell that you want to override.

4. From the Cell menu, select Create Override, Constant.

5. On the Cell Properties form, on the General tab, modify the name and description as required.

6. Set properties as desired on available tabs, and click OK.
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Modifying the Appearance of Report Objects

This chapter provides an overview of the appearance of report objects and discusses how to:

• Work with section descriptions.

• Hide report sections.

• Align fields and columns.

• Modify field lengths and column widths.

• Use absolute position for text wrapping.

• Change column spacing.

• Change font properties.

• Activate dynamic positioning.

• Define font substitutions.

• Use True Type fonts.

• Justify text.

• Change numerical formatting.

• Associate lines and boxes.

• Reprint the last line of a page on the succeeding page.

• Insert page breaks.

Understanding the Appearance of Report Objects
Every object in a report, such as a section, column heading, column variable, runtime field, or constant, has its
own set of properties. Modify the properties of an object to change how it looks or behaves. For example,
you can change the font size of a column heading or change the text to reflect company jargon. You can also
modify the format of the report by changing column and row spacing and object alignment.

Working with Section Descriptions
This section provides an overview of section descriptions, lists the prerequisites, and discusses how to
change section descriptions.
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Understanding Section Descriptions
Section descriptions appear on the tile on the left-hand side of the report section in the Report Design Aid
form. If you do not want to view these tiles, you can hide them in User Options.

Typically, detail section descriptions are the same as the description of the attached business view. Level break
sections are typically named after the level break field on which it is based. For example, the description for a
level break header including the search type field is On Search Type.

When you create a custom section and attach the same business view as the level one section, both sections
have the same description. When you create a group section to hold grand totals, the section is untitled.
You can change the section description from the section properties form. For the grand total section, you
can modify the description to read Grand Totals.

Prerequisites
Before you begin changing section descriptions, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Changing Section Descriptions
Open a report template in Report Design Aid.

1. Double-click the section that you want to change.
2. On the appropriate section properties form, on the General tab, enter a new name in the Description
field and click OK.

Hiding Report Sections
This section provides an overview of hiding report sections, lists the prerequisites, and discusses how to:

• Hide and display report sections unconditionally.
• Display detail sections conditionally.

Understanding Hiding Report Sections
You can hide a report section if the sole purpose of the section is to provide logic to be used by another section.
You can select the Show Invisible Sections At Startup option in User Options to view hidden sections of a
report in Report Design Aid. Hiding this type of section is referred to as unconditional. The section is never
meant to display in the report.

You can also hide a report section based on certain criteria. Hiding this type of section is referred to as
conditional, the section displays only when the condition is met. The condition can be logic designed to show
the section only when a field value reaches a certain amount. Another condition might be when the user
indicates that the section is required in the report.
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Prerequisites
Before you begin hiding report sections, ensure that you:

• Create a batch application object.
• Complete the design of the report template.

Hiding and Displaying Report Sections Unconditionally
Open a report template in Report Design Aid.

1. Double-click the report section you want to affect.

2. On the appropriate section properties form, select the Advanced tab.

3. Select the Visible option to display the report section or clear the Visible option to hide the report
section and then click OK.

Displaying Detail Sections Conditionally
Open a report template in Report Design Aid.

1. Click the section from which you want to call the conditional section and select Event Rules from the
Edit menu.

2. Click the down arrow in the toolbar and select the Do Section event.
3. From the Insert menu, select If/While and define the criteria for displaying the conditional section.
4. Click the If/While statement and select System Function from the Insert menu.
5. On the Function Selection tab, expand the Section folder and double-click Do Custom Section.
6. On the Parameter Mapping tab, double-click the report section that you want to display only when the
defined criteria is met.
The section appears in the Values column of the Parameters table.

7. Click OK and save the event rules.
8. On the PeopleSoft Report Design Aid form, double-click the report section that you want to be the
conditional section.

9. On the appropriate section properties form, select the Advanced tab.
10. Select the Conditional option and click OK.

Aligning Fields and Columns
This section provides an overview of aligning fields and columns, lists the prerequisites, and discusses how to:

• Align fields within sections.
• Align fields and columns across sections.
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Understanding Aligning Fields and Columns
When you create report sections, fields and columns might not line up properly. Report Design Aid provides
alignment options to enable you to precisely adjust the appearance of the report output. For example, you
create a columnar report with a level break footer that calculates a total. You change the size of the columns in
the columnar section and the total in the level break footer no longer aligns with the column it is totalling.

When you select to align fields you are presented with options based on whether you are aligning objects
within a section or across sections. On the Align Objects form, options are listed under two headings:

• Left to Right.
These options are available for aligning within sections and across sections.

• Top to Bottom.
These options are available for aligning across sections only.

When you align data fields, use these guidelines:

• Clear the focus of the cursor in all report sections before you select the objects for alignment.
Click an empty portion of each report section to clear the focus of the cursor. You could have the cursor
focused on a field in the a section, such as the page header, and not realize it. When you select to align the
field, the field from the other section, such as the page header, will be aligned with the selected fields.

• Designate one object as an anchor to which other objects are aligned.
The anchor is indicated by a black border; the objects to be aligned with it are indicated by a gray border.
The anchor field is the last field that you select during the alignment process.

• The black border indicates the currently selected field.
• The entire object must be selected for alignment, not just the constant text or variable.
• The anchor can be a disconnected constant or variable object.
• The objects selected can be within the same section or across sections.
• The fields are aligned rather than the text within the fields.
This is especially noteworthy when you center-align fields. Objects are centered based on field length
and not on the length of the text within the fields.

• The alignment process cannot be used on tabular rows.

When you align columns with other columns or fields, use these guidelines:

• To align columns from tabular and columnar sections with group section objects, the column in the tabular or
columnar section must be the anchor for the alignment.

• To align columns from tabular and columnar sections with columns in other columnar or tabular sections,
you can select only one column in each tabular or columnar section to align.

Prerequisites
Before you begin aligning fields and columns, ensure that you:

• Create a batch application object.
• Complete the design of the report template using a columnar section.
• Include a level break footer with a label.
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Aligning Fields Within Sections
In Report Design Aid, open a columnar report template that includes a level break footer.

1. Select the aggregate label in the level break footer.
2. Hold down the CTRL key and click the total field.
3. From the Layout menu, select Align.
4. Select the Current Sectionoption under the Apply to heading.
5. Select one of these options under the Top to Bottom heading:
• Top Edges
• Middle
• Bottom Edges
• No Changes

6. Click Apply to view the changes without leaving the form.

Aligning Fields and Columns Across Sections
In Report Design Aid, open a columnar report template that includes a level break footer.

1. Select the total in the level break footer.
2. Hold down the CTRL key and in the columnar section, click the column variable associated with the total.
3. From the Layout menu, select Align.
4. Select the All Sections option under the Apply to heading.
5. On the Align Objects form, select one of these options under the Left to Right heading:
• Left Edges.
• Center.
• Right Edges.
Typically, when aligning numeric values, you want to align by the right edges so that the decimal
places lines up properly.

• No Changes.
6. Click Apply. to view the changes without leaving the form.

Modifying Field Lengths and Column Widths
This section provides an overview of field lengths and column widths, lists the prerequisites, and discusses
how to:

• Modify the length of fields.

• Modify the width of columns.
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Understanding Field Lengths and Column Widths
Changing the length of a field and changing the width of a column do not yield the same results. You can
modify the display length of most fields from the item properties form. Changing the length of a field changes
the number of characters that the batch engine places in the field. For example, in a report, you include an
address number field that is defined in data dictionary to accommodate 20 characters. None of the records in
the report include an address number longer than five characters. In the item properties form, you can modify
the display length of the address number field to five. The address number field displays five characters on the
report. Since the column width is large enough to accommodate 20 characters, you see the five characters
followed by a large amount of white space. To eliminate the white space, you can size the address number
column so that it is only as wide as the five character display length.

Changing the width of a column changes the amount of space that is allotted for display. You can change the
size of columns in the Report Design workspace. This method of changing the column size does not affect
the field length. If you size the column to be smaller than its associated data, the data is truncated. If it
is a numeric field the column contains asterisks.

When you enter a column heading that is too long for the column heading length, the entire column heading
displays on the report, often times overlapping other columns. Report Design Aid provides you with two
column heading fields for each column so that you can split longer column headings into two lines.

When a string data type, such as media objects, is fetched from the database, the data text wraps within the
column. When a field is populated with data that is longer than the field length, and that does not reside in the
database, the data is truncated.

Prerequisites
Before you begin modifying field lengths and column widths, ensure that you:

• Create a batch application object.
• Complete the design of the report template using a columnar section.

Modify the Length of Fields
Open a columnar section report template in Report Design Aid.

1. Double-click the field you want to size.
2. On the applicable Properties form, select the Display tab.
If the Properties form does not include a Display tab, you cannot change the length of the field.

3. Enter a new length in the Display Length field, or click the arrow buttons to increase or decrease the
length, and click OK.

Modify the Width of Columns
Open a columnar section report template in Report Design Aid.

1. Click the column heading.

Note. The column heading is outlined and includes a small solid black box on the right edge. This box
indicates that you can manually size the object. Otherwise, the column width can not be changed manually.

2. Place the cursor over the small black box until the cursor changes to a horizontal line with an arrow on
both ends.
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Ensure that the cursor is not a plus sign with arrows on each end.
3. Click and drag the black box until the column is the size you require.

Using Absolute Position for Text Wrapping
This section provides an overview of absolute position, lists the prerequisites, and discusses how to activate
absolute position.

Understanding Absolute Position
The absolute position option enables you to wrap text that is fetched from the database. This option does not
affect text populated through event rules or entered into constant fields.

When you select the absolute position option, text is truncated in fields where the display length is too short.
The system leaves the text in its absolute position. When you clear the absolute position option, this text
is wrapped to the next line of the field.

Note. You cannot define text wrapping for individual fields; you must apply text wrapping to an entire
report section.

Prerequisites
Before you begin activating absolute position, ensure that you:

• Create a batch application object.
• Complete the design of the report template.

Activating Absolute Position
Open a report template in Report Design Aid.

1. Double-click the section in which you want to wrap text.

2. On the section properties form, select the Advanced tab.

3. Select the Absolute Position option to inactivate text wrapping or clear the option to activate text wrapping
and then click OK.

If the Advanced tab does not have an Absolute Position option, you cannot inactivate text wrapping
for the section.

Note. The absolute position option is cleared by default.

Changing Column Spacing
This section provides an overview of column and row spacing, lists the prerequisites, and discusses how to:

• Modify column spacing.
• Modify row spacing in columnar sections.
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• Modify row spacing in tabular row sections.

Understanding Column and Row Spacing
You can modify the space between columns and the space between rows of columnar and tabular report
sections.

In the spacing option, which is only available for columnar and tabular sections, there are two tabs:

• Column Spacing
• Row Spacing

The column spacing option enables you to center columns under the page header information. You can
modify the spacing between all columns of the section or between individual columns. You can also highlight
information in a specific column by adding spaces to set the column apart from the other columns.

On the Column Spacing tab, you can select all columns or indicate specific columns to affect. You enter a value
in the Space before selected columns field to indicate the amount of space you want between the columns. You
can click Apply to view the new spacing before leaving the form to ensure that the selection meets your needs.

You can also change the spacing of rows to improve the appearance of a report. From the Row Spacing tab,
you can modify the spacing between:

• The page header and the detail section.
• The rows in the detail section.

Prerequisites
Before you begin changing column spacing, ensure that you:

• Create two batch application objects.

• Complete the design of the first report template using a columnar section.

• Complete the design of the second report template using tabular rows.

Modifying Column Spacing
Open a columnar section report in Report Design Aid.

1. Click the columnar or tabular section in which you want to modify column spacing.
2. From the Layout menu, select Spacing.
3. On the Column Spacing tab, perform one of these actions to apply the spacing to columns:
• Click the Select All Columns button to apply the spacing to all columns in the section
• Select specific columns from the list to which you want to apply the spacing

4. In the Space before selected columns field, enter the number of spaces you want to appear before the
selected columns and click OK.
The default value is set at five spaces.

Modifying Row Spacing in Columnar Sections
Open a columnar section report in Report Design Aid.

90 PeopleSoft Proprietary and Confidential



Chapter 9 Modifying the Appearance of Report Objects

1. Select the columnar section you want to change.
2. From the Layout menu, select Spacing.
3. On the Columnar Section Spacing form, select the Row Spacing tab.
4. Select a Header to Detail option and a Detail to Detail option:
• Single
• Single + Half
• Double

Note. Only single spacing is supported for CSV files. Only single and double spacing is supported
for line printers.

5. Click Apply, and click OK.

Modifying Row Spacing in Tabular Row Sections
Open a tabular row section report in Report Design Aid.

1. In the tabular section, double-click a row to create a space above it.
2. On the appropriate row properties form, select the Options tab.
3. Enter a value in the Space Before field and click OK.

Changing Font Properties
This section provides an overview of font properties, lists the prerequisites, and discusses how to:

• Change font properties of individual fields.

• Change font properties of all fields in a section.

• Change font properties of all fields in a report.

• Create objects with bar code fonts.

Understanding Font Properties
A font is a set of print characters. Examples of fonts include Courier New and Arial. Typically, fonts include
variations such as bold and italic. Properties such as alignment and spacing are not considered font variations
and may be applied separately to text in the report. You can use multiple fonts in a single report. Some
fonts may be converted to PDF, PostScript, or Printer Control Language (PCL) files; line printers are fairly
limited in the types of fonts they can print.

Fonts are classified as either proportional or nonproportional. Proportional fonts include different pitches
(widths) for different characters. In a proportionally spaced font, the letter I is narrower than the letter q.
Examples of fonts with proportional spacing are Arial and Times New Roman. While proportionally spaced
fonts generally create a more visually pleasing document, they can be difficult to align because of the
varying widths of characters.

Nonproportional fonts refer to fonts in which every character has the same width. Most typewriters and line
printers use these fonts. Examples of nonproportional fonts are Courier New and MS Gothic.
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The PDF generation, PostScript and PCL conversion can support any font size. For line printers, it is
recommended that you generate the PDF file with nonproportional fonts and a font size of 10.

The 14 base fonts that Report Design Aid supports, along with their valid printer types, are illustrated in
this table:

Font Faces Postscript PCL Line PDF

Courier New X N/A X X

Courier New - Bold X N/A N/A X

Courier New - Italic N/A N/A N/A N/A

Courier New - Bold
Italic

N/A N/A N/A N/A

Arial X X N/A X

Arial - Bold X N/A N/A X

Arial - Italic N/A N/A N/A N/A

Arial - Bold Italic N/A N/A N/A N/A

Symbol N/A N/A N/A X

Times New Roman X X N/A X

Times New Roman -
Bold

X N/A N/A X

Times New Roman -
Italic

N/A N/A N/A N/A

Times New Roman -
Bold Italic

N/A N/A N/A N/A

ZapfDingbats N/A N/A N/A X

You can change font properties at three levels in the report template:

• Field
When you change the font properties for a field, the change affects only that field.

• Section
When you change the font properties for a section, the change affects all fields in the section, except for
those fields that have been changed individually. To apply the changes to all fields in the section without
exception, select the Apply settings to all Objects option.

• Report
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When you change the font properties for the report, the change affects all fields in all sections of the report,
except for fields in sections that have been changed at the section level and those fields that have been
changed individually. To apply the changes to all fields in the report without exception, select the Apply
settings to all Objects option.

Font Colors
Although you can select any color from the Font dialog to view reports online, the system supports only eight
colors for PCL and 16 colors for PostScript and black for line printers. Both PostScript and PDF generation
use the RGB model for color. PCL uses the Simple Color RGB model that provides only eight colors.

Refer to the color support table, where X is supported and blank is not supported:

Font Colors PostScript PCL Line PDF

Black X X X X

Blue X X N/A X

Cyan X X N/A X

Dark Blue X N/A N/A X

Dark Cyan X N/A N/A X

Dark Green X N/A N/A X

Dark Gray X N/A N/A X

DarkMagenta X N/A N/A X

Dark Red X N/A N/A X

Green X X N/A X

Light Gray X N/A N/A X

Magenta X X N/A X

Olive Green X N/A N/A X

Red X X N/A X

Yellow X X N/A X

White X X N/A X

Double-Byte Fonts
In a double-byte environment, fonts receive special treatment within the universal batch engine and Output
Management. In Report Design Aid, you can select any font that is available in the system and assign it to the
report, section, or object. However, in a double-byte environment, only the fonts included in this table are
supported when the PDF file is generated:
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Language Font Name

Simplified Chinese STSong-Light-Acro

Traditional Chinese Mhei-Medium-Acro

Korean HYGothic-Medium-Acro

Japanese HeiseiMin-W3-Acro, MS Gothic (true type font)

Japanese, Simplified Chinese, Traditional Chinese, and Korean languages do not support PCL.

Bar Code Fonts
You can use bar code fonts to create bar codes in reports. Report Design Aid provides base bar code
functionality for reports and batch job output and supports Code 39 fonts for both PCL and PostScript
conversion. The True Type font name is BC C39 3 to 1 Medium. The bar code fonts can be seen in Report
Design Aid, previewed, and then printed. Bar codes print on both PCL and PostScript printers. Since font
vendors do not sell scalable PCL fonts, only fixed-point sizes are supported for PCL. The recommended point
size range for PostScript is 8 to 24 points.

To specify a particular bar code, you must enter the encoding for that bar code in the constant properties. The
encoding is a series of characters and numbers that are preceded and followed by asterisks (*) to identify
the text as a bar code.

Prerequisites
Before you begin changing font properties, ensure that you:

• Create a batch application object.
• Complete the design of the report template.

Changing Font Properties of Individual Fields
Open a report template in Report Design Aid.

1. Right-click the field in the report that you want to change.
2. Select Properties from the menu.
Depending on the field type, an appropriate properties form appears.

3. On the properties form, select the Font/Color tab, change the font properties and click OK.

Changing Font Properties for All Fields in a Section
Open a report template in Report Design Aid.

1. Double-click the report section that you want to change.

2. On the section properties form, select the Font/Color tab, change the font properties and click OK.

Changing Font Properties for All Fields in a Report
Open a report template in Report Design Aid.
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1. From the File menu, select Report Properties.
2. On the report properties form, select the Font/Color tab, change the font properties and click OK.

Creating Objects with Bar Code Fonts
Open a report template in Report Design Aid.

1. Double-click a constant.

2. On the Constant Properties form, select the Font/Color tab.

3. Complete these fields:

• Font
The font is the bar code font name (for example, font “3 to 9 bar code”).

• Font Style
• Size
You can view a sample of how the font appears in case you need to make changes.

4. Select the General tab.

5. Enter the correct encoding sequence for the bar code in the Name field and click OK.

You can see the bar codes in Report Design Aid.

6. View the report in Preview mode to display the bar codes.

When you submit the batch job, the Job Submission form also displays the bar codes properly.

After you set up the bar code in the report, you must link the printer font name and the True Type font
name to a physical printer in the Bar Code Support application before you print to either a PostScript
or PCL printer.

7. From the Batch Processing Setup menu (GH9013), select Bar Code Support, and complete these fields:

• Printer Name
• True Type Font Name

• Printer Font Name

The printer font name comes from the font vendor (for example, Code39Three).

• Printer Definition Language

If you are printing to a PCL printer, you must also complete the Symbol Set ID field.

After you set up the bar code, you can use a scanner to test the bar code output.

Activating Dynamic Positioning
This section provides an overview of dynamic positioning and discusses how to activate dynamic positioning
for a server or client.
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Understanding Dynamic Positioning
Dynamic positioning is most useful when you print reports in multiple languages. For example, you print
a report in English, Greek, and Chinese. You can print the English reports in Arial, the Greek report in
Haettenschweiler, and the Chinese report in SimSun. Since the Haettenschweiler and SimSun fonts are wider
than the Arial font, the objects on the report need to be repositioned to prevent overlap.

The dynamic positioning feature:

• Enables you to designate a new font when the report is printed on a line printer or in a foreign language.

• Automatically adjusts the width of objects on a report so that they do not overlap when a font substitution
occurs.

Dynamic positioning is also useful when you send many reports to a line printer and want them in different
fonts so they are easier to read. When sending reports to a line printer, you must use nonproportional fonts.

Dynamic positioning does not adjust for the height of report objects when you substitute fonts. If you use font
substitution for a report, space the report objects on different lines that are farther apart.

To use dynamic positioning:

• Activate dynamic positioning on the machine where the reports are processed.
Enable dynamic positioning by inserting this line in the UBE section of the jde.ini file:

[UBE]

UBEDynamicPositioning=1

If you run reports that require dynamic positioning on multiple machines, you must enable dynamic
positioning on each machine. After you activate dynamic positioning on a machine, you should not
deactivate it. You can, however, override dynamic positioning for an individual report.

• Define font substitutions for languages and line printers.

If the report is already formatted in the font that you want, you can disable font substitution for the report.
Once you disable the font substitution feature and save the report, font substitution remains disabled for
the report. You must reestablish font substitution by clearing the override if you want to font substitution
in the future. You can view a report with font substitutions applied.

Activating Dynamic Positioning for a Server or Client
Using an editor program, access the appropriate jde.ini file, either server or client.

1. In the [UBE] section, enter:

UBEDynamicPositioning=1

2. Save and close the jde.ini file.

Defining Font Substitutions
This section provides an overview of font substitutions, lists the prerequisite, and discusses how to:

• View font substitutions by language type.
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• Define font substitutions for language and line printers.
• Change font substitutions by language type.
• Override font substitutions for reports.
• Apply font substitutions to report templates.

Understanding Font Substitutions
Font substitution enables you to indicate a different font, not a font size. When the font substitution is made,
dynamic positioning automatically adjusts the position of items on the report to accommodate the width of the
new font. It does not adjust the height of items on the report.

Font substitution is most useful for defining fonts in reports that are intended to be:

• Sent to a line printer
• Printed in a foreign language

Prerequisite
Activate dynamic positioning in the appropriate jde.ini file.

Viewing Font Substitutions by Language Type
Access the Batch Processing Setup menu (GH9013).

1. Select Font Substitution by Language Type.
2. On the Work with Font Substitution by Language Type form, enter the language type in the QBE line
and click Find.
The form displays all defined font substitutions for the language type that you entered.

Defining Font Substitutions for Language and Line Printers
Access the Work with Font Substitution by Language Type form.

1. Click Add.
2. On the Font Substitution by Language Revisions form, enter a language in the Language Type field
using the appropriate user defined code.

If you are defining a font substitution for a line printer, leave this field blank to select Domestic Language.

3. In the Original Font Name field, select the font that you are replacing.

For a line printer, enter *JDE LINE.

4. In the New Font Name field, select the new font that you want to use on the report and click OK.

For a line printer, you must use a nonproportional font such as Courier New.

Changing Font Substitutions by Language Type
Access the Work with Font Substitution by Language Type form.

1. Double-click the font substitution that you want to change.
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2. On the Font Substitution by Language Type Revisions form, modify the New Font Name field and click
OK.

Overriding Font Substitutions for Reports
Open a report template in Report Design Aid.

1. From the File menu, select Report Properties.

2. On the properties form, select the Advanced tab.

3. In the Dynamic Positioning section, click Apply System Language Font.

If the Apply System Language Font option is disabled, and the Don’t Dynamically Position option is
deselected, review the dynamic positioning setting in the jde.ini file.

4. On the Would you like to reposition the report objects based on the System Language Font? message box,
click No to ignore the system language font and click OK.

Once you have saved the report with the override defined, the system does not apply font substitutions to
the report.

Applying Font Substitutions to Report Templates
Open a report template in Report Design Aid.

1. From the File menu, select Report Properties.
2. On the properties form, select the Advanced tab.
3. In the Dynamic Positioning section, click Apply System Language Font.
4. On the Would you like to reposition the report objects based on the System Language Font? message box,
click Yes to apply the System Language Font to the report.
If a font substitution has been defined for the font that is currently used on the report, the system replaces
the current font and dynamically repositions objects on the report to accommodate the new font.

Using True Type Fonts
This section provides an overview of True Type fonts and discusses how to assign fonts by report language.

Understanding True Type Fonts
When you submit batch versions, PDF files are generated on the server using True Type fonts. PeopleSoft
software provides several True Type fonts, such as Arial, Courier, and Times New Roman. In addition to these
fonts, you can purchase or download additional True Type fonts.

To download Arial, Courier, and Times New Roman fonts, go to sourceforge.net. If you want a PDF to
contain Asian and European Long (WGL4) characters, you should purchase or download a font that is similar
to Arial Unicode MS.

By default, all PDFs are generated using the Arial font. To override the Arial font, use the Work with Fonts
form to assign fonts by report language.
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Assigning Fonts by Report Language
In the Fast Path field, enter P98980.

1. On the Work With Fonts form, complete the Language field and click Find.
The fonts assigned to the selected language appear in the grid.

2. If you want to add a new assignment for the language that you selected, click Add.
3. If you want to change an assignment for the language that you selected, highlight the appropriate line
in the grid and click Select.

4. On the Language Font Revisions form, in the Language field, enter the language for which you are
adding an assignment.
If you are modifying an assignment, this field is unavailable.

5. Click the Font button next to the Font ID - Report field.
6. On the Font form, select from these font properties and click OK:
• Font
• Font style
• Size
• Script
The selected font displays on the Language Font Revisions form.

7. Click the Font button next to these fields to make the same change for fonts that appear on forms and
grids and then click OK:
To keep the fonts on forms and grids as they are, without the change, select System under Font.
• Font ID - Form.
• Font ID - Grid.

Justifying Text
This section provides an overview of text justification, lists the prerequisites, and discusses how to change
text justification for variables.

Understanding Text Justification
Justification refers to how text lines up horizontally within the space allotted for the text. You can affect the
alignment of text in columns and in most variables. You cannot set text justification for constants, however. In
Report Design Aid, you can right align, center, or left align text.

Justification is relative to the frame of the object. For example, if you center text, the text is centered within
the frame of the object, not centered on the page. The Batch Engine supports left and center alignment for
all fonts and languages.

For Japanese languages, right alignment is fully supported for Japanese 7-, 8- and 9-point size MS Gothic fonts
only. For Chinese and Korean fonts, right alignment is not supported.

Bar codes must be left-aligned in Report Design Aid.

PeopleSoft Proprietary and Confidential 99



Modifying the Appearance of Report Objects Chapter 9

Prerequisites
Before you begin justifying text, ensure that you:

• Create a batch application object.
• Complete the design of the report template.

Changing Text Justification for Variables
Open a report template in Report Design Aid.

1. Double-click the field for which you want to define justification.

2. On the applicable properties form, select the Display tab.

3. Select the appropriate justification, or click Defaults to return the object to the default justification style,
and then click OK.

Changing Numerical Formatting
This section provides an overview of numerical formatting, lists the prerequisites, and discusses how to
change the appearance of numeric fields.

Understanding Numerical Formatting
In Report Design Aid, you can control the number of digits to display after a decimal for a numeric field.
Through edit codes, you can control whether to use commas, how to display positive and negative values, and
how to display monetary values.

Note. You can also control the display of positive and negative numbers using processing options. Processing
options override the settings entered in Report Design Aid.

Prerequisites
Before you begin changing numerical formatting, ensure that you:

• Create a batch application object.
• Complete the design of the report template.
• Include a numeric field.

Changing the Appearance of Numeric Fields
Open a report template that contains numeric fields in Report Design Aid.

1. Double-click the numeric field for which you want to change the formatting.

2. On the applicable properties form, select the Display tab.

3. Enter the number of decimal places to display in the Display Decimals field or click the arrow buttons to
increase or decrease the number of decimal places.
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Note. Setting display decimals is ineffective if currency has been enabled for the system.

4. If available, select the Edit Code field and use the visual assist to select a formatting style.
5. Click Defaults to return the object to its default style and then click OK.

Associating Lines and Boxes
This section provides an overview of lines and boxes, lists the prerequisites, and discusses how to add lines
and boxes to fields.

Understanding Lines and Boxes
You can apply a rectangle or other line styles to most fields in a report section. Single and double lines are
available to position either above or below the fields. You cannot enclose columns or entire report sections in
boxes.

These available line options are the same for both column headings and variables:

• No Lines
This option is selected by default for variable fields. You must clear this option to activate the remaining
options.

• Single Rectangle
• Single Line Over
• Double Line Over
• Single Line Under
This option is selected by default for column headings.

Prerequisites
Before you begin associating lines and boxes, ensure that you:

• Create a batch application object.
• Complete the design of the report template.

Adding Lines and Boxes to Fields
Open a report template in Report Design Aid.

1. Double-click the field you for which you want to add lines or boxes.
2. On the applicable Properties form, select the Style tab.
3. Clear the No Lines option to activate the other options on the form.
4. To enclose the field in a box, select Single Rectangle and then click OK.
Otherwise, select the line style you desire. The sample box on the form illustrates the selection.
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Reprinting the Last Line of a Page on the Succeeding Page
This section lists the prerequisites and discusses how to print the last line of a page as the first line on the
succeeding page.

Prerequisites
Before you begin printing the last line of a page as the first line of the succeeding page, ensure that you:

• Create a batch application object.

• Complete the design of the report template using a group or columnar section.

Printing the Last Line of a Page as the First Line
on the Succeeding Page
Open a columnar or group section report template in Report Design Aid.

1. Double-click the group or columnar section that you want to affect.
2. On the applicable Section form, select the Advanced tab.
3. Select Reprint At Page Break and click OK.

Inserting Page Breaks
This section provides an overview of manual page breaks, lists the prerequisites, and discusses how to insert
manual page breaks.

Understanding Manual Page Breaks
You can insert manual page breaks (that is, cause the report to stop printing on the current page and start
printing on the next page) after report headers, detail sections and level break footers. You cannot use the
page break feature for all three section types in the same report. You can use the page breaks feature in the
report header and level break footer simultaneously.

Prerequisites
Before you begin inserting manual page breaks, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Inserting Manual Page Breaks
Open a report template in Report Design Aid.

1. Double-click the report header, detail section or level break footer section that you want to affect.
2. On the appropriate Properties form, select the Advanced tab.
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3. Select Page Break After and click OK.
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Including Attachments and Comments in Reports

This chapter provides an overview of attachments and comments and discusses how to add attachments and
comments.

Understanding Attachments and Comments
You can include attachments and comments in reports and batch versions. Attachments are added to the report
template or version. Comments are added to individual fields of the report or batch version. Both can be used
to include detail that is important to you or another report designer.

Adding Attachments and Comments
This section provides overviews of attachments and comments, lists the prerequisites, and discusses how to:

• Add and delete attachments.
• Add, modify, and delete comments.

Understanding Attachments
Attachments are added to reports and batch versions using the Attachment tab in the Design workspace.

The Attachments workspace is split into two panes. The left pane is the icon pane, and the right pane is the
viewer pane. These attachment types are available in the icon pane:

• Text
• Image
• OLE
These files conform to the object linking and embedding (OLE) standard.

• Shortcut
• URL/File

You can use attachments to provide generic help text for reports that need to be company-specific or to
document changes that you made to a report. You cannot print attachments with a report; you can only
view the attachments in Report Design. Attachments are saved as media objects. For example, attachments
are beneficial in explaining that the format of a report uses a subsection join to present all of the required
information.
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Understanding Comments
Comments are text only and are added to an individual report object. Comments can be attached to any field
type. In group sections, you can attach comments to the constant or the variable portion of a field; you must
select one or the other, not the constant and variable together. For example, comments are beneficial in
explaining the logic used to populate fields that are not fetched the database.

A field that has a comment attached displays a visual cue. This field presents options to:

• Show Comment
If the comment is visible, this option will display Hide Comment.

• Edit Comment
• Delete Comment

Prerequisites
Before you begin adding attachments and comments, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Adding and Deleting Attachments
Open a report template in Report Design Aid.

1. Select the Attachments tab.
2. To add text, type the desired text in the viewer pane.
You can use the formatting tools at the top of the viewer pane to format the text of the attachment.

3. To add an object that is not text, right-click in the icon pane.
4. From the pop-up menu, select New, and then select an appropriate option.
5. To remove an object, right-click the object’s icon in the icon pane and select Delete from the pop-up menu.

Adding, Modifying, and Deleting Comments
Open a report template in Report Design Aid.

1. Right-click the object to which you want to attach the comment, and select Insert Comment.
2. Enter the text, and then click anywhere in the design workspace to close the text window.
A red triangle appears in the upper-right corner of the object to indicate that a comment is attached to
this object.

3. To modify, delete, show, or hide the comment, right-click the object and select the appropriate option
from the pop-up menu.
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Inserting Header and Footer Sections

This chapter provides an overview of headers and footers and discusses how to create headers and footers.

Understanding Headers and Footers
Report header and footer sections and page header and footer sections are special-purpose sections that contain
constant, variable, and runtime fields. Typical information in these headers and footers is the company name,
the name of the report, the date on which the report is printed, and page numbers. Because header and footer
sections typically provide commentary or system-related information rather than data from tables, they
are not associated with business views.

When you create a new report template, you are presented with header and footer section options on the
Welcome form of the Report Director. You can also add these sections to report templates from the Report
Design Aid menu.

When you add header and footer sections to a report template, they are added to the bottom of the report view
in Report Design Aid. However, when you print the report, the sections print in the appropriate order. The
properties and format of report headers and footers, and page headers and footers are similar to group sections.

Creating Headers and Footers
This section provides overviews of header and footers, lists the prerequisites, and discusses how to:

• Create report headers.
• Create page headers.
• Create page footers.
• Create report footers.

Understanding Headers
Report Design Aid presents you with two options for including headers in reports:

• Report headers
A report header appears once at the beginning of the report, before the page header. You can only create one
report header in a report template. Use the report header to include information regarding the entire report.

• Page headers.
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A page header appears on every page of the report. The page header is typically populated automatically by
the system. The page header is populated using runtime fields that capture the company name, report name
and description, date, time, and page number. You can only create one page header in a report template.
When you add a page header to an existing report template, you can select to either create an empty page
header section or to allow the system to populate the section automatically.

Understanding Footers
Report Design Aid presents you with two options for including footers in reports:

• Page Footers.
A page footer appears on every page of the report. You typically populate the page footer using constants.
You can only create one page footer in a report template. A page footer might include a description of
what is included in the report.

• Report Footers.

A report footer appears once at the end of the report, on its own page, after the last record is printed. You
can only create one report footer in a report template. A report footer might include a legal disclaimer or
some other text to conclude the report.

Prerequisites
Before you begin creating headers and footers, ensure that you:

• Create a batch application object.
• Complete the design of the report template without including header and footer sections.

Creating Report Headers
Open a report template in Report Design Aid.

1. From the Section menu, select Create, Headers and Footers, Report Header.
An icon is added to the Report Tree window and an empty section is added to the Report View.

2. Click the report header.
3. Select fields from the Insert menu and drag them to the report header section where you want them
to appear.
You can add any type of data field except business view columns.

4. From the Section menu, select Section Properties or double-click the Report Header section to open the
Report Header form.

5. Define section properties as appropriate and click OK.

Creating Page Headers
Open a report template in Report Design Aid.

1. From the Section menu, select Create, Headers and Footers, Page Header.

2. Select Section Only to create an empty page header that you can populate manually.

You can also select Auto Create to allow the system to automatically populate the page header section.
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3. Click the page header.
4. Select fields from the Insert menu and drag them to the page header section where you want them to appear.
You can add any type of data field except business view columns.

5. From the Section menu, select Section Properties or double-click the Page Header section to open the
Page Header form.

Note. You can add extra white space between the page header and the subsequent report section by
placing a blank constant field below the header text.

6. Define section properties as appropriate and click OK.

Creating Page Footers
Open a report template in Report Design Aid.

1. From the Section menu, select Create, Headers and Footers, Page Footer.
An icon is added to the Report Tree window and an empty section is added to the Report View.

2. Click the page footer.
3. Select fields from the Insert menu and drag them to the page footer section where you want them to appear.
You can add any type of data field except business view columns.

4. From the Section menu, select Section Properties or double-click the Page Footer section to open the
Page Footer form.

5. Define section properties as appropriate and click OK.

Note. You can add extra white space between the previous report section and the page footer by placing a
blank constant field above the footer text.

Creating Report Footers
Open a report template in Report Design Aid.

1. From the Section menu, select Create, Headers and Footers, Report Footer.
An icon is added to the Report Tree window and an empty section is added to the Report View.

2. Click the report footer.
3. Select fields from the Insert menu and drag them to the report footer section where you want them to appear.
You can add any type of data field except business view columns.

4. From the Section menu, select Section Properties or double-click the Report Footer section to open
the Report Footer form.

5. Define section properties as appropriate and click OK.
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CHAPTER 12

Working with Level Break Sections

This chapter provides an overview of level break header and footer sections and discusses how to create
level break sections.

Understanding Level Break Header and Footer Sections
In a report, a set of records that shares the same value for a specific field is said to be in the same level. For
example, in a report that is sorted by search type, all of the records with the same search type are in the same
level. When the value in the search type field changes, it is referred to in Report Design Aid as a level break.

Level breaks are useful for adding special processing. Two section types make adding processing to level
breaks easy: level break header and level break footer sections.

Level break headers and footers are always associated with a detail section. They do not have business views
attached but rather share a business view with the detail section with which it is associated. Therefore, all
fields from the business view attached to the detail section are available in the level break sections.

Level break sections organize records into smaller, more manageable units. You can define any data field
as a level break field. When the system processes the report, the level break triggers an event, such as the
printing of a heading or the calculation of totals. You can also define the level break to perform a page break.
For example, you can define Company as a level break field and a new page begins each time the value in
the Company field changes.

When you create a level break section you are presented with these options for selecting the level break field:

• All columns
Displays a list of all available fields in the business view attached to the detail section you selected.

• Only existing sort columns
Displays the fields that you selected as data sequencing fields when you created the detail section.

After you create a level break section, you can modify its properties.

You can define level break header and level break footer sections as conditional. Through the use of processing
options you can prompt the user to indicate whether they want to print the level break section in the report.
For example, from Event Rules on the level break section, you call the Hide Section system function to hide
the level break section unless selected by the user. Then, in the Initialize Section event, add event rules for a
processing option that shows or hides the section, depending on your preference.

In Report Design, you can:

• Add level break headers.
• Associate descriptions.
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• Add level break footers.
• Insert descriptions for aggregates.

See Also
Chapter 28, “Understanding Report Processing,” Level Break Processing, page 211

Creating Level Break Sections
This section provides overviews of level break headers and level break footers, lists the prerequisites, and
discusses how to:

• Create level break headers.
• Hide the level break field in the detail section.
• Associate descriptions.
• Create level break footers.
• Insert descriptions into level break footers.
• Add level breaks to detail sections.

Understanding Level Break Headers
Level break header sections present descriptive headings that appear at the beginning of each level of records.
For example, if you define search type as a level break field, a level break header introduces each group of
search types. The first level break header instance might indicate that the subsequent records are related to
search type C, or Customers. When the value of the search type field changes, the next level break header
instance might indicate that the subsequent records are related to search type E, or Employees.

Because of their free-form layout, group sections are used for level break headers. You can define more that
one level break header in a report template. For example, you can level break on search type and on business
unit to further organize the data.

When you create a new report template, you probably already know if you want to include a level break header
to organize the data. In this case, you typically do not include the level break field in the detail section. You
define the level break field to display in the level break header section.

If you are inserting a level break header into an existing report, you might have the same data field in both
the level break header section and the detail section. To avoid having the level break field print in both
sections, you can:

• Remove the level break field from the section layout prior to creating the level break header.

• Hide the level break field in the detail section.

In the report view, the level break header appears within the detail section. The name of the level break header
usually begins with On and indicates the level break field on which it was created. In the report tree, the level
break header appears one branch below the section to which it is attached.
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Associated Descriptions
You might want to add a description to the level break header to make it more meaningful to the report
reader. When you associate a description with the level break field, the system displays the description that
relates to the current level break header record being read. For example, Search Type E has a description of
Employees associated with it. When the level break header is processed, this description prints along with the
search type value in the level break header.

You can also associate descriptions within detail sections. If a detail section includes the Search Type field,
you can associate a description with this field to include the description of the value in the detail section.

Not every data field has a description associated with it. The data item must have a business function trigger
attached to it. In data dictionary, you can review the Edit Rule tab of a data item to determine if it includes a
business function trigger. Some examples of data items with business function triggers are:

• Address Number

• Business Unit

• Company
• Search Type

Understanding Level Break Footers
Level break footer sections present information that appears after the level break. Fields within the level break
footer are used for displaying aggregates. If you are using the level break footer to accumulate totals, then the
values in those fields are calculated dynamically at runtime.

Due to their free-form layout, group sections are typically used for level break footers. You can define more
that one level break footer in a report template. For example, you can level break on search type and on
business unit to provide more detailed aggregates.

An aggregate is an object that holds the results of a calculation using the values in other fields. For example,
the calculation could be a sum of values, an average of values, or a count of how many records exist. After
adding a level break footer and assigning the totaling conditions to the aggregate object within the level break
footer, you might need to change the totaling conditions to meet other reporting requirements.

When defining aggregates, you first determine the appropriate available operator:

Operator Description

Average of Reports the average of all the amounts in the column.

Count of Reports howmany entries or records are in the column.

Maximum of Report the maximum amount for a record in the column.

Minimum of Reports the minimum amount for a record in the column.

Total of Reports the sum of the values in this column.

The operator that you select determines the available selection of operands. Operands are columns included in
the report layout.
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In the report view, the level break footer appears within the detail section. The name of the level break footer
usually begins with On and indicates the level break field on which it was created. In the report tree, the level
break footer appears one branch below the section to which it is attached.

Aggregate Descriptions
You can use a level break footer in an employee listing report section to produce salary totals by department.
You can add a description in the level break footer to make the aggregates more meaningful to the report
readers. You can use a constant field as a generic label, such as Totals by Business Unit. You can also use a
data item to label the aggregate to include more detail, such as Totals for Business Unit 10. The data item
requires an assignment added to event rules to populate the data item variable.

See Chapter 17, “Working with Event Rules,” page 139.

Level break footers are presented after a level break has occurred in the preceding level. When the system
encounters a different value in the level break field, the system calculates and presents the information in the
level break footer section. Therefore, you must consider this timing when defining assignments in the event
rules of level break footers. The subsequent level break value is already in memory when the level break footer
is printed for the current level break value. If you use business view columns in the assignment, the system
fetches the subsequent value. Therefore, you want to use previous business view columns in assignments on the
level break footer. For example, you use the search type data item in the level break footer of a report to label
the aggregates. The first group of records in the report is for search type E and the second group of records is for
search type C. You create an assignment to assign a value to the search type data item. If you use the business
view column for search type in the assignment, the search type of C appears in the level break footer for the
first group of records because the C search type is currently in memory. If you use the previous business view
column in the assignment, the search type of E appears in the level break footer for the first group of records.

See Also
Chapter 28, “Understanding Report Processing,” Level Break Processing, page 211

Prerequisites
Before you begin creating level break sections, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Creating Level Break Headers
Open a report template in Report Design Aid.

1. Click the detail section to which you want to attach a level break header.
2. From the Section menu, select Create, Level Break Header.
3. On the Level Break form, under the Show heading, select one of these options:
• All columns
• Only existing sort columns

4. Select a business view field to designate it as a level break field.
5. Select the Display selected column as part of this section option.
6. Click Finish.
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You can modify the level break header, and even select a different field as the level break field, from the
Level Break tab on the section properties of the level break header.

Hiding the Level Break Field in the Detail Section
Open a report template in Report Design Aid.

1. Select the detail section containing the level break field that you want to hide.

2. Double-click the variable or column variable portion of the level break field.

3. On the appropriate properties form, select the Advanced tab.

4. Clear the Visible option.

If you need to make this field visible again, access the Section Properties form, select the Fields tab and, in
the Visible column, double-click the icon with the No sign. Also, in the report tree, you can double-click
the object and select the Visible option.

Associating Descriptions
Open a report template with a level break header in Report Design Aid.

1. In the level break header, click the variable portion of the level break header field.
2. From the Edit menu, select Associate, Description.
The cursor changes, enabling you to add the description to the level break header.

3. Position the Description field to the right of the level break header field.
4. To change the properties of this field, double-click the field.
5. On the Associated Description Properties form, change options as required.

Creating Level Break Footers
Open a report template in Report Design Aid.

1. Click the detail section to which you want to attach a level break footer.
2. From the Section menu, select Create, Level Break Footer.
3. On the Level Break Footer form, select the Group Section option, and click OK.
The Columnar Section option is used when you do not want the detail section to print. The aggregate
fields appear in a row beneath the column headings.

4. On the Level Break form, under the Show heading, select one of these options:
• All columns
• Only existing sort columns

5. Select a business view field to designate it as a level break field and click Next.
6. On the Aggregations form, select an appropriate Operator and Operand.
7. Click one of these options under the Item display style heading:
• Single overline
• Double underline
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8. Click the Reprint section at page break option, if necessary, and click Finish.
This option reprints the last line from the previous page as the first line of the next page.

9. Click the level break footer and select Add Aggregates from the Section menu to define additional
aggregates.

Note. In Report Design, move the cursor over the aggregate object; the field in the detail section upon which
the aggregate’s calculations are based changes color.

Inserting Descriptions into Level Break Footers
Open a report template with a level break footer in Report Design Aid.

1. Click the level break footer section.
2. From the Insert menu, select Constant Field.
3. Position the constant field in the level break footer where you want the description to appear.
4. Double-click the constant field.
5. On the Constant Properties form, change the Variable Name field to a meaningful description.

Adding Level Breaks to Detail Sections
This example illustrates adding a level break header and footer to an existing report.

Note. For this example, modify the example report described in Creating a Columnar Report. See that task
for information about creating the base report. The report below uses the business unit field to create a level
break header and a level break footer.

Even though an aggregate function is performed on one column (totaling the salaries), that field is not
designated as a level break. Business unit is the level break for the footer because the report totals all of the
salaries for each business unit.

Open the Creating a Columnar Report example in Report Design Aid.

1. From the Section menu, select Create, Level Break Header.
2. On the Level Break form, select Business Unit - Home as the level break field.
3. Select Display selected column as part of this section to display the data field in the level break header
section, and click Finish.
Report Design displays the header section within the columnar section.

4. To include the business unit description, click the variable of the Business Unit - Home field and select
Associate Description from the Edit menu.

5. Position the description field to the right of the Business Unit - Home field.
6. Double-click the Home Business Unit variable in the columnar section and on the Advanced tab, clear
the Visible option and then click OK.
This hides the business unit field in the columnar section.

7. Click the columnar section and select Create Level Break Footer from the Section menu.
8. On the Level Break Footer form, select Group Section and click OK.
9. On the Level Break form, select Business Unit - Home and click Next.
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10. To total the annual salaries for each business unit, set the Operator to Total of and set the Operand to
Rate - Salary, Annual.

11. Select a single overline and click Finish.
Report Design Aid displays the footer section within the columnar section.

Note. The order of the header and footer sections within the columnar section have no bearing on how they
appear in the printed report.

12. Click the Preview tab to view the report.
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CHAPTER 13

Working with Smart Fields

This chapter provides an overview of smart fields and discusses how to use smart fields in reports.

Understanding Smart Fields
Smart fields are data dictionary items with one or more business functions attached. Smart fields enable you
to include complex, reusable calculations in detail sections of a report. From Event Rules Design, you can
edit the event rules that are generated by smart fields. Smart fields are used in Report Design Aid and are not
currently available for use in any other PeopleSoft EnterpriseOne tool.

Smart fields are organized in smart field templates. Each smart field template is associated with a particular
business view. All smart fields in a template use the same business view columns for data selection. Because
smart fields are grouped in smart field templates, you must attach a smart field template to a detail section
before smart fields are available for the section layout.

If you attach a smart field template to a section and the section uses a different business view from the one
required by the smart field template, the system provides you with the opportunity to change the business view.

Important! If the business view that is attached to the section is not the same as the business view that is
required by the smart field template, then the smart fields that you add to the section might not function
correctly.

Using Smart Fields in Reports
This section provides an overview of smart field columns, lists the prerequisites, and discusses how to:

• Select smart field templates in existing reports.
• Insert smart fields.
• Select and delete smart fields.

Understanding Smart Field Columns
Smart fields are data dictionary items defined as glossary group K and are designed to retrieve and manipulate
specific PeopleSoft EnterpriseOne table data. For example, you can add the FINRPTAB - Account Balance
smart field, which is located in the S09001 - Financial Reporting smart field template, to a report. This smart
field creates a column that calculates the account balance as of the specified financial period and fiscal year.
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Smart fields mask the creation of event rules that call business functions or named event rules. Business
functions are programs that use data structures to perform functions including, but not limited to:

• Requesting specific data from PeopleSoft EnterpriseOne tables.

• Returning data to the established parameters in the data structure.

• Performing some type of calculation or other manipulation on the data.

• Returning the desired information, such as column headings and complex calculations, to the report.

A named event rule is a business function that is created by using the event rules scripting language. This
scripting language is platform independent and stored in a database as a PeopleSoft EnterpriseOne object.
When you build the named event rule business function, the system generates C code and creates a .c and .h file.

Because the smart field templates have already been created for you, you can include complex logic in
the report without having to do any programming.

Smart field templates are attached to Director templates. When you create a new report template, the Director
templates are available in the Application Reports drop-down list on the Welcome form of the Report Director.

When you insert a smart field into an existing report, the smart field director guides you through a series of
forms to set up the smart field parameters and values. The option to insert smart field columns is unavailable
for input if no smart field template is associated with the report section.

When you select a smart field, the event to which the associated logic is written is predefined. The section type
in which the smart field can be used is also predefined. If a Director Template does not exist for the section
type in which you are working, the smart field option is not available from the Create menu.

See Also
Chapter 32, “Creating Smart Fields,” page 247

Prerequisites
Before you begin using smart fields in reports, ensure that you:

• Create a batch application object.
• Complete the design of the report template.

Selecting Smart Field Templates in Existing Reports
Open a report template in Report Design Aid.

1. From the View menu, select User Options.

2. On the User Options form, select the Allow Smart Field Template Selection option and click OK.

3. On the PeopleSoft Report Design Aid form, click the detail section to which you want to add smart fields.

4. From the Section menu, select Section Properties.

5. On the section properties form, select the General tab.

6. Select a smart field template from the Smart Field Template field and click OK.

Only smart fields that are defined for the section type you selected appear.
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Note. If the business view that is attached to the section you selected is not the same as the business
view that is required by the smart field template, then the smart fields that you add to the section will
not function correctly.

Inserting Smart Fields
Open a report template with a smart field template attached in Report Design Aid.

1. Select Smart Field from the Insert menu.
2. On the Create New Smart Field form, select a smart field.
The smart field director prompts you to set up the smart field.

Selecting and Deleting Smart Fields
Open a report template that includes a smart field in Report Design Aid.

1. Click the section that includes the smart field that you want to change.
2. From the Column menu, select Create and then select Smart Field.
The Create New Smart Field form appears with a list of smart fields that are included in the template that is
associated with the section.

3. Select the smart field that you want to create, and click Next.
4. To move the column, drag it to the new location.
5. To delete the column, click it and select Delete from the Edit menu.
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CHAPTER 14

Setting Up Business Views as Favorites

This chapter provides an overview of Business View Favorites and discusses how to set up Business View
Favorites.

Understanding Business View Favorites
Business View Favorites organize your most frequently used business views. During the report creation
process, the Report Director enables you to quickly access a favorite business view to attache to the report
section.

Create Business View Favorites using the Favorites program, which you can access from the Advanced
Report Setup menu (GH9141)

Business View Favorites enable you to logically organize the business views that you designate as favorites.
You can attach notes to Business View Favorites to include information about the business view. For example,
you might include text that describes when to use a particular business view and the name of the business view.

Business View Favorites can be set up for individual users. You can translate the notes, as well as the Business
View Favorites descriptions, to different languages.

Setting Up Business View Favorites
This section provides an overview of favorites folders and subfolders and discusses how to:

• Add favorites folders.
• Add favorites subfolders.
• Add business views to favorites folders and subfolders.
• Add notes for favorites, folders, and subfolders.
• Modify and delete notes.
• Set up favorites description translations.
• View favorites with alternative descriptions.
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Understanding Favorites Folders and Subfolders
Business View Favorites are organized in a tree structure using folders and subfolders. You can use these
folders in any way that enables you to easily locate frequently used business views. For example, you can
name the business view folder using your name. Then you can create subfolders under the folder for each
category of business view that you use often.

You can add notes for folders and subfolders if you need to provide information about the business views
contained within. You can also use category codes to further organize your Business View Favorites.

Forms Used to Create Business View Favorites
Form Name FormID Navigation Usage

WorkWith Favorites W91100A EnterpriseOne Life Cycle
Tools, Report Management
(GH9111), Advanced Report
Setup, Favorites

Add, modify, and delete
Business View Favorites
folders and subfolders.

Object Folder Revisions W91100B Click Add on theWorkWith
Favorites form.

Enter the folder name, parent
folder name (if appropriate),
description, owner, and
descriptive category codes.

Favorites Revisions W91100C Select a Business View
Favorites folder or subfolder
on theWorkWith Favorites
form and select Revise
Favorites from the Row
menu.

Add business views to the
Business View Favorites
folders and subfolders.

Notes Revisions W91100E Select a Business View
Favorites folder, subfolder,
or business view on theWork
With Favorites form and
Select Note Revisions from
the Rowmenu.

Add, modify, and delete
information regarding the
Business View Favorites
folders, subfolders, and
business views in the
workspace.

WorkWith Favorites
Description Translation

W91100F EnterpriseOne Life Cycle
Tools, Report Management
(GH9111), Advanced Report
Setup, Favorites Description
Translation

Locate an alternate language
to display Business View
Favorites.

Revise Favorites Description
Translation

W91100G Select a language from
theWorkWith Favorites
Description Translation
form.

Locate Business View
Favorites and enter an
alternative description in the
selected language.

Adding Favorites Folders
Access the Object Folder Revisions form.
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Object Folder Revisions form

Folder The name of the folder.

Description A meaningful description of the folder. The description appears on the Work
With Favorites form and in Report Design Aid.

Folder Owner The address number of the person for whom the Business View Favorites are
defined.

Category Codes 1–6 User defined values that are used to further categorize the folder.

Adding Favorites Subfolders
Click a Business View Favorites folder and select Add Subfolders from the Row menu.
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Object Folder Revisions form

Adding Business Views to Favorites Folders and Subfolders
Access the Favorites Revision form.
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Favorites Revisions form

Object Name The name of the business view object.

Description The description of the business view. The description appears on the Work
With Favorites form and in Report Design Aid. The system populates this
field when you tab out of the Object Name field.

Adding Notes for Favorites, Folders, and Subfolders
Access the Notes Revision form
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Notes Revisions form

Modifying and Deleting Notes
Access the Notes Revision form.

1. Modify text in the workspace, and click OK.
2. Delete text in the workspace, and click OK.

Setting Up Favorites Description Translations
Access the Work With Favorites Description Translation form.
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Work With Favorites Description Translation form

Language Preference The language in which the Business View Favorites are written. This is
typically the domestic language defined for the system.

To Language The alternate language in which you want the business favorite to be written.
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Revise Favorites Description Translation form

Skip To Favorite The name of the Business View Favorites folder, subfolder, or business view
for which you want to create an alternate description.

Alternate Description The description of the Business View Favorites folder, subfolder, or business
view as it should appear in the selected language.

Viewing Favorites with Alternative Descriptions
Access the Work With Favorites form.

1. Enter the selected language in the Language field in the upper right-hand side of the form.
You can also use the visual assist to search and select a language.

2. Click Find.
If an alternative description exists for Business View Favorites folders, subfolders, and business views in
the specified language, they appear in that language. All other Business View Favorites folders, subfolders,
and business views display in the domestic language. The notes are blank to enable you to add notes in
the alternate language.
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CHAPTER 15

Understanding Advanced Report Enhancements

This chapter discusses advanced report enhancements.

Advanced Report Enhancements
In addition to the basic functionality of Report Design Aid, you can also use advanced features to create reports
with greater depth of information and functions. This table lists the available advanced features:

Feature Description

Subsection Joins A method of joining two detail sections of a report, each
with a different business view attached.

Event Rules Logic that enables you to perform operations such as:

Processing conditional logic.

Populating fields using assignments.

Performing calculations and complex expressions.

Calling existing business functions or system functions.

Fetching and updating data in the database.

Date Titles Used most often in financial reports. A date title added
to the page header makes the report more meaningful.
PeopleSoft EnterpriseOne includes commonly used date
titles. The date title business function enables you to select
the type of date title you want to display on the report.

Drill Down Creates a link to an interactive application. When you view
a report using Adobe Acrobat Reader, you can click a value
in the report viewer that is fetched from the database to
directly access the detail in the associated application.

Processing Option Templates Controls how the system processes the data for a report or
other batch application. The processing option template
is attached to the report template; however, different
processing option values can be specified for different
versions of the report.
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Feature Description

Director Templates Used by the Report Director to guide you through the
creation of report templates. These templates, which are
included with PeopleSoft EnterpriseOne, contain default
criteria. You can modify existing Director templates and
create custom templates.

Text Attachments Added to records in PeopleSoft EnterpriseOne interactive
applications by end users. You can design a report to
include text attachments that exist for a record.
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Joining Detail Sections

This chapter provides an overview of subsection joins and discusses how to create subjection joins.

Understanding Subsection Joins
Subsection joins provide you with an alternative to creating a new business view when existing business views
do not meet your business requirement. You can use subsection joins to join two detail sections that have
different business views attached. This enables you to present additional data in the report using fields that are
not included in a single business view.

The two sections are referred to as the parent section (generally accessing a master table) and the child section
(generally accessing a secondary table). The parent section regulates the processing of the report. After each
field in the parent section is processed, all of the corresponding records in the child section are processed.

Using Report Design Aid, you can:

• Create subsection joins.
There are two methods for creating subsection joins.
- Create the second detail section as a subsection join section.
- Join two existing detail sections that share common business view fields.

• Modify and sever subsection joins.
After creating a subsection join, some modification might be required. For example, you might need to
change the fields on which the sections are joined. You can also sever the join between the two sections.

You can create a subsection join between two columnar sections, two group sections, or a columnar and a
group section. The subsection join option is not available for tabular sections.

Subsection join reports take longer to process than a report using a joined table business view. For this reason,
subsection joins are a great alternative to creating a custom business view when the report is not a frequently
processed report or a report that processes a large amount of data.

Creating Subsection Joins
This section provides an overview of joins, lists the prerequisites, and discusses how to:

• Create subsection join sections.
• Modify and sever subsection joins.
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• Join two existing detail sections.

Understanding the Join
The two business views used in a subsection join report must share common fields. You must join the two
detail sections on at least one common field to establish a link between the two sections.

When selecting business view columns to use in the subsection join, consider which fields are required to
ensure that the correct child records are associated with the correct parent records. This could require one
field or multiple fields to be selected for the join.

If the records in the detail sections involved in the subsection join have a many-to-many relationship, you
need to select the Join only on level breaks defined in the parent section option. This option processes the
associated child records only after all of the records for the defined level breaks in the parent section have been
processed. This action is critical when joining tables that have a many-to-many relationship such as a detail
file that is joined to a transaction file.

For example, you can create a report to review accounts payable and general ledger detail. There is no business
view that includes both accounts payable and general ledger information, In a report template, you can create
one detail section using the A/P Detail Reports (V0411G) business view and another detail section using the
G/L Transaction Detail Report (V0911G) business view. Because both of these business views include the
Document Type and Document Number fields, you can establish the subsection join using these fields.

Prerequisites
Before you begin joining detail sections, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Creating Subsection Join Sections
Open a report template in Report Design Aid.

1. Click the columnar or group section to use as the parent section.
2. From the Section menu, select Create, Sub-Section Join, and select one of these options:
• Group
• Columnar

3. On the Business View Selection Option form, select one of these business view options and click Next:
• I’d like help finding an appropriate business view.
• I’ll find a business view myself.

4. Select the required business view and click Next.
5. On the Section Layout form, select the business view columns to include in the child section, and click Next.
6. On the Sub Section Join form, verify that the Join to option under the Parent heading is selected and
that the parent section name appears in the field.
These options are typically already defined by the system.

7. Select business view columns from the Child columns list that are common with the business view columns
in the Parent columns and variables list.
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8. Select the Join only at level breaks defined in the parent section option as necessary.
9. After you have completed entering columns in the child section to join with the parent section, click Finish..
The child section resides within the parent section and includes a chain-link icon, indicating that it is
joined to the parent section.

10. If necessary, define data sequencing for the child section.
11. Modify the fields in the child section as necessary to enhance the appearance of the report.

Modifying and Severing Subsection Joins
Open a report template that includes a subsection join in Report Design Aid.

1. Double-click the child section, or from the Section menu, select Section Properties.

2. Select the Sub Section Join tab and modify options as necessary.

3. To sever the join, click the No Join option and click OK.

Both detail sections are now independent sections.

Joining Two Existing Detail Sections
Open a report template that includes a subsection join in Report Design Aid.

1. Click the detail section that you want to perform as the child section.
2. From the Section menu, select Sub-Section Join.
3. On the Define Sub-Section Join form, under the Parent heading, select theJoin To option.
4. In the Join To field, select the parent section to which you want to join the child.
5. Select business view columns from the Child columns list that are common with the business view columns
in the Parent columns and variables list.

6. Select the Join only at level breaks defined in the parent section option as necessary.
7. After you have completed entering columns in the child section to join with the parent section, click Finish.
The child section resides within the parent section and includes a chain-link icon, indicating that it is
joined to the parent section.
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CHAPTER 17

Working with Event Rules

This chapter provides an overview of events and discusses how to:

• Create event rules.
• Create and use text variables.
• Call system functions in event rules.
• Create event rule variables.
• Use the Column Inclusion versus the Do Section event.
• Create custom sections.
• Access BrowsER for report templates.

Understanding Events
As a report is processed, the system pauses at specific points to process attached logic. These points are called
events. You can use these events to attach event rules. Event rules are logic statements that you create and
attach to an event. Event rules process when an event, such as a page break, is encountered. Events are
attached to report components, such as variables, constants, sections, and the report.

The event to which you attach event rules varies depending on the purpose of the event rule and the type of
section in which the event occurs. For example, if you are adding event rules to columnar or group sections,
you typically use the Do Section event. In tabular sections, you typically attach event rules to the Do Tabular
Break, Do Balance Auditor, or Column Inclusion events. The smart fields that are included in a tabular section
are automatically attached to the Column Inclusion event. If you are attaching event rules to a variable,
you might use the Do Variable event.

Each event is triggered at different times during the processing of the report. You should become familiar with
the process flow of events so you can determine on which event to attach event rules. If you attach event rules
to the wrong event, the appropriate data might not be available to successfully process the event rule logic.

See Also
Chapter 27, “Understanding Events,” page 195

Chapter 28, “Understanding Report Processing,” page 201

Creating Event Rules
This section provides an overview of event rules, lists the prerequisites, and discusses how to:
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• Create If/While statements.
• Create simple event rule assignments.
• Create assignments using the Expression Manager.

Understanding Event Rules
Event rules are created in the Event Rule Design form. You create event rules by selecting from available
components.

Event rules can be written on any event. You must understand the order in which the events are processed to
determine the correct event on which to place event rules.

If the event rules affect an individual field, you can place the event rules on one of that field’s events or on one
of the section events. Typically, events rules are placed on section events for more efficient performance.

You can create these types of event rule statements:

• If/Else/While Statements.

Enables you to define the criteria for which the logic should process. The first line of an If/While statement
typically begins with the If operator. Subsequent lines begin with either an And or an Or operator. An else
is used to link two options. For example, If Search Type is equal to E or Search Type is equal to C <do
this> Else <do that>. You can embed multiple If statements in event rules and other statements inside of
the if statement.

• Assignments and Expressions.

Enables you to assign a value to a field. For example, RV Business Unit = PC Business Unit. Also enables
you to create expressions to populate fields.

• System Function Calls.

Enables you to use special functions provided by the system. Only system functions that are relevant to
the report component and event selected are presented for your use.

• Business Function Calls.

Enables you to use logic provided by the system. Business functions are C functions that can be called
from an event.

• Event Rules Variables.

Enables you to create variables that can be used inside event rules. These variables are typically used to store
values to be used in event rule logic.

• Table I/O Calls.

Enables you to use special table input and output functions provided by the system to fetch and update data.

• Report Interconnects.

Enables you to call another report from event rules.

Fields available for use in event rules are represented by a two-character, alphabetical code. This code indicates
the source of the field and determines how the field data is used at runtime. Depending on what fields you
have included in the report section, these field types could be available:
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Prefix Code Description

BC Columns included in the attached business view. These
columns are populated with values from the database when
a fetch is performed and are the values that are saved when
you add or update.

PC Previous business view column values. These columns are
populated with the previous value for the selected business
view field.

PO Values that are passed from processing options.

PV Previous report variables.

RC Report constants. Includes column headings in columnar
sections and the constant portion of fields in group sections.

RS Report sections. These values might not be used when
creating event rule assignments.

RV Report variables. Includes column variables in columnar
sections and the variable portion of fields in group sections.

SL System values. These values are fetched by the system and
include information such as user IDs, environment names,
version names, and report names.

TV Text variables that you create these values from the Section
menu prior to creating the event rules.

VA Event rule variables represent any variables that you define
in event rules using data items. You assign values to these
variables in event rules.

Expression Manager
The Expression Manager enables you to create expressions for use in event rules assignments. The Expression
Manager provides a calculator for use in creating calculations as well as these functions:

• Date Functions
Enables you to easily calculate data such as, days_between, months_between, and date_today.

• Time Zone Functions
Enables you to easily calculate data such as, utc_get_day, utc_get_hour, and utc_add_years.

• General Functions
Enables you to easily calculate data such as, abs( ), exp( ), and round ( ).

• Trig Functions
Enables you to easily calculate data such as, cos( ), log( ), and sin ( ).

• Text Functions
Enables you to easily calculate data such as, concat( ), ltrim( ), and substr ( ).
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Prerequisites
Before you begin creating event rules, ensure that you:

• Create a batch application object.
• Complete the design of the report template.

Creating If/While Statements
Open a report template in Report Design Aid.

1. Click an object (section, heading, variable, data item) for which you want to place the event rules.

2. From the Edit menu, select Event Rules.

You can also right-click the object, and select Event Rules.

3. On the Event Rules Design form, select an event from the pull-down menu of the events list.

For example, select the Do Section event. This event is the most commonly used event in columnar and
group sections.

4. From the Insert menu, select If/While.

You can also click the If/While button on the toolbar.

5. On the Criteria Design form, define the specific criteria for the event rules.

6. Click OK to save the If statement and return to the Event Rules Design form.

The if statement displays on the Event Rules Design form.

You can move a line of the event rules to a new location by selecting it and dragging it to the desired position.

Note. Changing the sequence of statements in event rules can result in improper syntax. If you detect syntax
errors, you can either disable the event rule and continue; or edit the event rule to eliminate the errors.

Creating Simple Event Rule Assignments
Open a report template in Report Design Aid.

1. Click the object (section, variable, data item, and so forth) to which you want to attach the event rule.

2. From the Edit menu, select Event Rules.

3. On the Event Rules Design form, select an event from the pull-down events list.

4. If needed, click an existing statement to have the assignment follow that statement.

5. Select Assignment/Expression from the Insert menu.

6. On the Assignment form, in the To Object list, select the field to which you want to assign a value.

For example, the To Object might be the report variable (RV) of a column that you inserted into the report.

When an object is selected, the selected field displays under the To Object heading. This field is the
recipient of the assigned value.

7. Select an object from the From Object/Literal list and click OK.

The options listed in the From Object/Literal are dependent on the field selected as the To Object.

8. On the Event Rules Design form, select Save from the File menu.
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You can also click the check mark on the toolbar.

Creating Assignments Using the Expression Manager
Open a report template in Report Design Aid.

1. Click the object (section, variable, data item, and so forth) to which you want to attach the event rule.

2. From the Edit menu, select Event Rules.

3. On the Event Rules Design form, select an event from the pull-down events list.

4. If needed, click an existing statement to have the assignment follow that statement.

5. Select Assignment/Expression from the Insert menu.

6. On the Assignment form, in the To Object list, select the field to which you want to assign a value.

7. Click the ƒ(x) button at the end of the From Object/Literal field.

8. On the Expression Manager form, enter an expression using the fields in the Available Information
list, the calculator, and the Advanced Functions.

Expression
9. When the expression is complete, click OK.

10. On the Event Rules Design form, select Save from the File menu.

Creating and Using Text Variables
This section provides an overview of text variables, lists the prerequisites, and discusses how to:

• Create text variables.
• Use text variables in assignments.

Understanding Text Variables
Use text variables to hold a literal string for use in event rules. Text variables are easier to translate into
multiple languages and easier to maintain than hard-coded literal strings.

You create text variables in Report Design Aid. The text variables are then available in the Event Rules
Design form for use in If statements and assignments.

Prerequisites
Before you begin creating and using text variables, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Creating Text Variables
Open a report template in Report Design Aid.
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1. Click the section to which you want to add text variables and select Text Variables from the Section menu.
2. On the Text Variables form, enter the text that you want to appear on the report under the Text String
heading.

3. Press ENTER or click Add then click OK.
You must press ENTERafter each entry for Report Design Aid to recognize the entry. When you press
ENTER or click Add, another blank line appears.

Using Text Variables in Assignments
Open a report template that includes text variables in Report Design Aid.

1. Click the section to which you added the text variables, and select Event Rules from the Edit menu.

2. On the Event Rules Design form, select an event from the pull-down events list.

The system displays a green plus sign (+) next to events with attached event rules.

3. If needed, click an existing statement to have the assignment follow that statement.

4. Create an assignment by selecting Assignment/Expression from the Insert menu.

You can also click the x= button on the toolbar.

5. On the Assignment form, in the To Object list, select the field to which you want to assign a value.

6. Select the text variable in the From Object/Literal field and click OK.

Refer to the prefix code table in the Understanding Event Rules section.

The Event Rules Design form displays the assignment using the text variable in addition to any existing
event rules.

7. Click the check mark on the toolbar to save and exit Event Rules Design.

Calling System Functions in Event Rules
This section provides an overview of system functions, lists the prerequisites, and discusses how to use
system functions in event rules.

Understanding System Functions
System functions are predefined sets of logic shipped with the PeopleSoft EnterpriseOne product. These
functions enable you to perform specialized processing without adding custom code. Some examples of
frequently used system functions are:

• Hide Object and Show Object.
Use these system functions to hide and show objects within a section.

• Hide Section and Show Section.
Use these system functions to hide and show sections within a report.

• Do Custom Section.
Use this system function to call a custom section.
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• Set Selection Append Flag and Set Sequence Append Flag.
Use these system functions to set append flags for defining data selection and data sequencing entered into
processing option templates.

• Set User Selection and Set User Sequence.
Use these system functions to define data selection and data sequencing entered into processing option
templates.

• Stop Batch Processing and Stop Event Processing.
• Use Data Sel/Seq From a Section.
Use this system function to adopt the data selection and data sequencing from another report section.

Prerequisites
Before you begin calling system functions in event rules, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Using System Functions in Event Rules
Open a report template in Report Design Aid.

1. Click the object (section, variable, data item, and so forth) you want to attach the event rule.
2. From the Edit menu, select Event Rules.
3. On the Event Rules Design form, select an event from the pull-down events list.
4. If needed, click an existing statement to have the assignment follow that statement.
5. From the Insert menu, select System Function.
You can also click the System Function button on the toolbar.

6. On the Function Selection tab of the System Functions form, expand each folder to view all available
functions.

7. Select an appropriate system function.
For example, to hide an object, expand the Object folder and select the Hide Object system function.

8. Select the Parameter Mapping tab to define the parameters.
If you double-click the system function, the Parameter Mapping tab is accessed automatically.

9. On the Parameter Mapping tab, select an appropriate field from the Available Objects list.
For example, to hide an object, select the object from the Available Objects list.

10. Click the right arrow to move the object to the Value column under Parameters.
Not all system functions require parameter mappings. Some system functions do not have any parameters.

11. Click OK to return to Event Rules Design.
12. On the Event Rules Design form, click the check mark to save and return to Report Design Aid.
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Creating Event Rule Variables
This section provides an overview of event rule variables, lists the prerequisites, and discusses how to create
event rule variables in event rules.

Understanding Event Rule Variables
Event rule variables are objects that you create based on the characteristics of a selected data dictionary field.
However, the variables are not stored in the data dictionary. Rather, each variable exists only within the report
where it was created. After you create the variable, it is available for use in event rules.

When you create an event rule variable, you indicate the scope:

• Report
Enables you to use the event rule variable in any event in any section of the report. Upon completion of the
variable, the system adds a prefix of rpt to the variable name.

• Section
Enables you to use the event rule variable in multiple events of the selected section. Upon completion of the
variable, the system adds a prefix of sec to the variable name.

• Event
Enables you to use the event rule variable in the event where it was created. Upon completion of the variable,
the system adds a prefix of evt to the variable name.

The recommended naming convention for event rule variables is to include the Hungarian Notation at the
beginning of the name and the data item alias at the end, preceded by an underline. Do not include spaces in
the name. For example, an event rule variable that is created using the Address Number data item might be
named mnEmployeeNumber_AN8. The mn indicates that the field is a math numeric field type. Employee
Number is the name that the creator gave the variable. The AN8 indicates that the variable shares the same
characteristics as the Address Number data item.

Prerequisites
Before you begin creating event rules variables, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

Creating Event Rule Variables in Event Rules
Open a report template in Report Design Aid.

1. Click the section to which you want to attach event rule variables and select Event Rules from the Edit
menu.

2. On the Event Rules Design form, select an event from the pull-down events list.
This step is required only if the event rule variable is used for a specific event. If the variable is required
for the entire section or report, you do not need to select an event prior to creating the variable.

3. From the Insert menu, select Variables.
You can also click the Variables button on the toolbar.
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4. On the Event Rules Variables form, enter the alias of the appropriate data item in the DD Item field
and click Add.
Select a data item that possesses the characteristics that are required by the variable.
If you do not know which data item you need, you can leave the DD Item field empty and click Add. You
can then use the Variable Options Selection form to search for an appropriate data item.

5. On the Variable Options Selection form, an appropriate Scope option.
6. In the Name field, enter a meaningful name using the recommended naming conventions, and click Finish.
The Event Rules Variables form displays the event rule variable that you just created.

7. To modify the scope of the event rule variable, click the variable that you want to edit and then click
the Edit button.

8. On the Variable Options Selection form, make any modifications that are required and click Finish.
9. Click OK to return to Event Rules Design.
10. On the Event Rules Design form, click the check mark to save and return to Report Design Aid.

Using the Column Inclusion Versus the Do Section Event
This section provides an overview of the Do Section and Column Inclusion events, lists the prerequisites, and
discusses how to use the Column Inclusion event.

Understanding the Do Section and Column Inclusion Events
The most common event for a group or columnar section is the Do Section event. For group or columnar
sections, this event occurs after each record is fetched.

The most common event for a tabular section is the Column Inclusion event. For a tabular section, the Do
Section event processes only at each level break; while the Column Inclusion event processes after each
record is fetched.

Regardless of the section type, do not use the Column Inclusion event when you are performing a calculation
between columns (such as when calculating variances) or between variables within a column. For these
situations, use the Do Section event.

When using the Column Inclusion event, you attach event rules to individual columns in the section.

Prerequisites
Before you begin using the Column Inclusion event, ensure that you:

• Create a batch application object.

• Complete the design of the report template using a tabular section.

Using the Column Inclusion Event
Open a tabular section report template in Report Design Aid.

1. In the tabular section, click the column variable to which you want to attach event rules.
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2. From the Edit menu, select Event Rules.
3. On the Event Rules Design form, select Column Inclusion from the pull-down events list.
4. Create event rules using the appropriate event rule components.
For example, to create an if/while statement, select If/While from the Insert menu.

5. Click the check mark to save and return to Report Design Aid.

Creating Custom Sections
This section provides an overview of custom sections, lists the prerequisites, and discusses how to set up
custom sections.

Understanding Custom Sections
Custom sections enable you to control, through event rules, the information that prints on a report. You can
include business view fields, variables, and data dictionary fields in custom sections. The number of custom
sections that you can add to a report is only limited by your system’s performance. Custom sections are
allocated and processed like any other section. You can use custom sections to:

• Force page breaks.

Create a custom section with no objects and then activate the Page Break After Print option in that section.

• Perform logic.

Create a custom section and add event rules to perform percent of total calculations to be used by the
level-one section.

• Present additional information when stated criteria is met.

Create an accounts receivable report that displays the payment history of customers. Add a custom section
that presents account receivables by aging categories. Call the custom section only if a customer is
delinquent. When the batch engine encounters a record that meets the past due criteria, the custom section
prints. The custom section does not print for any records that do not have a past due amount.

Logic for Custom Sections
When you use a custom section, you must specify the section as conditional in the section properties. You then
use the Do Custom Section system function to call the custom section. You can use the Do Custom Section
system function in columnar, group, or tabular sections. You attach the system function to the section that
precedes the custom section. For example, to process a custom section after a columnar section, call the
custom section from the Do Section event of the columnar section. Likewise, to process a custom section after
a level break footer, call the custom section from the Init Lvl Brk Footer event.

You can call a custom section from any report section. Furthermore, you can use any event rule logic along
with a custom section, such as If/While statements, business functions, and table I/O.

You can call a custom section from any event except the Initialize Section event. If you try to call a custom
section from the Initialize Section event, the report will not process.

Prerequisites
Before you begin creating custom sections, ensure that you:
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• Create a batch application object.
• Complete the design of the report template.

Setting Up Custom Sections
Open a report template in Report Design Aid.

1. Click the section from which you want to call the custom section and select Event Rules from the Edit menu.

2. Select the event from which you want to process the custom section.

3. Click the System Function button.

4. On the System Functions form, select the Do Custom Section system function from the Section folder.

5. Select the Parameter Mapping tab.

The system populates the Available Objects list with all of the sections that are included in the report, not
just the sections that are defined as conditional.

6. From the Available Objects list, select the conditional section that you want to process as a custom section,
click the right-arrow to move it to the Parameters grid and then click OK.

Accessing BrowsER for Report Templates
This section provides an overview of BrowsER, lists the prerequisites, and discusses how to access BrowsER.

Understanding BrowsER
You can use BrowsER to view event rules for an entire report or batch version. BrowsER displays the report
sections in a hierarchical structure. When you expand a section, you see a section node and nodes for each
object within the section. Event rules attached to the section will display under the section node. All event
rules that are attached to an object display under the appropriate object node.

A plus sign next to a node indicates that event rules are attached. When you expand a node with a plus sign, an
event node on which the event rules are attached appears with a plus sign. When you expand the event node,
you can review the event rules that are attached to the event. You can disable and then enable, one or more
event rules from BrowsER. This is useful for troubleshooting event rules for an entire report or batch version.

You can access BrowsER from multiple locations in PeopleSoft EnterpriseOne:

• Report Design Aid.

Open a report template in Report Design Aid and access BrowsER from the View menu.

• Object Management Workbench

Select a report template and access the Design Tools tab.

• Batch Versions

Select a batch version and from the Advanced Operations form select Report BrowsER from the Form menu.
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See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Batch Versions, “Reviewing Batch
Version Processing,” Accessing BrowsER for Batch Versions

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Event Rules and System Functions,
“Using BrowsER”

Prerequisites
Before you access BrowsER for report templates, ensure that you:

• Create a batch application object.
• Complete the design of the report template.
• Include event rules.

Accessing BrowsER
Access Object Management Workbench.

1. From a project, select the report template that you want to review.

For example, select the R014021 One Line Per Address report template.

2. Click Design.
3. Select the Design Tools tab.

4. Click Browse Event Rules.

5. On the Browsing form, expand the nodes for each report section.

If no other nodes under the report section can be expanded, no event rules exist for that report section.

6. Expand additional nodes until you locate event rules.

You can disable, and enable, event rules for the entire report template from this form.
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Including Text Attachments in Reports

This chapter provides an overview of text attachments and discusses how to add text attachments to reports.

Understanding Text Attachments
PeopleSoft EnterpriseOne enables you to attach informational text to records in the database. Users can add
text attachments to records from PeopleSoft EnterpriseOne interactive applications. An example of a text
attachment is a resume that is attached to the address book record of an employee. A popular use of text
attachments is a brief description of items that are purchased in the PeopleSoft EnterpriseOne Accounts
Payable application.

Adding Text Attachments to Reports
This section provides an overview of text attachments in reports, lists the prerequisites, and discusses how
to include text attachments in reports.

Understanding Text Attachments in Reports
You can design reports to display text attachments that exist for a record. In this way, anyone who reads the
report can view the same text attachments that are available in the interactive applications.

PeopleSoft EnterpriseOne uses media object data structures to associate records with their text attachments.
You can use Object Management Workbench to view a list of all media object data structures (object type GT).
The media object data structure is called in event rules using a system function. After you select a media object
system function, you must define these parameters:

• Action
<Get Text> is the appropriate action for a media object text attachment.

• Text
The name of the field that is inserted into the report section to display the text attachment is mapped to the
Text parameter.

• Associated fields
Business view columns that are associated with the fields that are displayed in the data structure. These fields
are required to ensure that the correct text attachment appears with the correct record in the report section.
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Prerequisites
Before you add text attachments to reports, ensure that:

• Text attachments exist for the records that you want to include in the report.
• An existing report includes the records to which you have attached the text or create a new report that
includes the records to which you have attached the text.

• You can identify the name of the media object data structure that the interactive application uses to associate
records with text attachments.

Including Text Attachments in Reports
Open a report template that fetches the appropriate records in Report Design Aid.

1. Select the detail section to which you want to add the text attachment.

2. From the Insert menu, select Alpha Variable.

3. Position the variable in the detail section.

4. If the section is columnar, double-click the alpha variable column heading and on the General tab of the
properties form, enter a descriptive column name.

5. If the section is columnar, double-click the column variable; if the section is group, double-click the
alpha variable field.

6. On the Description tab of the properties form, change the Variable Name field.

Change the name to something meaningful that is easy to recognize in Event Rules Design (for example,
Attachments). This field should relate to the column heading name if the section is columnar.

7. Select the Display tab, modify the Display Length field to a length that accommodates the text attachment
and click OK.
If the text is longer than the display length, the text will wrap.

8. Click in the detail section of the report, and select Event Rules from the Edit menu.

9. On the Event Rules Design form, select the Do Section event from the pull-down events list.

10. From the Insert menu, select System Function.

To include text attachments for specific records, establish If/While criteria. If no text attachment for the
record exists or if the record is excluded by the If/While logic, no text prints in the report section.

11. On the System Functions form, on the Function Selection tab, expand the Media Objects folder.

12. Select the media object data structure that is attached to the associated interactive application.

13. Select the Parameter Mapping tab.

The Action and Text parameters typically display on this screen, the remaining parameters vary depending
on the data structure that you select.

14. Define the data structure parameters and click OK.

The system displays a media object call on the Event Rules Design form. This call varies, depending
on the parameters that you mapped.

15. On the Event Rules Design form, click the check mark to save and return to Report Design Aid.

16. Preview or run the report.
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For any record that has generic text attached, the text prints where you placed the alpha variable on
the report.
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Using Date Titles in Financial Reports

This chapter provides an overview of date titles and discusses how to:

• Use date titles in financial reports.
• Assign accounting periods to column headings.

Understanding Date Titles
Date titles are used to indicate the time period covered by the data in the report. Several date titles are included
in PeopleSoft EnterpriseOne:

Date Tile Example

A (As of) As of 03/31/07

B (Balance sheet) As of March 31, 2007

P (Profit and Loss) For the Three Months EndingMarch 31, 2007

S (Single period) For the Month Ending March 31, 2007

The User Defined Date Title business function (B8300007) uses the company number to determine the fiscal
year. The system also uses the company number to determine the default reporting period if the user leaves
the processing option values for the reporting month and year blank.

Using Date Titles in Financial Reports
This section provides an overview of customizing date titles, lists the prerequisites, and discusses how to:

• Define custom date titles.
• Preview date titles.
• Add date titles to financial reports.
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Understanding Customizing Date Titles
For reports that include financial data, a date title in the page header makes the report more meaningful.
PeopleSoft EnterpriseOne includes commonly used date titles. While a predefined date title enables you add a
date title quickly, it might not be specific to your reporting needs. Therefore, you can add a company-specific
date title. You can call the User Defined Date Title business function (B8300007) to add an existing date title
to a report or create a date title specific to your reporting needs. In addition, you can create the same date title
in multiple languages. The date title parameters are stored in the F83100 table.

When creating a custom date title you must complete these fields:

• Date Title Type
A single unique identifier. For a profit and loss date title use the letter P as the title type.

• Description
A description of the date title. For a profit and loss date title enter Profit and Loss as the description.

• Language
Identifies the language. Leaving this field blank selects the domestic language.

As part of the date title creation, the system presents you with 14 fields for defining the elements of the title.
Use these element fields to indicate how the date title should appear in reports. If you want a comma to appear
in the date title, enter a comma in the appropriate element field.

The maximum length of a date title is 100 characters. The maximum number of elements is 14. Each element
can be a literal text string or a text substitution parameter. This list describes the text substitution parameters
that are available. The system stores these parameters in user defined code 83/TS. These parameters are
populated at runtime, typically through a processing option.

The predefined elements from which you can select are:

• @1: Period Name

The system fetches this value from the F83110 table. This name is generally the name of the month that is
associated with the period. The values in the table are populated when you define the name of the period
for a fiscal date pattern.

• @2: Day Period Ends

The system fetches this value from the F0008 table. For example, this parameter would return 31 for
a period that ends on the 31st day of the month.

• @3: Century and Year

The system typically fetches this value from a processing option, but the value might be determined by the
company that is selected for the report.

• @4: Year
The system typically fetches this value from a processing option, but the value might be determined by the
company that is selected for the report.

• @5: Text for Period Number

The system fetches these values from the user defined code (UDC) 83/PT. This UDC stores text for the
number of periods through the current period. For example, Period 2 retrieves two periods.

• @6: Date (12/31/05)

The system fetches this value from a processing option, but the value might be determined by the company
that is selected for the report.

156 PeopleSoft Proprietary and Confidential



Chapter 19 Using Date Titles in Financial Reports

You can use as little as two of these element fields. For example, the elements of the As Of Date date title is
defined as Element 1- As of and Element 2 -@6. The As of is the text that appears on the report. The@6
fetches the date. An example of this date title, as it appears in the page header of a financial report, might
be As of 12/31/05.

Select Period Text from the Form menu on the Date Title Revisions form to revise the User Defined Code
values for the Text for Period Number (@5) element.

To use date titles in reports, you call a date title business function in event rules. In the business function data
structure, you map the appropriate date title type, the processing option fields, and other relevant fields, such
as Company. You must assign values to each data item that is included in the data structure. All directional
arrows are defined in the data structure.

Prerequisites
Before you use date titles in financial reports, ensure that you:

• Create a batch application object.
• Complete the design of a financial report template to which you can add a date title.

Forms Used to Define Custom Date Titles
Form Name FormID Navigation Usage

WorkWith Date Titles W83100A EnterpriseOne Life Cycle
Tools, Report Management
(GH9111), Advanced Report
Setup, Date Titles

Add, modify, and delete
date titles.

Date Title Revisions W83100B Click Add on theWorkWith
Date Titles form.

Enter the date title type,
description, language, and
elements.

Date Title Preview W83100D Select a date title on the
WorkWith Date Titles
and select Preview from
the Row menu.

Review and modify date
title information. Select
Run Preview from the Form
menu to preview the date
title in the same format as it
displays in the report.

Defining Custom Date Titles
Access the Date Title Revisions form.
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Date Title Revisions form

Date Title Type A unique single character used to identify the date title.

Description Text that describes the date title using 30 characters or less.

Language A user defined code that indicates the language in which the date title should
be displayed.

Elements Components of the date title. For example, For the six months ending June
2005. Use User Defined Codes for text substituted values such as the six, the
June and the 2005 in the example.

Previewing Date Titles
Access the Date Title Preview form.
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Date Title Preview form

Date Title Type This field is populated by the system based on the information on the Work
With Date Titles form. You can edit this field.

Language This field is populated by the system based on the information on the Work
With Date Titles form. You can edit this field.

Company Enter a company address book number in this field.

Period Number Enter a number to indicate the current accounting period. If you leave this
field blank, the system retrieves the value from the Financial Reporting
Date in the company’s application.

Fiscal Year Enter a two-digit number to indicate the current fiscal year. If you leave this
field blank, the system retrieves the value from the Financial Reporting
Date in the company’s application.

Preview Date Title
On the Date Title Preview form, select Run Preview from the Form menu to preview the date title in the
same format as it displays in the report. If the system does not find language-specific versions of the date
title, the date title displays in the default language.

Note. If the date title is over 100 characters, you will receive an error message and the date title will be
truncated to fit the available space.
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Adding Date Titles to Financial Reports
Open a financial report template in Report Design Aid.

1. Click the page header section, and select Alpha Variable from the Insert menu.
2. Position the field in the page header.
3. Double-click the alpha variable field that you just inserted.
4. On the Variable Properties form, on the Description tab, enter a name in the Variable Name field.
Use a name that you can easily identify in Event Rules Design, such as Date Title.

5. Select the Display tab and set the Justification to Center.
6. Set the Display Length to 100.
If the date title is over 100 characters, the system truncates the date title to fit the available space.

7. Select the Advanced tab, select the Global Variable option and click OK.
Selecting this option makes the variable available in event rules for all sections of the report.

8. Align the object with the other objects in the section and save the report template.
9. Click the tabular section of the report, and select Event Rules from the Edit menu.
10. Select the Before Level Break event from the pull-down events list.
11. From the Insert menu, select Business Function.
12. On the Business Function Search form, enter B8300007 in the Source Module field of the QBE line,
press ENTER or click Find.

13. Click Select.
14. On the Business Functions form, click in the Value field next to the data item cDateTitleType to map
the data structure parameters.

15. Double-click Literal in the Available Objects list.
16. On the Single value form, click the visual assist in the Date Title Type field.
17. On the Date Title Search form, select a value, and click Select.
18. On the Single value form, click OK.
19. Click in the Value field next to the data item szLanguagePreference.
20. To print the date title in the user’s language, double-click SL LanguagePreference in the Available
Objects list.
SL LanguagePreference is the system value for language preference in the user profile.

21. To print the date title in a specific language, regardless of the preference of the user running the report,
double-click Literal in the Available Objects list.

22. On the Single value form, click the visual assist in the Language field.
23. Select a value and click Select.
24. On the Single value form, click OK.
25. Click in the Value field next to the data item szCompany.
26. Double-click Literal in the Available Objects list.
27. On the Single value form, enter the company number in the Company field.
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28. On the Single value form, click OK.
The company that you select determines the fiscal date pattern.

29. Click in the Value field next to the data item mnPOPeriodNumber, and then double-click PO
PeriodNoGeneralLedger in the Available Objects list.
This is the period number that is defined in the Financial Reports processing options (T83PO). The
processing option appears automatically at runtime to prompt the user for a value.

30. Click in the Value field next to the data item szPOFiscalYear, and then double-click PO szFiscalYear
in the Available Objects list.
This is the fiscal year that is defined in the Financial Reports processing options (T83PO).

31. Click in the Value field next to the data item szDateTitle, and then double-click the report variable name
beginning with RV in the Available Objects list.
This is the name that you assigned to the alpha variable that you inserted into the Page Header.

32. On the Business Functions form, click OK.
33. On the Event Rules Design form, click the check mark to save and return to Report Design Aid.

Assigning Accounting Periods to Column Headings
This section provides an overview of accounting periods and discusses how to define column headings
for accounting periods.

Understanding Accounting Periods
Each fiscal date pattern type is assigned a name for each period. For example, period six is equal to June. The
system uses the name that is assigned to a period in the Date Title and in Smart Field column headings. Each
fiscal date pattern type can have period names to accommodate company-specific fiscal date patterns. For
example, a fiscal date pattern for a fiscal year that begins in October has a column heading of October for
period 1. A fiscal year that begins in January has a column heading of January for period 1.

Forms Used to Assign Accounting Periods to Column Headings
Form Name FormID Navigation Usage

WorkWith Column
Headings

W83110A EnterpriseOne Life Cycle
Tools, Report Management
(GH9111), Advanced Report
Setup, Column Headings

Add, modify, and delete
accounting period column
headings.

Column Heading Revisions W83110B Click Add on theWorkWith
Column Headings form.

Enter fiscal date pattern,
language, and period names.

Defining Column Headings for Accounting Periods
Access the Column Heading Revisions form.
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Column Heading Revisions form

Fiscal Date Pattern A user defined code used to identify date patterns. Codes must be defined for
this use.

Language A user defined code that indicates the language in which the column headings
should display.

Period 1–7 and Period 8–14 Column heading names for each accounting period. For example, January,
February, and so on.
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Working with the Drill Down Feature

This chapter provides a overview of the drill down feature and discusses how to define the drill down feature.

Understanding the Drill Down Feature
The drill down feature enables you to research beyond the summary information in a tabular report section and
into the detail from which the information was derived. The drill down feature is available in tabular sections
only. For example, in a tabular report that displays unpaid balances for customers, you can review each unpaid
invoice that contributes to the total unpaid balance. You can use the drill down feature to associate the data in
the report with the related PeopleSoft EnterpriseOne interactive application.

When the PeopleSoft EnterpriseOne application opens, an audit trail is created for financial reports, that
includes detail regarding the data on the report. The audit trail records are static. Therefore, the information in
the audit trail might differ from the information in the records you are auditing. For example, if someone posts
a transaction after you run the report, the change is immediately reflected in the table, but it is not reflected
in the audit trail. You cannot create an audit trail for tabular reports containing row or cell specifications or
calculation fields.

Important! Because the drill down feature requires significant system resources, you should activate
it only when required.

Defining the Drill Down Feature
This section provides an overview of activating the drill down feature, lists the prerequisites, and discusses
how to:

• Activate and define the drill down feature.

• Review audit trails.

• Purge drill down work files.

Understanding Activating the Drill Down Feature
You must activate the drill down feature before you can define it. You can activate and define the drill down
feature in a report template that contains a tabular section; this includes financial reports because they use
the tabular section type.

You can also activate and define the drill down feature in a batch version. When defining the drill down feature
in a batch version, you must first override the specifications for the section layout and the event rules.
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Activate the Drill Down Feature
You can activate the drill down feature during these activities:

• Editing or revising the tabular section report in Report Design Aid.
The drill down feature is accessed on the Tabular Section properties form. The name of the tab where the
drill down feature resides is dependent on the type of section that you create. For a tabular section, the name
of the tab is Financial. For a financial report, the name of the tab is Financial Report.

• Creating a financial report using the Report Design Director.
• Modifying or creating a Report Director Template.

Define the Drill Down Feature
You define the drill down feature by indicating the PeopleSoft EnterpriseOne application where the detail
resides for the data that is presented in the tabular section. As part of the drill down feature, you define the:

• Interactive application
The name of the application that is associated with the data presented in the tabular report section.

• Form
PeopleSoft EnterpriseOne interactive applications can include multiple forms. Select the form to appear
when the application is launched.

• Version
Some PeopleSoft EnterpriseOne interactive applications have more than one version. Select the appropriate
version to launch. When there is only one version of the application, the system does not present this form.

Note. If the report template has processing options attached, you are prompted to provide the parameters
after defining the interactive application.

The last step in defining the drill down feature is to map the form interconnect fields in the data structure. Map
fields from the business view that is attached to the tabular section to the fields that reside on the selected
interactive application form. The fields that you map from the tabular section must be the fields that are
required to access the detail in the application. You do not typically need to map all fields that are included
in the data structure. You must modify the directional arrows to ensure that the data flows from the tabular
section to the associated application.

Review Audit Trails
When reviewing an online report from the web client, a user can click specific data in the report that the system
fetches from the database, and the system automatically launches the associated PeopleSoft EnterpriseOne
application.

Using the drill down feature establishes an audit trail for financial reports, whereby you can see detail about
the data in the report. Tabular reports that use the drill down feature and are not financial in nature do not
create an audit trail.

Purge the Drill Down Work Files
Each time that you activate the drill down feature in a financial report, the system creates a work file that
remains in the system until purged.
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The information from the audit trail resides in the F83UI001 table. This work file must be purged periodically
using the Drill Down Table Purge, which is located on the Advanced Report Setup menu (GH9141), to
improve processing time. Typically, a system administrator is responsible for purging drill down work files.

Prerequisites
Before you define the drill down feature, ensure that you:

• Create a batch application object.

• Complete the design of a financial report template in which you can define the drill down feature.

Activating and Defining the Drill Down Feature
Open a financial report template in Report Design Aid.

1. Click the tabular report section for which you want to activate the drill down feature.
2. From the Section menu, select Section Properties.
3. On the Tabular Section form, select the Financial tab.
If you are creating an application report, the system names the tab the same names as the Director
template. For example, if you select the Financial Reports template in the Report Director, the tab
is named Financial Reports.

4. Select the Drill Down option, and click Define.
5. On the Work With Applications form, click Find.
You can filter the search by entering search criteria in the QBE line.

6. Click an application, and click Select.
7. On the Work With Forms form, select a form, and click Select.
8. On the Work With Versions form, perform one of these actions:
• Click a version, and then click Select.
• Click Close to avoid selecting a specific version.
If the report has processing options, the system prompts you to provide the parameters.

9. On the Form Interconnections form, click the first <NOT Assigned> field in the data structure.
10. Double-click the object in the Available Objects list that is associated with the first field from the
application form.
Fields in the Data Item column of the data structure come from the application that you defined. Mapping
the associated field from the report ensures that the value is passed into that field of the application form.

11. Click the directional arrow in the Dir column for each parameter until it becomes a right arrow and
then click OK.
The arrow indicates that the data flows from the source (the report section) to the target (the interactive
application).
Ensure that you move the cursor down to the next field in the data structure before you select the next
available object.

Note. Available objects vary for each <NOT Assigned> field, depending on the field type of the data item.
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12. On the Tabular Section form, click OK to return to the Report Design form.

Reviewing Audit Trails
From the Submit Job-Work With Batch Versions-Available Versions form on the web client, process a batch
version for a financial report template.

1. Select Submitted Jobs from the Form menu.

2. On the Submit Job-Submitted Job Search form, select the batch version that you processed and then
select View PDF from the Row menu.

3. Within the online report, position the cursor over the record that you want to research.

If the selected data is associated with the PeopleSoft EnterpriseOne application, the cursor becomes a
pointing index finger.

4. Click the value.

The Acrobat Reader displays a message asking if you want to launch the application.

5. On the Acrobat Reader form, click Yes to open the application form.

The form that is associated with this report section displays the record that you selected from the report.

6. Select the record for which you want to display details, and click Select.

The form that is associated with this report displays the details of the record that you are investigating.

7. When you are finished with the evaluation of the form, click Close.

8. When you are completely finished with the evaluation of the records, open the report template in Report
Design Aid, go to the tabular section properties, select the Financial tab, and clear the Drill Down option.

Purging Drill Down Work Files
Select Drill Down Table Purge from the Advanced Report Setup menu (GH9141) to access the Purge Financial
Reporting Drill Down Work File form.

1. Click Find.
A list of all existing drill down work files appear in the grid.

2. Select a file, and click Delete.
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Setting Up Processing Option Templates

This chapter provides an overview of processing option templates and discusses how to design and use
processing option templates in reports.

Understanding Processing Option Templates
Processing options designate parameters that are used by reports. When reports are processed, the processing
option template passes values that are entered by the user. These values are passed to event rules that are
attached to the report to perform customized processing.

Processing option templates are included in PeopleSoft EnterpriseOne. You can also create custom processing
option templates to meet your business needs.

You can use processing options to:

• Control how reports process data.
• Set up default values.
• Customize batch versions for different companies or even different users.
• Control the format of reports.
• Control page breaks for reports.
• Control totaling for reports.

Processing option templates contain one or more parameters. You can add tabs, with descriptive names, to the
processing option template to categorize the parameters. For example, you can name a tab Print to describe
parameters that affect how a report prints or which printer is used.

At runtime, processing option templates display the set of tabs which are referred to as pages. When you select
a tab, the page changes to display the set of processing options for that category.

You can add comments to processing options. The comment should describe the purpose of the available
parameters and any information that is required by the user. Use this processing option to indicate the preferred
format of labels for printing.

Each processing option tab displays parameters in a row within the template and is defined by a title, which
often includes valid values when appropriate. You add data items to the processing option tab to define the
parameters. You can change the description of the data item to better describe the purpose of the parameter.
Enter 1 to print single column labels and 2 to print two-column labels.
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Each data item that you include on the processing option template includes a member name. This name is
located on the properties form and can be modified. You want to modify the member name of fields that
provide a generic use. Modify the member name to be a descriptive name that you will recognize in Event
Rules Design. The recommended naming convention is to include the Hungarian Notation at the beginning of
the name and the data item alias at the end, preceded by an underline. Do not include spaces in the name.
For example, the Add [Y/N] data item is often used in processing options for entering a yes or no value. You
might modify the member name to read cDisplayCommentsColumn_A.

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Data Structure Design, “Using
Processing Options”

Designing and Using Processing Option Templates in Reports
This section provides an overview of processing option templates in reports, lists the prerequisites, and
discusses how to:

• Create data structure objects.
• Create processing option templates.
• Add tabs to processing option templates.
• Attach processing option templates to reports.

Understanding Processing Option Templates in Reports
To use a processing option with a report, you must attach the processing option template to the report template.
When the report is launched, the system prompts the user to enter processing option values. However, even
if a report template has a processing option template attached, the system might launch the report with no
prompting. This is called a blind execution. The processing option values for a blind execution are predefined
and cannot be modified by the user.

Processing option templates are a report feature so they are always attached to the report template. Processing
option templates are reusable objects so you can attach the same processing option template to multiple
reports. Processing option values, however, are stored with the batch version. This enables you to assign a
set of processing option values to a particular batch version. For example, you can have two versions of a
report that prints labels; one version with the processing option values set to print one-column labels, and one
version set to print two-column labels.

This overview outlines the process for creating and using processing option templates in a report:

1. Create processing options by building a list of parameters called a template.
2. Attach the processing option template to a report template and create event rules in the appropriate report
section to process the processing option values.

3. Create versions of the report template that indicate how the system will handle processing options
at runtime.
• Prompt for Values
The processing options appear, enabling the user to enter values.
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• Blind Execution
The report runs using a set of predefined processing option values.

You must attach processing option templates to report templates to use the functionality at runtime. Processing
option templates are reusable objects, so you can attach the same processing option template to multiple reports.

Prerequisites
Before you design and use processing option templates in reports, ensure that you:

• Create a batch application object.
• Complete the design of a financial report template to which you can attach a processing option template.

Creating Data Structure Objects
Access Object Management Workbench.

1. Click Add.
2. On the Add EnterpriseOne Object to the Project form, select the Data Structure option and click OK.
3. On the Add Object form, enter the name of the processing option template in the Object Name field using
the recommended naming conventions.

4. Enter a brief description of the processing option template in the Description field
5. Enter a client reserved product code (55–59) in the Product Code field.
6. Enter the system code that relates to the report data that this processing option will affect in the Product
System Code field.

7. Enter 360 in the Object Use field to indicate that the object is a data structure.
The object use value should reflect the object that you are creating. You can create categories of data
structures to select from the Object Use list. Click the visual assist in the Object Use field. On the Select
User Defined Code form, select Revisions from the Form menu. On the Work With User Defined Codes
form, click Add. On the User Defined Codes form, scroll to the bottom of the list and enter a new code and
description in the blank row of the grid.

8. Under Type, select Processing Option Template and click OK.
The tool that the system presents for developing the data structure object is dependent on the type that you
select. If you select Regular Data Structure, the system presents a much different form than if you select
Processing Option Template.

9. On the Processing Option Design form, select the Design Tools tab, and click Start the Processing Option
Design Aid.

Creating Processing Option Templates
Access Processing Option Design Aid

1. On the Processing Options Design form, right-click <New Tab> and select Current Tab Properties from
the pop-up menu.

2. On the Tab Properties form, complete these fields, and click OK:

• Short Name
• Long Name
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3. Click A on the toolbar and then click the processing option template to add a comment box.
4. Double-click the comment box, highlight Comment Text, and enter a brief description of the processing
option tab.

Note. You can highlight the comment text and type over it or you can backspace to remove the text, but
you cannot use DELETE to delete the text.

5. On the Data Dictionary Browser form, enter a value on the QBE line to locate a required data item,
and then press ENTER.
You can also click the Search button that is located directly beneath the Data Dictionary Browser heading
to search through all data items.

6. Drag the required data items to the processing option template.
You can also double-click the data item and it appears on the processing option tab.

7. To reposition a data item on the processing option tab, click the data item and drag it to another location.
The Processing Options tool automatically adjusts the size and position of data items to fit the width
of the tab.

8. Double-click the text portion of the item to modify the description.

Note. You can highlight the text and type over it or, you can backspace to remove the text, but you
cannot use DELETE to delete the text.

9. Right-click the data item field and select Properties from the pop-up menu.

10. On the General tab of the JDE.DataItem Properties form, change the Member Name field, if necessary.

11. Select the Help Override Data Item tab, modify the Data Item Help Override Name field, if necessary and
click OK.

12. Save the processing option and exit Processing Option Design Aid.

Adding Tabs to Processing Option Templates
Open a processing option template in Processing Option Design Aid.

1. Right-click the current tab and select New Tab from the pop-up menu.
2. On the Tab Properties form, complete these fields, and click OK:
• Short Name
• Long Name

3. Add comments and data fields as appropriate.
4. From the Edit menu, select Test to test the processing option when it is complete.
In test mode, you can click the visual assist for a data item to verify that you have selected the correct
data item.

5. Save the processing option and exit Processing Option Design Aid.

Attaching Processing Option Templates to Reports
Open a report template in Report Design Aid.
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1. From the File menu, click Select Processing Options.
2. On the Select Processing Option Template form, use the QBE line to search and select the template you
want to use, and click OK.
A check mark appears next to Select Processing Options on the File menu, indicating that a processing
option template is attached to this report.

3. Verify that the processing option template is attached to the report by selecting Report Properties from the
File menu.
The Processing Options field on the Report Properties tab indicates the processing option template that is
attached to the report.

4. Add logic in Event Rules Design to indicate to the system how each valid value entered into the processing
option template should be processed.

5. To remove an existing processing option template, from the File menu, click Select Processing Options.
6. On the Select Processing Option Template form, select the template and click Remove.
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CHAPTER 22

Working with Database Output

This chapter provides an overview of database output and discusses how to use database output to update data.

Understanding Database Output
You can use database output to update the database using a batch application. You can attach a database output
specification to any report section with an attached business view The report template must be defined as an
Update report for the Database Output option to be available.

You can use database output in Report Design Aid to update, insert, or delete records in PeopleSoft
EnterpriseOne tables. You can also insert records in text files. You can also use a special operation called
Insert or Update. This operation attempts to insert a record into a table. If a record with the same primary key
exists, the insert fails and the system updates the existing record instead.

You can use database output to load data into PeopleSoft EnterpriseOne tables or into text files. Text files
can be specified as either comma delimited or fixed-length text records. The comma-delimited format is
useful for transferring data to spreadsheets.

Using Database Output to Update Data
This section provides an overview of database output in PeopleSoft EnterpriseOne, lists the prerequisites,
and discusses how to:

• Define database output.
• Override environments for database output.

Understanding Database Output in PeopleSoft EnterpriseOne
This table describes the tools that you can use to perform database maintenance in PeopleSoft EnterpriseOne:

Tool Description

Table Conversion Use for high-performance SQL table-to-table processing.
Enables access to non-PeopleSoft EnterpriseOne tables. No
reporting.
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Tool Description

Database Output Use to affect tables in different environments that are
defined on the Advanced tab of the Report Properties form.
Enables you to output to text files. Reporting and output
occurs simultaneously.

Table I/O (in Event Rules) Use for transforming input data using event rules before
outputting to the database. Reporting and output occurs
simultaneously.

Database Output
Database output is performed for every row of data that is processed in the section. All database operations
occur on a record-by-record basis using the standard JDE Base middleware Application Programming
Interfaces (APIs).

Defining database output involves defining the output and then overriding the environment, if appropriate. If
no override is defined, the database output runs against the default data source.

When you design database mappings in a batch application, Report Design Aid determines where the system
stores the flat files that are produced by the mapping. You can also define a default destination using the
"UBEDBOutputLocation" in the "[UBE]" section of the jde.ini file. If no location is defined in Report Design
Aid or in the jde.ini file, or if the location is invalid, the files are stored in the current working directory.

The first step in defining database output is to select an operation for mapping the targets:

• Insert only
Can be used for tables but is the only appropriate option for text files.

• Update
• Insert or update
• Delete

Next, you need to select the type of target that you are using:

• OneWorld table.
• Comma-delimited text file.
• Fixed-record length text file.

After you have defined the database output, you can suppress it by:

• Overriding the database output in the version and deleting the mapping record to process the database
output for a specific version of the report.

• Defining the criteria using If statements and then using the Suppress Section Write system function to
process the database output for specific rows of data.

The Suppress Section Write system function suppresses not only printed output but also database mappings.

You can also use table I/O in event rules to perform database maintenance.

See PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Tables and Business Views,
“Working with Table I/O”.
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Prerequisites
Before you begin working with database output, ensure that you:

• Create a batch application object.
• Defined the report template as an Update report.
• Complete the design of the report template.

Defining Database Output
Open a report template in Report Design Aid.

1. Click a detail report section and from the Section menu, select Database Output.

2. On the Mapping Targets form, in the Operation field of the grid, select an operation.

You can double-click the Operation(s) and Type fields to view a list of available options. Double-click
the option to select it.

3. In the Type field, select the type of file you are using as a target.

You can use the same source type several times using different operations.

4. In the Name field, enter the name of the file you are using as a target.

5. Click Next.
6. On the Mappings form, for each target column, specify which of the available objects from the report
section should be assigned (mapped).

Double-click a Source Section or a Source Object field to display a list of options.

You can also enable data dictionary overrides from this form.

7. On the Mappings form, click the Map Same option if you need to map all columns.

8. When you have completed the mapping, click Finish.

Overriding Environments for Database Output
Open a report template in Report Design Aid.

1. From the File menu, select Report Properties.
2. On the Properties form, select the Advanced tab.
3. Complete the Target field or click the Browse button to select the target environment.
4. Complete the Source field or click the Browse button to select the source environment.
5. Select the Prompt for overrides at runtime option, if desired, and click OK.
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CHAPTER 23

Working with Subsystem Jobs

This chapter provides an overview of subsystem jobs and discusses how to define subsystem jobs.

Understanding Subsystem Jobs
Within PeopleSoft EnterpriseOne, subsystem jobs are batch processes that continually run independent of,
but asynchronously with, PeopleSoft EnterpriseOne applications. These subsystem jobs function with the
system’s logical process or queue defined for the server platform. You can configure PeopleSoft EnterpriseOne
to use one or more subsystems.

Use subsystem jobs to off-load processor resources, to protect server processes, or to do repetitive and frequent
processes to maximize output throughput. Examples of applications that are suited for subsystem processing
include Logistics Warehousing, Inventory, and Sales Order Processing. For example, you can execute the
Sales Order Entry application on a workstation and automatically print pick slips when all orders are entered.
If you are using a version of pick slips that has the subsystem job function enabled in the report properties
in Report Design Aid, the request is executed by a subsystem job. The pick slip request is routed to and
processed by the subsystem job on the defined enterprise server. As a result, no additional processing
resources are required of the workstation.

When a PeopleSoft EnterpriseOne application issues a request for a job to run as a subsystem job, it places a
record in the F986113 table. This record is identified by a subsystem job name and version, and contains status
and operational indicators. Embedded in the record is key information, such as the values for the processing
options and the values for the report interconnect data structure, that enables the subsystem to process the
record without additional interaction with the requesting application. The continuously running subsystem
monitors this table for records. If the subsystem finds a record with the appropriate status indicators for the
specific report and version being run, it processes the record and updates the status accordingly.

This diagram illustrates how the system processes a subsystem job:
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Start a batch process to launch pick slip
in subsystem mode (R42520)

Pick slip subsystem (R42520),
version ZJDE0007

Workstations Enterprise Server

Look for records with W status
and R42520

Fetch and process records

System Administrator

Return status

System Table (F986113)

Type Status

UBE P (Processing)
D (Done
O (In Queue)
H (Hold)
E (Error)

Subsystem Job Type Job Status BLOB

R42520D W
P
D

W = Waiting

P42520 writes a W record
to the subsystem table

Pick slip request issued that uses a
version of P42520 defined to use a

subsystem on the server

Subsystem processing
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Defining Subsystem Jobs
This section provides overviews of subsystem job definitions and adding records to the subsystem table using
an API, lists the prerequisites, and discusses how to:

• Define reports as subsystem jobs.

• Add records to the subsystem table.

Understanding Subsystem Job Definitions
Subsystem jobs are continuous jobs, processing records from a data queue. This type of job runs until you
request termination. Subsystem jobs read records one at a time for a subsystem table, retrieve information
from the specific record, and run the batch engine for each record. At the end of the records, instead of ending
the job, subsystem jobs sleep for a defined period and then retrieve the information for the next record. For
each subsystem job, multiple records can exist in the subsystem table.

You run a subsystem job the same way as you would run a regular batch job. No difference exists between
running a subsystem job and running a batch job.

Before processing, PeopleSoft EnterpriseOne ensures that limits for the subsystem job on the defined server
have not been exceeded. If exceeded, the batch engine does not process the subsystem job.

Understanding Adding Records to the Subsystem
Table Using an API
Use an API to add records to the subsystem table to enable the subsystem job to perform the batch process.
To add records to the subsystem table, you must create a business function. You then generate a header
file in Report Design Aid. The header file takes the form of Report_Name.h under the E811 folder
$environ\include subdirectory. In an interactive application, from which the system fetches a record to process
in the subsystem report, you can add this header file to the business function using Microsoft Visual C++
to create a subsystem record. When the business function is complete, attach the business function to the
appropriate event rules of the program to be called.

For example, you can specify to call a business function when the user clicks OK on Sales Order Entry (P4210).
The business function uses the report’s data structure and the subsystem’s APIs to trigger the subsystem report.

This API record retrieves data structure and user information from the cache. If the server name is not passed,
the API finds Object Map Record from the F98611 table. If the record exists, it uses the record to send a
JDENet Message to the server’s Subsystem Kernel to add the record to the subsystem table on the server.
However, if the user provides an Override Server name, the JDENet message is sent to that server’s Subsystem
Kernel instead. Each server is only allowed to have one subsystem kernel running.

Prerequisites
Before you begin defining subsystem jobs, ensure that you:

• Create a batch application object.

• Complete the design of the report template.

• Generate the header file in Report Design Aid using the Report Data Structure to ensure that the API is
called from the business function.
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Defining Reports as Subsystem Jobs
Open the report template in Report Design Aid.

1. From the File menu, select Report Properties.
2. On the Properties form, select the Subsystem option on the Advanced tab .
3. Enter an appropriate value in the Wait Time (ms) field, and click OK.
The value in the Wait Time field is entered in milliseconds (1000 milliseconds equals one second). This
represents the time that the subsystem job sleeps until checking the subsystem file for new records
to process.

4. From the File menu, select Report Data Structure.
5. On the Report Data Structure form, enter a data item alias on the QBE line to display the required data item.
You can also click Find to display a list of data items from which to select.

6. From Dictionary Items, drag the required data items over to Structure Members, and click OK.
7. From the File menu, select Report Properties.
8. On the Properties form, click Generate on the Advanced tab to create a header file.

Adding Records to the Subsystem Table
This example illustrates the subsystem job header file:

#include <jde.h>

/************************************************************

* Report : R98SSUBE * ReportId : 8123244 * DSTRId : 380813 *

* Note: * Do not edit the following typedef

* To make modifications, use the Report Design Aid Tool to

* Generate a revised version.

*************************************************************/

#ifndef REPORT_DS_380813 #define REPORT_DS_380813

typedef struct tagDS_RI_380813 { char

ProgramId[11]; } DSRI380813, *LPDSRI380813;

#define IDERRProgramId_1 1L

#endif /* #define REPORT_DS_380813*/

#endif /* #define __R98SSUBE_H */

Add a business function object in Object Management Workbench.

1. On the Business Function Design form, select the Design Tools tab and click Start Business Function
Design Aid.

2. Complete the function name and description, and then attach the appropriate data structure.

3. In Microsoft Visual C++, open the business function include file and add the name of the header file that
you generated.
In this example, the include statement is emphasized:

/***************************************************************************

/* Table Header Inclusions

****************************************************************************/
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/***************************************************************************/

External Business Function Header Inclusions

****************************************************************************/

#include <R98SSUBE.h>

/***************************************************************************

* Global Definitions

****************************************************************************/

/***************************************************************************

* Structure Definitions

****************************************************************************/

* TYPEDEF for Data Structure

* Template Name: Report Interconnect Data Structure

* Template ID: D983059

* Generated: Wed Oct 18 14:01:22 1995

4. In Microsoft Visual C++, open the business function source file and add lines to declare the variable of this
data structure type and populate the members of the data structure.

In this example, the new line is emphasized:

#include <jde.h>

/****************************************************************************

* Variable declarations

*****************************************************************************/

HUSER hUser=NULL;

LPSTR szServer=NULL;

DSRI380813 dsRI; /* Declare the variable of type REPORT

INTERCONNECT DATA STRUCTURE */

BOOL bRet=FALSE;

JDEDB_RESULT rcode;

/****************************************************************************

Declare structures

*****************************************************************************/

/****************************************************************************

Declare pointers

*****************************************************************************/

/****************************************************************************

Check for NULL pointers

*****************************************************************************/

if ((lpBhvrCom == NULL) ||

(lpVoid == NULL) ||

(lpDS == NULL))

5. In the source file, call the API to add the record.
In this example, the new lines are emphasized:

*****************************************************************************

Main Processing
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*****************************************************************************/

memset(&dsRI, 0, sizeof(DSRI380813));

/* Populate the members of the Report Interconnect Data Structure */

strcpy(dsRI.ProgramId,lpDS->szString01);

/* Call Subsystem API to add the record to the Subsystem Table */

/* Note : As Environment Name is set to NULL, this API will use OCMto

find the default Environment of this UBE */

bRet=jdeAddSubsystemRecord( hUser,/* User Handle */

"R98SSUBE", /* Name of the subsystem */

"XJDEOOO1", /* Name of the Subsystem Version*/

NULL, /* Name of the override env - not used */

szServer, /* Name of the server */

&dsRI); /* Subsystem Connect DS */

/**************************************************************************/

6. After you call the jdeAddSubSystemRecord API to attach the record, build the business function.

7. Call the business function from the event rules process of the program to be called. This program can be
either an interactive or batch application.

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: APIs and Business Functions

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Event Rules and System Functions

182 PeopleSoft Proprietary and Confidential



CHAPTER 24

Creating Report Director Templates

This chapter provides an overview of Report Director templates and discusses how to add and modify Report
Director templates.

Understanding Report Director Templates
The Report Director aids you in designing reports by guiding you through the design process. In addition to
creating a group, columnar, or tabular section, the Report Director uses templates to help you create application
reports, such as financial reporting, fixed assets, or job cost. These templates, included with PeopleSoft
EnterpriseOne, contain default criteria. When you select one of the templates in the Report Director, the
system reads the template specifications (stored in PeopleSoft EnterpriseOne tables) and presents the default
criteria through the Report Director forms.

The template specifications are stored in these PeopleSoft EnterpriseOne tables:

Table Description

Report Director Templates (F91400) Contains the default business view and processing option
information.

Report Director Templates Sequence Items (F91410) Contains information about the preferred data sequencing.

Report Director Templates Smart Field Activation
(F91420)

Contains information about which smart fields to display.

Adding and Modifying Report Director Templates
This section provides an overview of Report Director template definitions, lists the prerequisite, and discusses
how to create custom Report Director templates.

Understanding Report Director Template Definitions
You can modify the PeopleSoft EnterpriseOne Report Director templates and create custom templates through
the Report Director Templates (P91400) program. When complete, the templates are available on the Welcome
form of the Report Director.

The Report Director template description displays in the Application Report drop-down field on the Welcome
form of the Report Director. Custom Report Director Template names should begin with DT and follow the
recommended naming convention for PeopleSoft EnterpriseOne objects.
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The Report Director Templates application includes three tabs:

• Building Blocks

Available for all Report Director templates.

• Properties
Available only if the tabular detail section is selected for the report.

• Drill Down
Available only if the tabular detail section is selected for the report.

For each Report Director template that you create, you can define these specifications:

• Which detail section type to use in the report.
• Which business view to use as the default.
• Which processing options to use with the report.
• Which smart field template to make available for the selection layout.

Important! Smart fields associated with a Report Director template rely on the business view attached to
the report template. If you select a different business view when designing the report, the associated smart
fields might not function correctly. Before making any such changes, ensure that you know which business
view columns the smart fields require. This critical association is justification for defining the default
business view in the Report Director Template.

• The preferred section data sequencing and level breaks.
Under the Default Sequence and Level Breaks heading, you can define the data sequencing to be used in
the report. The first two data items you select are defined as level break fields. These can be modified
when you design the report.

• Which additional properties to include.
Display financial or generic criteria. Available only if the tabular detail section is selected for the report.

• Define the appropriate drill down feature.
Activate and define the drill down feature. Available only if the tabular detail section is selected for the report.

See Also
Chapter 32, “Creating Smart Fields,” Creating Custom Smart Fields, page 248

Prerequisite
Locate the name of a smart field template to be used or, if a suitable one does not exist, create a smart field
template.
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Forms Used to Add Report Director Templates
Form Name FormID Navigation Usage

WorkWith Report Director
Templates

W91400A EnterpriseOne Life Cycle
Tools, Report Management
(GH9111), Advanced Report
Setup, Report Director
Templates

Add, modify, and delete
Report Director templates.

Report Director Templates
Revisions

W91400B Click Add on theWorkWith
Report Director Templates
form.

Enter the Report Director
template name, description,
section type, default
business view, processing
options, smart field template
name (if appropriate),
default data sequencing and
level breaks, properties,
and drill down.

Creating Custom Report Director Templates
Access the Report Director Templates Revisions form.

Report Director Templates Revisions form - Building Blocks tab
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Report
Template/Description

The name of the Report Director template and a meaningful description.
The Report Template/Description information displays from all three tabs.

Section Type The type of report section the system creates when this Report Director
template is selected.

Business View The business view to be used by the report. You can override this business
view in the Report Director.

Processing Options This field is optional. The processing options to be used by the report. You can
override this business view in the Report Director.

Smart Field Template This field is optional. The smart field template to be used by the report. The
smart field template is dependent on the business view defined.

Default Sequence and
Level Breaks

The data sequence and level breaks to be used by the report. These fields
appear on the Data Sequencing Help form of the Report Director. The first two
data items appear in Report Grouping, and the subsequent data items appear in
Report Detail. You can override these fields in the Report Director.

The Default Sequence and Level Breaks information displays from all three
tabs.

Report Director Templates Revisions form - Properties tab

Use Financial Description Used to provide the correct description of the object account. The system sets
this option on the Additional Properties form of the Report Director.
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Display Level of Detail Determines the level of detail for summarizing the object account information
based on the levels defined in the chart of accounts. The system sets this
option on the Additional Properties form of the Report Director.

Display AAI Subtotal Inserts subtotals based on the Financial Statements series of AAIs. The system
sets this option on the Additional Properties form of the Report Director.

Display Adjust Sign Reverses the sign of amounts (debits and credits) in accounts for balance sheet
or income statement reports. The system sets this option on the Additional
Properties form of the Report Director.

Display Suppress Zero
Rows

Suppresses the printing of a row in a tabular section using one of these options:

• No Zero Row Suppression.
• Suppress Zero Detail Rows Only.
• Suppress All Zero Rows.

Display Generic Criteria The Report Director displays the Section Data Selection form.

Display Financial Criteria The Report Director displays the Help with Section Data Selection form.
This form enables you to select records based on balance sheet or income
statement accounts.

Note. The Display Generic Criteria and the Display Financial Criteria options are mutually exclusive.

Report Director Templates Revisions form - Drill Down tab
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Drill Down Activates the drill feature. The application, form, and version must be defined
to ensure that the drill down feature functions.

Drill Down App/Form/Vers The name of the PeopleSoft EnterpriseOne application, form, and version that
will launch to display the detail of the record selected in the report.
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CHAPTER 25

Understanding Additional Information for
Designing Reports in PeopleSoft EnterpriseOne

This chapter discusses additional information for designing reports in PeopleSoft EnterpriseOne.

Additional Information for Designing Reports
When adding logic to reports, it is critical that you understand the events available to you. Events are available
at the report level, section level, and object level. When you understand how each of these events are processed
by the system, you can maximize performance by using the best event choice for the job.

Knowledge of the process flow of reports also aids you in designing efficient reports.

This section provides additional information about using Report Design Aid to create complex reports, and
includes these topics:

• Edit Code Table
Describes the edit codes that are available. Edit codes determine how numerical data is displayed in a report.

• Events
Describes the different events available for reporting.

• Report Processing
Describes the flow of processing for reports, sections, level breaks, batch events, and batch runtime.

• Batch Error Messages
Describes the purpose of batch error messages and how to create messages.

• Smart Fields
Describes how to create smart fields, define the data structure and named mapping, define required logic,
create data dictionary smart field items, create smart field templates, create Report Director templates,
and create reports using smart fields.
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Understanding Edit Codes

This chapter discusses edit codes.

Edit Codes
PeopleSoft EnterpriseOne uses edit codes to determine how to display or format numeric values for a report.
The default edit code for a numeric value is derived from the associated data dictionary item. However, you
can override the edit code in the Object Properties in Report Design Aid. The Edit Code Table can help you
select the edit code that best meets your business needs.

To select the appropriate edit code for the report, review the Negative Amount Notation column in the Edit
Code table and select the appropriate option. This narrows the search to four codes. For example, if you select
a trailing minus sign as your negative amount notation, your search is narrowed to the selection of J, K, L, or M.

Next, review the Zero Balance column in the Edit Code table and determine whether you want to print
zero balances in the report. This narrows the search to two codes. For example, if you print zero balances,
your search is narrowed to the selection of J or L.

Next, review the Commas column in the Edit Code table and determine whether you want to include commas
in the numeric values on the report. For example, if you want commas in the report figures, select J. If
not, select L.

This Edit Code table lists the available edit codes and their characteristics:

Edit Code Commas Y/N Zero Balance Y/N
Negative Amount

Notation

A Y Y Cr

B Y N Cr

C N Y Cr

D N N Cr

J Y Y - Trailing

K Y N - Trailing

L N Y - Trailing

M N N - Trailing
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Edit Code Commas Y/N Zero Balance Y/N
Negative Amount

Notation

N Y Y - Preceding

O Y N - Preceding

P N Y - Preceding

Q N N - Preceding

R Y Y < >

S Y N < >

T N Y < >

U N N < >

1 Y Y No sign

2 Y N No sign

3 N Y No sign

4 N N No sign
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Understanding Events

This chapter discusses:

• Events.
• Processing option logic.
• Event levels.

Events
As a report is processed, the system pauses at specific points to process attached logic. These points are
called events. You can use events to attach custom logic for processing. You use event rules in PeopleSoft
EnterpriseOne to create logic statements without the difficult syntax required by most programming languages.
Event rules process when an event, such as a page break, is encountered.

Events execute in a specific order during the processing of the report. Events are attached to controls, such
as objects, sections, and reports. When you access Event Rules Design, the set of events you are presented
with varies depending on where the cursor is positioned in the report.

Processing Option Logic
The section and event used to attach event rules affecting processing option values depends on the purpose
of the processing options attached to the report. Some processing options must be read before fetching data
from the database because they affect which records are fetched. Other processing options might determine
whether a level break section is displayed in the report.

If the processing option template determines the data to be fetched from the database, you typically place
the associated event rules in the Initialize Section event of the affected detail section. For example, if the
processing option is prompting for which fiscal year to present, this value must be read before the system
fetches any values for that section.

If the processing option determines whether to display a level break section in the report, the processing option
needs to be processed before the level break section is processed. The event rules for this processing option are
typically placed on the Initialize Section event of the level break section affected.
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Event Levels
The events available to you are determined by the section type and where the cursor is positioned in the
report template when entering Event Rules Design. The tables in this section list events that are available
for these levels:

• Reports
• Sections
• Objects

Report Level Events
This table describes the events that are available for the report level; XO indicates that an event is supported:

Event Description

Do Initialize Printer XO

Initialize Report future functionality

End Report future functionality

Section Level Events
This table lists the events that are available for sections; XO indicates that an event is supported:

Event
Report
Header

Page
Header Columnar Group Tabular

Child/
Custom
(CG)

Level
Break
Header

Level
Break
Footer

Page
Footer

Report
Footer

Advance
Section

N/A N/A XO XO XO XO XO N/A N/A N/A

After
Last
Object
Printed

XO XO XO XO XO XO XO XO XO XO

Before
Level
Break

N/A N/A XO XO XO XO N/A N/A N/A N/A

Do
Balance
Auditor

N/A N/A N/A N/A XO N/A N/A N/A N/A N/A

Do
Section

XO XO XO XO XO XO XO XO XO XO

Do
Tabular
Break

N/A N/A N/A N/A XO N/A N/A N/A N/A N/A
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Event
Report
Header

Page
Header Columnar Group Tabular

Child/
Custom
(CG)

Level
Break
Header

Level
Break
Footer

Page
Footer

Report
Footer

End
Break
Section

N/A N/A XO XO XO XO N/A N/A N/A N/A

End
Lvl Brk
Footer
Section

N/A N/A N/A N/A N/A N/A N/A XO N/A N/A

End
Lvl Brk
Header
Section

N/A N/A N/A N/A N/A N/A XO N/A N/A N/A

End Page
Header

N/A XO N/A N/A N/A N/A N/A N/A N/A N/A

End
Report
Header

XO N/A N/A N/A N/A N/A N/A N/A N/A N/A

End
Report
Footer

N/A N/A N/A N/A N/A N/A N/A N/A N/A XO

End
Section

N/A N/A XO XO XO XO N/A N/A N/A N/A

Init
Break
Section

N/A N/A XO XO XO XO N/A N/A N/A N/A

Init Lvl
Brk
Footer
Section

N/A N/A N/A N/A N/A N/A N/A XO N/A N/A

Init Lvl
Brk
Header
Section

N/A N/A XO XO N/A XO Even
though
event
rules can
be edited
in RDA,
this event
is not
processed
by the
system.

N/A N/A N/A

Initialize
Page
Header

N/A XO N/A N/A N/A N/A N/A N/A N/A N/A
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Event
Report
Header

Page
Header Columnar Group Tabular

Child/
Custom
(CG)

Level
Break
Header

Level
Break
Footer

Page
Footer

Report
Footer

Initialize
Page
Footer

N/A N/A N/A N/A N/A N/A N/A N/A XO N/A

Initialize
Report
Header

XO N/A N/A N/A N/A N/A N/A N/A N/A N/A

Initialize
Report
Footer

N/A N/A N/A N/A N/A N/A N/A N/A N/A XO

Initialize
Section

N/A N/A XO XO XO XO XO XO N/A N/A

Refresh
Section

N/A N/A N/A N/A N/A XO N/A N/A N/A N/A

Suspend
Section

N/A N/A XO XO XO XO XO XO N/A N/A

Object Level Events for Variables
This table lists the events that are available for variables; XO indicates that an event is supported:

Event
Report
Header

Page
Header Columnar Group Tabular

Level
Break
Header

Level
Break
Footer

Page
Footer

Report
Footer

Cell
Inclusion

N/A N/A N/A N/A XO N/A N/A N/A N/A

Column
Inclusion

N/A N/A N/A N/A XO N/A N/A N/A N/A

Do
Variable

XO XO XO XO XO XO XO XO XO

End
Column

N/A N/A XO XO XO N/A N/A N/A N/A

End
Variable

XO XO XO XO XO XO XO XO XO

Initialize
Column

N/A N/A XO XO XO N/A N/A N/A N/A

Initialize
Variable

XO XO XO XO XO XO XO XO XO
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Object Level Events for Constants
This table lists the events that are available for constants; XO indicates that an event is supported:

Event
Report
Header

Page
Header Columnar Group Tabular

Level
Break
Header

Level
Break
Footer

Page
Footer

Report
Footer

Do
Column
Heading

N/A N/A XO N/A XO N/A XO N/A N/A

Do
Constant

XO XO XO XO XO XO XO XO XO

End
Constant

XO XO XO XO XO XO XO XO XO

Initialize
Const

XO XO XO XO XO XO XO XO XO

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Event Rules and System Functions,
“Using Event Rules Design”
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CHAPTER 28

Understanding Report Processing

This chapter discusses:

• The batch process.
• Batch processing.
• Section processing.
• Level break processing.
• Batch events.
• System functions within batch events.

The Batch Process
Reports run using a batch process; they processes automatically without user interaction. The engine executes
the logic attached to the events within the batch process. After a batch process is launched, the flow of the
attached logic proceeds on a fixed path based on the data being processed. If you need to change the flow of
the logic, you must make modifications in the batch process using Report Design Aid. Examples of batch
processes include reports, subsystem jobs, database output, and table conversions.

Subsystem jobs are batch processes that constantly run in the background and off-load processor resources.
Subsystem jobs can also be used to move activities through a process, such as an escalation process in
Workflow, which moves unanswered messages from one user to another after a defined period of time.

The database output function within Report Design Aid enables you to update or insert records within tables.
Table conversions transfer data from one table to one or more tables, changes the data or schema of a
PeopleSoft EnterpriseOne table, and transfers data from a single business view to one or more tables.

This section describes some of the advanced features of batch and report processing and how those features
work.

Batch Processing
You create reports and batch processes using Report Design Aid, and you access the reports using PeopleSoft
EnterpriseOne Solution Explorer. Individual reports and batch processes can be associated with applicable
menus. You use batch processes to update tables or to print reports indicating the results of the batch process.
Reports are just one kind of batch process that generates output. Many batch processes do not generate output.

PeopleSoft EnterpriseOne reports contain all of the specifications for the report, including section layout,
business views, event rules, data selection, data sequencing, and database output.
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Each report includes one or more sections, which you create in Report Design Aid. Sections are self-contained
elements that are the building blocks of developing reports. You can join sections to one another or use them as
standalone groups of information. You can also use sections for special purposes, such as headers and footers.

Report Sections
PeopleSoft EnterpriseOne report sections include headers, footers, and detail sections (columnar, group, and
tabular). Some sections are dependent on other sections of the report. Dependent sections provide supporting
information and do not necessarily make sense on their own. Other report sections are independent and
address the business purpose of the report.

Independent sections are also referred to as level-one sections and include:

• Group
• Columnar
• Tabular

Level-one sections can also be parent sections.

Dependent sections are called from a level-one section. Dependent sections are also referred to as level-two
sections and include:

• Level break headers.

• Level break footers.

• Total sections (used in non-tabular reports).

• Subsections.

• Custom.

This graphic illustrates how the batch engine processes sections within a report:
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EO
Level 1 Section

EO
Level 1 Section

Batch Processing Report View (also
applies to batch
processing)

EO
Level 2

EO

EO
EO

EO

Parent

Child

Subsection

Conditional - can be called from
any level above

Process
Flow

Data selection and sequencing (at submission
time, only affects the first level 1 section).

Batch engine processing

The sequence in which the level-one sections of the report appear in the report view of Report Design Aid
determines the process flow of the level-one sections. For example, if a report has multiple level-one sections
and each has its own business view, then the first level-one section executes before the next level-one section
executes. Any level-two sections that exist between the level-one sections are processed when and if they
are called from a level-one section. If the report includes a subsection join following the level-one sections,
creating a parent/child relationship, then the parent/child sections are processed independently of the first
level-two section.

The system reads and processes all records in a section from beginning to end based on the defined data
selection. If you do not specify data selection, then all the records in the table are read until the end of
file (EOF) is reached.

If the report contains a subsection join following a level-one section, then the parent/child section is processed
independently of the first section.
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The parent/child relationship positioned in the middle of the previous graphic illustrates the flow of joined
sections. Parent/child sections can be called at any point within the process flow. Depending on how the
sections are joined (one-to-one, one-to-many, or many-to-many), records are fetched first from the parent
business view and then from the child business view for each corresponding parent record. When all parent
records have processed, the system continues to the next section. If any database updates are performed in one
of the first level-one sections, that change is reflected in the records fetched for the parent/child sections.

The last section in the previous graphic, the conditional section, can be called from any of the previous
level-one sections using the Do Custom Section system function. Conditional sections are called from a
level-one section dependent on the criteria you defined. For this reason, conditional sections are considered
level-two sections. Memory allocation for conditional sections occurs at the beginning of the section.
Therefore, you need to place conditional logic in the Initialize Section or End Section event to hide and show
objects because memory is allocated and freed only once, instead of each time a section is called.

PeopleSoft EnterpriseOne processes all section types, except for tabular sections, the same way. Tabular
sections output to the report only when the system encounters a level break. The system does not initialize the
Do Section for each record; instead, it summarizes the records to the lowest level break level. The output to
tabular sections is similar to level break header sections.

The process flow of level-one sections depends on the sequence in which the sections appear on the Report
tab in Report Design Aid. If level-one sections are moved, the execution sequence is affected. In report
processing, the system processes all level-one sections in the order in which they appear. This is not true
of level-two sections: all level-two sections are processed as dependents of level-one sections. Moving
conditional sections, subsections, level break sections, page headers, page footers, and report headers does
not affect the sequence of execution. Report execution takes place from top-to-bottom for sections; and
top-to-bottom, left-to-right for objects within a section.

Custom sections appear as level-one sections in the report view, but they are not processed unless explicitly
called by the Do Custom Section system function.

Detail report sections can be considered mini reports, or batch processes, with each section using its own
business view. Because other sections in the report can contain different business views, you must add data
sequencing and data selection to each section using Report Design Aid.

Note. Data sequencing and data selection defined at runtime affects only the first level-one section of the
report or batch process. Therefore, when you design a report or batch process, consider how this effects users:
they cannot change data selection and sequencing easily for additional level-one sections.

Whether or not a level-one section has a business view attached to it, it is executed at least once. Consider this
in your decision to execute special event rule logic using the Do Section event of that section.

Section Processing
When a report is processed, several events occur. The processing of the attached logic might be dependent on
processes that occur before and after a particular event.

The report header is processed before the level-one section, and the level-one section is initialized by the
Initialize Section event. After Initialize Section, the system processes the Advance Section, Page Footer, Page
Header, and so on. When the system finishes processing the first level-one section and all dependent sections
associated with it, it repeats the process for the next level-one section.

This section discusses:

• Group and columnar section event flow.
• Tabular section event flow.
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• Logic attached to joined sections.
• Data selection and sequencing.

Group and Columnar Section Event Flow
Group and columnar sections are alike in their processing because they both write to the output after each
record is read, unlike tabular sections, which write to the output only when a level break is encountered. The
output is determined by the data sequencing defined in the section.

This diagram illustrates the typical event flow for group and columnar sections:
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Tabular Section Event Flow
Tabular sections are comprised of columns, rows, and cells. To define what information is contained in each
column, row, or cell, you define inclusion event rules or calculations. Inclusion event rules can include
a set of criteria, a business function, or a named event rule for a row or column. One advantage of tabular
sections is that you do not have to define additional sections for level break logic or processing, as you do
with group and columnar sections. However, level breaks are dependent on the data sequencing, so you
must define data sequencing correctly.

This diagram illustrates the typical event flow for tabular sections:

Advance Section

Before Level Break

Initialize Section

No tabular
level break

Do Tab Break Do Section

Event flow for tabular section

Tabular sections summarize information and write to the output only when a level break is encountered. Level
breaks are dependent on data sequencing and can be modified to make records as detailed or as general as the
business need requires. The more fields that you include in the section data sequencing and define as level
breaks, the more detailed the report is. For example, you create a tabular section report to display open
purchase orders. You sequence the data on Address Number, Document Number, and 2nd Item Number. You
define all three fields as level break fields. The report displays the amount open for each 2nd Item Number for
each document for each supplier. If you modify the data sequencing to include only Address Number and
Document Number, and define only Document Number as a level break field, the report rolls up all the
information and displays the total amount open for each document number. The result is a summary of the
data included in the first report.

This diagram illustrates a tabular section level:
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Additional features in tabular sections include Drill Down, Account Level of Detail, and Automatic Totaling.
Drill Down provides a view to the associated interactive application from the viewable output of a report. The
interactive application displays the detail for the balances on the viewable output of the report.

The Automatic Totaling feature totals numeric values, regardless of the type, unless otherwise defined in data
dictionary. An example of a data item that does not total is Address Number. However, the system displays
the description of some numeric values in the Row Description column, and may try to total these fields. To
suppress the total for a column, access the properties for the column and select the Suppress at Totals option.

If you have a report that uses multiple sections or a combination of group and columnar sections, consider
using a tabular section instead. This improves system performance because instead of calling multiple
sections, the system calls only one section.

Attaching Logic to Joined Sections
If you need to include logic on joined sections, attach the logic to the Refresh Section event if the logic should
be processed every time the section is processed. When joined sections are processed, the system initializes the
Initialize Section event the first time the parent/child section is processed. The system then initializes the
Refresh Section event for all subsequent times the parent/child section is processed. Therefore, if you attach
logic to the Initialize Section event, the logic is processed only once. If you attach it to the Refresh Section
event, it is processed each time the section is processed.

208 PeopleSoft Proprietary and Confidential



Chapter 28 Understanding Report Processing

Data Selection and Sequencing
If the report or batch process contains multiple sections and takes a long time to process, check the data
selection for each section. The system processes all the records in a table unless you specify otherwise. If
you want a level-one section to adopt the data selection and sequencing from another section, you can use
the Use Data Sel/SeqFromASection system function. This system function uses the data selection and data
sequencing as defined in another section.

For example, in the Print Pick Slips program (R42520), you can select from hundreds of available columns in
the F4211 table to use in the data selection. In the first section, which is hidden and sends data to the F4211
table, the report processes commitments first, which could add rows to the F4211 table. The next section in
the report displays the modified and updated F4211 table showing the committed records. Possible solutions
are to use a temporary file or to change the data selection on multiple sections. In this case, use the Use
Data Sel/SeqFromASection system function to adopt the data selection and sequencing from the previous
level-one section.

The Use Data Sel/SeqFromASection system function enables a detail section to adopt the data sequencing
or data selection specifications from another section in the report or from an entirely different report. The
target section can adopt the data selection criteria, the data sequencing information, or both from the source
section. The selection or sequencing information from the source section replaces the information contained in
the specifications of the target section.

To use the Use Data Sel/SeqFromASection system function, access the event rules for the Initialize Section
event of the target section. The Initialize Section event is the only event that should invoke this system function.
Expand the General folder to locate and select the Use Data Sel/SeqFromASection system function. Define the
parameters to indicate the report, version, and section of the source data selection and data sequencing.

Custom Sections
Custom sections enable you to control, through event rules, the information that prints on a report. You can use
custom sections to force a page break by creating a section with no objects and then activating Page Break
After Print in the Section Properties. You can use custom sections to print variable text. Custom sections
can also be used for sections that present the same information but are formatted differently. For example, a
report that exists in two different modules but, depending on the user, calls a different section that displays
information specific to that particular module.

This diagram illustrates the process flow for custom sections called from event rules:
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Start next event

Processing flow of a custom section called from event rules

When you run the report, the batch engine calls and processes each section until it encounters the system
function call to the custom section. The batch engine then processes the custom section. When the batch
engine finishes processing the custom section, it continues processing the previous section.

You can call custom sections from any event except Initialize Section, Initialize Column, and Report Level
Events (Do Initialize Printer, Initialize Report, and End Report). If you try to call a custom section from one
of these events, the report writes a warning to the log and ignores the call to the custom section, continuing
with the main section.

The custom section processes in the same manner as the type of section it is (columnar, group, or tabular).
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Level Break Processing
Use level breaks to identify a change in a field’s data by comparing the current record to the previous record. A
level break occurs when there is a change between the records for the field defined as a level break. You can
use level breaks to organize the data of a large report into smaller, logical groups of data that are easier to
review. Typically, a descriptive header is displayed prior to the associated data. For example, you can group
address book records by search type. All records with the search type of E, for employees, are displayed
together with an appropriate heading. When the value in the search type field changes, a level break occurs and
a new grouping begins. Level breaks can be set up to initiate page breaks, totals, headers, and footers. Only
business view fields can be defined to be level break fields.

A single business view field can be attached to one level break header and one level break footer. If more than
one level break header or level break footer is attached to a business view field, the batch engine processes
only the first level break header or level break footer section and ignores the others.

This graphic illustrates level break logic processing:
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Before a level break section is processed, the batch engine issues the Init Break Section event. This event stops
processing for the current section and begins processing the level break footer section. After the level break
footer section has been processed, the batch engine processes the level break header, if defined in the report.

Level Break Section Events
When a report containing level break sections is processed, PeopleSoft EnterpriseOne automatically calls the
Init Lvl Brk Footer Section event or Init Lvl Brk Header Section event. You can attach event rules to these
events to control the flow of logic processed by the batch engine.

For example, if you want to create a report that summarizes information by company, you can design the report
to organize the data by company using a level break footer. You can define Company as a level break field and,
when the company changes, the batch engine calls the level break footer for the detail section.

Business function calls, table I/Os, or other logic can be attached to level break section events.

Init Lvl Brk Footer Section Event
A level break occurs when a new value for the level break field is encountered. Therefore, the new level break
value is in memory when the level break occurs. When the batch system calls the Init Lvl Brk Footer Section
event, the values for the previous level are accessed and are either summarized or totaled. For example, if you
have a level break footer defined to total revenue by company, the level break footer inserts the total below
all the associated records that have been processed for a specific company. The Init Lvl Brk Footer Section
event is attached to the level break footer section.

If you set up multiple level break footers within a report, the batch system processes the footers starting from
the lowest level up to the highest level in the report, as seen in the data sequencing dialog for the section in
Report Design Aid. For example, if you define two level break footers, one on business unit and one on
company, the aggregates for business unit process first and then the aggregates for the associated company.

When attaching logic to a level break footer, attach it to the End Lvl Brk Footer Section event rather than on
the End Section event.

Init Lvl Brk Header Section Event
The Init Lvl Brk Header Section event is called after a level finishes processing and the system has encountered
a new value for the level break field. It is also called after the Init Lvl Brk Footer Section event, if you have
one defined. The Init Lvl Brk Header Section event locates the header section associated with the previous
level and processes the information in the level break header.

For example, if you define a level break header and a level break footer in a report, the level break footer
processes before the level break header for the next level, which might contain records for another company.
The header section processes new records, or different data, from the previous section.

If multiple level break headers exist within a report section, the batch system processes the headers starting
from the highest level down to the lowest level in the report, as seen in the data sequencing dialog for the
section in Report Design Aid. For example, if you define two level break headers, one on business unit and
one on company, the company level break header processes first and then the business unit level break header.

End Lvl Brk Header and Footer Section Events
After the initialize level break events are processed, PeopleSoft EnterpriseOne processes the End Lvl Brk
Header Section and End Lvl Brk Footer Section events. These events end the level break process and return to
the detail section. You can attach logic to the End Lvl Brk Section event to call a custom section. For example,
you might want to print text, such as a disclaimer, after a level break footer. In this case, you can create a custom
section that contains the information you want to print and attach the custom section logic to the End Lvl Brk
Section event. When you process the report, the disclaimer displays below the level break footer section.
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Batch Events
As a batch application is processed, the runtime engine pauses at certain points to process logic. These points
are called events. You can use events to insert custom logic for processing. The basic flow of these events
within a section is Initialize Section, Do Section, and then End Section.

Some events are processed by the batch engine only if the appropriate section type exists. For example, Init
Report Header and End Report Header are initialized only if the report includes a report header section.
Likewise, Init Lvl Brk Footer and End Lvl Bk Footer are processed only if a level break footer exists.

This section discusses:

• Do Section event.
• Additional batch events.
• System functions within batch events.

Do Section Event
The Do Section event is invoked after the batch system has assigned new values to objects in the report and
immediately before processing objects within a section. In columnar and group sections, you most commonly
attach logic to the Do Section event. This is because the Do Section event occurs before any objects are
processed, and typically the logic you attach affects the objects in some way.

When the system processes the Do Section event in columnar sections, it processes the column headings first,
and then fetches the first record. For each object or column in the record, it processes the Init Object, Do
Object, and End Object events. After processing the last object, the system calls the After Last Object Printed
event and then fetches the next record and repeats the process. When all lines have been fetched from the
database, the system processes the End Section event. This basic process is the same for group sections.

If an object does not fit on the page, the engine invokes the Suspend Object event, which moves the object
to the next page.

If an object is a child section, such as in a subsection join, the system invokes the Initialize Section event
the first time the child section is processed. For any subsequent times that the child section is processed, the
engine invokes the Refresh Section event.

Additional Batch Events
In addition to the basic batch events, other events provide you with flexibility in the batch process. Other
levels of events include:

• Report Level.
• Section Level.
• Page Header Section Level.
• Page Footer Section Level.
• Report Header Section Level.
• Report Footer Section Level.
• Constant and Variable.

Report Level Events
This table describes the events that are available at the report level:
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Event Description

Do Initialize Printer Resolves and validates the printer name. This event is
called once per subsystem trigger. The printer can be set
using the Initialize Printer system function, which is only
valid on this event.

Initialize Report Resets global report variable and global event rule variable
values if the event contains no event rules in a subsystem;
preserves global variable values otherwise. The Initialize
Report event is executed only once per report and is always
the first event to be processed. If the report is a subsystem
report, the event rules on this event is executed once as the
subsystem begins and before any subsystem triggers are
processed.

End Report Executes once at the end of the report processing and is
always the last event to be processed. If the report is a
subsystem, the event rules on this event are executed only
after the system processes an End Subsystem trigger and
the subsystem is in the process of terminating.

Section Level Events
This table describes the events that are available at the section level:

Event Description

Advance Section Occurs each time you perform a fetch from the database.
Use this event if you need to perform processing on objects
before the fetch. If the section does not have a business
view attached, then this event is processed only once.

After Last Object Printed Occurs after a record is printed to an output file. Use this
event to process information after a record has been output.

Before Level Break Occurs before a level break is processed. Use this event to
perform processing after a fetch but before any level breaks
are checked.

Do Balance Auditor Valid only for tabular sections. Use this event for the drill
down feature.

Do Section Occurs after Advance Section, after values have been
assigned to print out to a printer or an output file. Occurs
before any information for the current record is written to
the PDF file and before Do Cell (if tabular cells exist), Do
Variable or Do Constant. In a tabular section, this event
processes after the level break.

Do Tabular Break Valid only for tabular sections. Occurs when the value
changes for a business view field defined as a level break.
Use this event to perform processing that requires a change
of values in any of the level break fields.
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Event Description

End Break Section Occurs after a level break finishes processing. Use this
event to perform processing immediately after a level
break.

End Lvl Brk Footer Section Occurs after a level break footer. Use this event to do
processing immediately after a level break footer.

End Lvl Brk Header Section Occurs after a level break header. Use this event to do
processing immediately after a level break header.

End Section Occurs after a batch process has completed processing the
last set of section values. Use this event to do processing
immediately after a section ends. This event is useful for
last record and end-of-file procedures.

Init Break Section Occurs after a level break begins processing. This event
initializes a child section that is joined to the parent section
on a level break.

Init Lvl Brk Footer Section Occurs before a level break footer. Use this event to do
processing immediately before a level break footer.

Init Lvl Brk Header Section Occurs before a level break header. Use this event to do
processing immediately before a level break header.

Initialize Section Occurs when a batch process encounters a section for the
first time. Use this event to do processing immediately
before a section begins. This event is useful for working
with global variables or performing other preparatory
procedures. For conditional sections, this event is
processed each time the section is called.

Refresh Section Occurs subsequent times a child section is processed. The
first time the batch engine encounters a child section, it
issues an initialize section event. Each subsequent time the
child section is processed, the batch process uses Refresh
Section. At this point, the internal structures and pointers
for the child section have been established and the batch
engine prepares to select a new group of records for the
child section. This logic also works for the level break
sections. Use this event to set the object values of level two
sections based on the parent section. You can also use this
event to reset or modify data selection and data sequencing
for the child section.

Suspend Section Occurs when an overflow page break (that is, information
exceeds the space available on the page). This event
temporarily stops the section processing. Use this event to
do processing when a page break occurs.

Page Header Section Level Events
This table describes the events that are available at the page header section level:
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Event Description

Initialize Page Header Occurs at the beginning of a report, after the report header
section and before the page header section processes for the
first time. It also processes every time a page break occurs.
Use this event to initialize values that cannot be set until
after the report header logic executes. This event is similar
to Init Section for a normal group, columnar, or tabular
section, except that it is processed only for a page header
section.

End Page Header Occurs after the page header finishes processing. Use this
event to do processing immediately after a page header.

Page Footer Section Level Events
This table describes the events that are available at the page footer section level:

Event Description

Initialize Page Footer Occurs at the beginning of the report, after the report header
and before the page header section processes for the first
time. Use this event to initialize values to be printed in the
current page footer section. These assignments typically
depend on information already processed on that page.

End Page Footer Occurs after the page footer finishes processing. Use this
event to do processing immediately after a page footer.

Report Header Section Level Events
This table describes the events that are available at the report header section level:

Event Description

Initialize Report Header Processes once at the very beginning of the report. Use
this event to initialize values at the beginning of a report.
This event is similar to Init Section for a normal group,
columnar, or tabular section, except that it processes only
for a report header section.

End Report Header Occurs after the report header processes. The report
processes the page header for a report next. Use this event
to do processing immediately after a report header.

Report Footer Section Level Events
This table describes the events that are available at the report footer section level:
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Event Description

Initialize Report Footer Occurs once at the end of a report, after everything else
processes and before the report footer prints. Use this event
to initialize values to print in the report footer.

End Report Footer Occurs after the report footer processes. After processing
completes, the report terminates. Use this event to do
processing immediately after a report footer.

Constant and Variable Events
This table describes the events that are available at constant and variable events:

Event Description

Do Column Heading Occurs when the column is initialized. Use this event
to populate the column heading based on event rules
associated with a business function.

Do Variable and Do Constant Occurs just before the font and color are selected and
before the value of the object is translated into a printable
string of characters and is output to the page. Use this event
to do processing after an object has been processed. This is
your last opportunity to manipulate the values or display
attributes of objects before output.

End Variable and End Constant Occurs immediately after an object is processed even if
the object is invisible or suppressed. Use this event to do
processing after an object is processed.

Initialize Variable and Initialize Constant Occurs before each report object or variable is processed.
Use this event to do processing before an object is
processed. This event is useful to do processing that affects
the position of an object because the object’s position on
the page has not yet been determined.

Suspend Object (constant) If an object requires multiple text strings or column
headings and if only part of the object fits on a page, then
the batch process issues a suspend object to halt processing
of the object until the next page has been started. Use this
event to modify the value at the page break. Because the
value of the object is already partially processed, this is not
a good time to manipulate that value.
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Event Description

Column Inclusion Valid only for tabular sections. Occurs after each record
is fetched from the database. Use this event to perform
calculations. Do not use the Column Inclusion event when
you are performing calculations between columns (such
as when calculating variance) or between variables within
a column.

Cell Inclusion Valid only for tabular sections. Occurs during Do Object
after processing calculations for a cell. Use this event to
manipulate cell data before displaying it. This event occurs
before Do Variable and Do Constant. This event occurs
during calculations. Additionally, you can attach criteria
to determine whether the currently fetched data should be
included in the cell calculation.

System Functions within Batch Events
System functions provide you with flexibility and control over how reports are processed. For example, you
can use system functions to hide and show objects, hide and show sections, and to generate messages.

This table describes the main categories of system functions available in batch applications:

Category Description

Object Use to perform actions such as hide and show objects.

Section Use to perform actions such as hide and show sections or
work with totals.

General Use to perform actions such as work with data selection and
data sequencing.

Messaging Use to perform actions such as send, update, or delete
messages.

Workflow Use to perform actions such as work with processes.

Transaction Processing Use to begin, commit, or roll back transactions.

Media Objects Use to work with media objects.

There are many system functions that are shipped with PeopleSoft EnterpriseOne. This table describes some
of the commonly used system functions located in the general folder:

System Function Description

Set Selection Append Flag and Set Sequence Append Flag Enables you to add, append, or overwrite data selection and
data sequencing for a section.
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System Function Description

Set User Selection and Set User Sequence Enables you to define data selection and data sequencing
for a section.

Stop Section Processing Stops processing for the current section and moves to
the next section. This system function is helpful for
performance, especially when there is a large amount of
event rule logic that remains to be performed. For example,
if no more customers exist with a credit limit over a certain
amount, the system stops processing that section and moves
to the next section.

Stop Section Processing differs from Suppress Section
Write. Suppress SectionWrite suppresses only the current
record, which causes the engine to process the next record
for the current section.

Hide Object For group and columnar sections, when you hide objects
using the Hide Object system function, the system still
prints a blank line even if the hidden object is the only
object on that line. The system has no way of knowing
whether there are any other objects on that line that need to
be printed. To keep the system from printing a blank line,
place the object in its own conditional section and suppress
the printing of the conditional section using the Hide Object
system function.
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Understanding Runtime Processing

This chapter discusses batch runtime processing.

Batch Runtime Processing
The term batch runtime processing refers to how events and their attached event rules are evaluated at runtime.

Runtime structures are blocks of memory that hold data as it is read, processed, and written to the database,
when required.

Report Design Aid provides several different field types and event rules that are associated with runtime
structures.

This section discusses:

• Available objects.
• Typical event flow for group sections.

Available Objects
Available objects are represented by a two-character, alphabetical code that characterizes the source of the data
and determines how the data is used in reports and batch processes at runtime.

During runtime processing, data is stored in memory in an internal data structure. Certain fields of the data
structure temporarily store data during runtime until it is no longer needed. Then data can be cleared to
process another record.

This table describes the available objects that are defined for batch processing:

Object Description

BC Columns included in the attached business view. These
columns are populated with values from the database
when a fetch is performed and are the values saved to the
database during an add or update.

PO Values passed from processing options. These values
are passed into the application when the batch version is
submitted. These processing option values are entered by
the user or defined in a particular version of an application.

VA Event rules variables that you create in event rules using
data items. They are not manipulated by the system.
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Object Description

SV System variables that represent environment variables that
are made accessible to event rules.

SL System values that represent constant system values that
have been made accessible to event rules.

TV Text variables that you create in Report Design Aid for use
in event rules.

RC Report constants. Includes column headings in columnar
sections and the constant portion of fields in group sections.

RV Report variables.

PC Previous business view columns.

PV Previous report variables.

Typical Event Flow for Group Sections
The runtime engine processes events in a specific order.

Initialize Section
This diagram illustrates the values that are held in the runtime structures after the Initialize Section event
processes for the group section of an Address Book report:

AN8 Address Number

ALPH Alpha Name

AN8

ALPH

RC BC

Runtime structure values after Initialize Section event

Advance Section
This diagram illustrates the values that are held in the runtime structures after these events process:

• Initialize Section
• Advance Section
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AN8 Address Number

ALPH Alpha Name

AN8

ALPH

RC BC

Runtime structure values after Advance Section event

Before Level Break
This graphic illustrates the values that are held in the runtime structures after these events process:

• Initialize Section
• Advance Section
• Before Level Break

AN8 Address Number

ALPH Alpha Name

AN8 1

ALPH
Financial/Distribution

Company

RC BC

Runtime structure values after Before Level Break event

Do Section
This diagram illustrates the values that are held in the runtime structures after these events process:

• Initialize Section
• Advance Section
• Before Level Break
• Do Section

AN8 Address Number

ALPH Alpha Name

AN8 1

ALPH
Financial/Distribution

Company

RC BC

Runtime structure values after Do Section event
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After Last Object Printed
These diagrams illustrates the values that are held in the runtime structures after these events process and
shows how the report appears:

• Initialize Section
• Advance Section
• Before Level Break
• Do Section
• After Last Object Printed

AN8 Address Number

ALPH Alpha Name

AN8 1

ALPH
Financial/Distribution

Company

RC BC

Report

Address Number 1
Alpha Name Financial/Distribution

Company

Runtime structure values after the After Last Object Printed event

Advance Section
These diagrams illustrate the values that are held in the runtime structures after these events process and
show how the report appears:

• Initialize Section
• Advance Section
• Before Level Break
• Do Section
• After Last Object Printed
• Advance Section
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AN8 Address Number

ALPH Alpha Name

AN8 1

ALPH
Financial/Distribution

Company

RC BC

Report

Address Number 1
Alpha Name Financial/Distribution

Company

Runtime structure values after Advance Section event

Before Level Break
These diagrams illustrate the values that are held in the runtime structures after these events process and
show how the report appears:

• Initialize Section
• Advance Section
• Before Level Break
• Do Section
• After Last Object Printed
• Advance Section
• Before Level Break
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Runtime structure values after Before Level Break event

Do Section
These diagrams illustrate the values that are held in the runtime structures after these events process and
show how the report appears:

• Initialize Section
• Advance Section
• Before Level Break
• Do Section
• After Last Object Printed
• Advance Section
• Before Level Break
• Do Section
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Runtime structure values after Do Section event

After Last Object Printed
These diagrams illustrate the values that are held in the runtime structures after these events process and
show how the report appears:

• Initialize Section
• Advance Section
• Before Level Break
• Do Section
• After Last Object Printed
• Advance Section
• Before Level Break
• Do Section
• After Last Object Printed
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Runtime structure values after the After Last Object Printed event

Advance Section
These diagrams illustrate the values that are held in the runtime structures after these events process and
show how the report appears:

• Initialize Section
• Advance Section
• Before Level Break
• Do Section
• After Last Object Printed
• Advance Section
• Before Level Break
• Do Section
• After Last Object Printed
• Advance Section
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CHAPTER 30

Defining Batch Error Messages

This chapter provides an overview of batch error messaging and discusses how to set up batch error messages.

Understanding Batch Error Messaging
The PeopleSoft EnterpriseOne error message system provides a consistent interface to review batch application
errors. You can set up batch applications to send messages to users when processing is complete. These
messages include the success or failure of the batch job and the notification that information that was
incorrectly entered into the system. To enhance the usability of the messages, the system uses a tree structure
(or parent/child structure) to group related messages.

You can create two types of error messages for batch applications: non-text substituted and text substituted. A
non-text substituted error message provides a high-level indication that an error exists in the batch application
(for example Document number is invalid).

You can use text substitution messages to provide additional information regarding errors. For example,
rather than the Document number is invalid error message, the message can instead state Document number
55.5555 is invalid.

You can also include a link to the associated interactive application in the message. This type of message
is referred to as an active error message. The user can open the associated interactive application from
the link that is attached to the message.

Error messages appear in the Work Center after the batch job has completed. When you create custom batch
error messages, you need to determine the information that PeopleSoft EnterpriseOne users require. For
example, you might create a number of different messages that are generated when you run a journal entry
report. You can create a message stating that the report completed successfully when the report data is in
balance. Additionally, you can create multiple levels of messages that describe various errors if the report
is out of balance. The first level might state that the report completed with errors while additional levels
would explain the specific details regarding the errors.

Setting Up Batch Error Messages
This section provides overviews of level break messages, level break message components, and work center
APIs, provides sample source code, lists the prerequisites, and discusses how to:

• Create data items for level break messages.
• Create business function data structures.
• Create level break message business functions.
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• Call the work center initialization API.
• Call the processing work center APIs.

Understanding Level Break Messages
Level break messages act as containers to present error messages for each level break field that is defined in
the batch application. Level break messages are informational, they are not error messages. They can be action
messagesthat contain a shortcut to an application and require action on the part of the user. They can also be
messages that require no action, but might include instructions for the user to review information.

Level break messages are text-substituted messages. You can define them at many different levels such as
level one, level two, level three, and so on.

The level one level break message appears when you first launch work center. Additional levels appear beneath
this level. This level of message provides high-level information (for example, Job completed with errors).

The level two level break message appears when you expand the level one message. Additional levels can
appear beneath this level. This level of message provides more detail (for example, Batch 3230 has errors).

The level three level break message appears when you expand the level two message. Additional levels can
appear beneath this level. This level of message provides additional detail (for example, Voucher 14787
contains errors).

How Level Break Messages Work
Level break and action messages group errors. Level break messages include two distinct components. The
first component is the actual text of the message. The second component indicates whether the message is an
action message. All level break messages include the text component, but not all messages are defined as
action messages.

The Work Center API creates and manages the Job Completed level break message. You must create all other
messages. Level break messages organize messages that you set up to communicate information about the
batch, document, and line in which the error occurred. You set these messages using the jdeSetGBRError or
the jdeSetGBRErrorSubText functions.

Level break message Job R89004 ZJDE0001.c is a level-one message that the system generates automatically.
Level break message Batch 3230 is in Error is a level-two message. AA 20050606 3031 and Intercompany Out
of Balance are actual error messages.

The Work Center API must be called for every level break message.

These topics illustrate how messages might appear when an out-of-balance journal entry upload has completed.

First-Level Messages
First-level messages appear when users open their personal in-basket. A plus symbol next to the message
indicates that additional levels of messages exist. First-level messages might show the name of the batch job,
explain that it completed with errors, and instruct the user to review the details about the errors.

Second-Level Messages
Users can view second-level messages when they expand the first-level message. For example, the
second-level message might inform users that they need to review a specific batch number.
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Third-Level Messages
Third-level messages display when the user expands the second-level message. For example, the third-level
message might inform the user that the batch job completed with errors because it was out of balance, and then
provides solutions to resolve the issue.

Text Substituted Messages
Error messages must be informative to be beneficial. You can increase their effectiveness through text
substitution. Text substitution enables you to define variable text (such as dates, amounts, and so on) for the
system to embed into the message at runtime. You set up text substitution messages in the data dictionary,
which helps to ensure consistency of jargon and terminology. For example, in the message Voucher Batch &1
Contains Errors, the system uses &1 as a parameter to the message. The system substitutes &1 at runtime and
stores the rest of the information from the message in the data dictionary glossary. The glossary describes
the error message as it is defined in the data dictionary. When you open the message in data dictionary, you
can review the item glossary.

Action Messages
After users review a an error message and determine the resolution, they typically need to access an application
to resolve the error. You can set up specific level break messages, which are known as action messages,
to provide direct access to the associated application directly from Work Center. Action messages call a
PeopleSoft EnterpriseOne application and pass required variables to that application. For example, users can
click the shortcut to automatically access the Voucher Revision form from within the error message. The
application presents the appropriate form and displays the record in error. You determine the appropriate
application and the correct values that need to pass to that application when you create the message. The
system highlights action messages in the grid to differentiate them from non-action messages.

Work Center APIs
When you call a work center API, the system assumes a child/parent order. In other words, when the API is
called, it assumes that any error that is in the runtime error message stack belongs to the level that is associated
with that instance of the API call. This means that all of the errors in the error space at that time, whether they
are set using business functions or event rules, are packaged or grouped together as children of the level that
was passed to the work center API. These error messages are then cleared from the error space so that the
system can create the next group of messages based on a new set of records.

The timing of the calls to the work center API is critical. The reporting program typically starts by editing
the header-level record, which leads to a set of detail records. The detail records are the first to be read and
processed. Thus, the calls to the work center API typically sends level break numbers in descending level
break order.

For example, the actual series of level break calls to the API might appear as 4,4,4,3,4,4,3,2,4,4,3,2,1. This
series indicates that the call structure started four levels down. The first call at level 4 allows the work center
API to find any messages that occurred at that time and creates child messages using the level 4 message as the
parent. If no errors occurred, then no messages are created. This call sequence example illustrates that the
API was called at level 3 after three calls to level 4. When the call to level 3 is made, the work center API
remembers if any level 4 messages were written. In other words, if no errors occurred when any of the level 4
calls were made, then the work center API does not create the level 3 messages. If even one error existed at
any of the level 4 calls, the level 3 and the level 2 messages are created.

You must call the work center API at every level. Because the work center error messages are created based
on a parent/child structure, if a level call is skipped, then the API has no way to group the child messages
and child levels that are already created.

For example, this level call structure is valid: 6, 6, 5, 4, 3, 4, 4, 3, 2, 1. Conversely, the call sequence 6, 6, 4, 3,
4, 4, 3, 2, 1 is invalid because after level 6 is called, there is no corresponding call to level 5.
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The work center API must be called using level 1 when the reporting job is about to complete. Hence, level 1
is the parent to all errors and level break messages. It issues the job completed message. The level 1 call to
the work center API is essential because it ensures that no orphan work center records are created and it also
cleans up all allocated storage used by the work center system. The level 1 call to the API should occur only
once in the report, typically in the End Section event of the primary section of the report.

Understanding Level Break Message Components
Error messages and level break messages are considered glossary data items. Level break messages act as a
container for error messages. You can create level break messages that are action messages or non-action
messages.

You create level break messages in a project in Object Management Workbench by creating:

• Data dictionary items.
• Text substituted data structures.
• Business function data structures
• Business functions.

Data Dictionary Items
The data dictionary item defines the text portion of the level break message as it appears in the work center.
Before you create a data dictionary item, you should review the level break messages to determine if an
existing level break message meets your business needs.

Define a level break message data item as a glossary data item. The alias that you enter for the data dictionary
item is a unique identifier and cannot be changed once the data item is saved. It is recommended that the
alias begins with LM. Level break messages are not error messages; they are defined as glossary group Y,
PPAT Level Messages.

This description of the level break message data item displays in the work center. If this is a text-substituted
message, enter the description using ampersands and sequential numbers to hold positions for substituted
variables. For example, Batch &1 is out of balance by &2. The system replaces &1 with the actual batch
number while the system replaces &2 with the amount that the batch is out of balance.

All message data items must include a cause and resolution. Begin by entering the text Cause: and then enter
the cause of the message. Then, under the cause, enter the text Resolution: and then enter how the user should
resolve the issue For text-substituted messages, enter the description in the text area just above the cause.

Text Substituted Data Structures
The data structure for a text substituted error message must include the data items that are required for the text
substitution. For example, a level break message describing a batch number that is out of balance by a specific
amount uses a data structure that includes data items ICU (Batch Number) and AA (Amount).

The name of the data structure should include the same unique number that was used for the associated data
dictionary glossary item. This number is to be appended to the prefix DELM. For example, a data structure
created for level break message LM5509 is named DLM5509.

You must create a type definition (typedef) to include the data structure in the associated business function.
The typedef adds code to the C business function so that the business function can use the data structure.
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Business Function Data Structures
Level break message business functions require several standard parameters in addition to the variables that
are used for the text substitution. You must include in this data structure all of the required data items to
ensure that the system generates the error message successfully. For the system to return the correct batch
number and the amount that it is out of balance, the data structure in the business function must include the
document number, document type, document company, batch number, batch type, and document pay item.
Two additional data items are required in this data structure:

• J.D. EnterpriseOne Event Point.
Required to determine if the message is an action message.

• Generic Long.
Required to control work center messaging.

The name of this data structure should include the same unique number that was used for the associated data
dictionary glossary item. This number is to be appended to the prefix DLM. For example, you should name a
business function data structure that was created for level break message LM5509 as DLM5509.

You must have a business function for each level break message. Do not confuse this data structure with the
text substituted data structure the system created for the data dictionary item. The difference between the two
is that the data structure for the business function moves data variables to the level break function. The data
structure for the data dictionary items stores data that is mapped to the text substituted variables.

Include these items in the business function data structure:

• All data items that are required for the level break text substitution message.
• All data items that are required for the message to be active (that is, any variables that are required to load
the form for the appropriate application).

• Data item EV01.
Change the variable name from cEverestEventPoint01 to cIncludeInterconnect. This parameter is a flag that
determines if the message is active. This parameter should be included as a parameter in all level break
messages, even if the original intent is not to call an application. You must enter a 1 in the data structure
value to launch an application.

• Data item GENLNG. Change the variable name from idGenericLong to idGenlong. Use this parameter to
control all work center messaging. This data item is intended for use as a work field for the system.

Business Functions
After you have created the business function data structure, you can create the business function. The business
function processes the level break errors and performs all of the mappings for the active message.

The name of the business function should include the same unique number that was used for the associated
data dictionary glossary item and the data structures. This number is to be appended to the prefix BLM. For
example, you should name a business function that you create for level break message LM5509 as BLM5509.

You must attach the business function data structure to the business function prior to entering code. Then,
when you create the business function, you can select to have the system create a skeleton for you. The last
message that you receive reminds you to create a typedef of the business function data structure and paste it
into the header file of the business function.

After you create the business function, you must build it and check it in to central objects.
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Sample Source Code
This sample of the shell source code illustrates the information required in a level break message business
function and its location in the .c file.

You need to manually map fields from the business functions data structure to the dsTextData data
structure; this is the data structure that is used for the text substitution in the level break message. You also
need to manually map fields from the business function data structure to the dsFormData data structure; this
is the data structure that is used for the active message.

Variable Declarations
These lines declare the level break message variables:

/*********************************************************

* Variable declarations

********************************************************/

JCHAR szForm[11]; /* Name of form in application */

JCAHR szDDitem[11]; /* Data dictionary name of the level message */

JCHAR szDLLName[11];/* Name of the application DLL */

JCHAR szDsTmpl[11]; /* Name of the text substitution data structure */

Declare Structures
Enter your own code for the appropriate text substitution data structure and application form. These examples
are from an existing business function:

/************************************************************

* Declare structures

************************************************************/

DSDELM0002 dsTextData;/* Instance of text substitution structure */

FORMDSW0411Z1D dsFormData;/* Instance of form interconnect structure */

Set Pointers
These lines ensure that the level break message functions:

/********************************************************************

* Set pointers

********************************************************************/

if (lpDS->idGenLong == (ID) 0)

{

jdeSetGBRError (lpBhvrCom,lpVoid,(ID)0,_J("4363"));

if(hUser)

{

JDB_FreeBhvr(hUser);

}

return ER_ERROR;

}

else

lpDSwork = (LPDS_B0100011A) jdeRetrieveDataPtr(hUser,lpDS->idGenLong);
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Main Processing
Enter your own code for the appropriate text substitution data structure and glossary data item. These examples
are from an existing business function:

jdeStrcpy((JCHAR*)szDsTmpl,)const JCHAR*)(_J("DELM0002)),DIM(szDsTmpl)-1);

jdeStrcpy(szDDitem,(const JCHAR *)(_J("LM0002")),DIM(szDDitem));

memset((void *)(&dsTextData),(int)(_J(\0’)),sizeof(dsTextData));

Assign Values from lpDS Data Structure to dsTextData Here
Enter your own code for the data items that are included in the business function data structure. When you
assign values, you map the business function data structure items to the text substitution data structure items.
These examples are from an existing business function:

jdeStrncpy(dsTextData.szEdiuserid,(const JCHAR *)(lpDs->szEdiuserid),

DIM (dsTextData.szEdiuserid));

jdeStrncpy(dsTextData.szEdibatchnumber,(const JCHAR *)

(lpDS->szEdibatchnumber),

DIM(dsTextData.szEdibatchnumber));

jdeStrncpy(dsTextData.szEditransactnumber,(const JCHAR *)

(lpDS->szEditransactnumber),

DIM(dsTextData.szEditransactnumber));

The first parameter is the location to where the value is being copied. The second value is the location from
where the value is copied In this example,dsTextData.szEditransactnumber is located in the
text substitution data structure and pDS->szEditransactnumber is located in the business function
data structure.

Note. Be conscientious of the APIs that you use for these statements. The APIs are based on the data type
of the associated data items. MathCopy is used for math numeric fields, assignments are used for character
fields, Strncpy is used for strings, and Memcpy is used for dates. If you use Memcpy for dates, the system
assigns the characters directly.

The remaining lines in this section ensure that the level break message is functional:
if (lpDSwork->lpBlob->lpTSDSMPL != (LPDSTMPL)NULL)

{

lpDSwork->

lpBlob->lpTSTEXT=(PJSTR)AllocBuildStrFromDstmplName((LPDSTMPL)

lpDSwork->lpBlob->lpTSDSMPL,(JCHAR*)szDsTmpl,

(LPVOID)&dsTextData);

jdeStrncpy (lpDSwork->lpBlob->szDDItem, (const JCHAR *)(szDDitem),

DIM(lpDSwork->lpBlob->szDDItem));

}

if(lpDS->cIncludeInterconnect == _J(’1’))

Form Interconnect Processing
Enter your own code for the appropriate application and form to be linked to the message. This example
is from an existing business function:

jdeStrncpy(szDLLName,(const JCHAR *)(_J("P0411Z1")),DIM(szDLLName));

memset((void *)(&dsFormData),(int)(_J’\0)),sizeof(dsFormData));

memset((void *)(szForm),(int)(_J(\0’)),sizeof(szForm));
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jdeStrncpy((JCHAR *)szForm,(const JCHAR *)(_J("W0411Z1D")),DIM(szForm) - 1);

Assign Values from LpDS Data Structure to dsFormData
Enter your own code for the appropriate application form. This example is from an existing business function
and illustrates how to pass information from the business function data structure to the form data structure:

jdeStrncpy(dsFormData.EDUS,(const JCHAR *)(lpDS->szEdiuserid),

DIM(dsFormData.EDUS));

jdeStrncpy(dsFormData.EDBT,(const JCHAR *)(lpDS->szEdibatchnumber),

DIM(dsFormData.EDBT));

jdeStrncpy(dsFormData.EDTN,(const JCHAR *)(lpDS->szEditransactnumber),

DIM(dsFormData.EDTN));

ParseNumericString(&dsFormData.EDLN,_J("1.0"));

dsFormData.EV01=_J(1’);

Note. Be conscientious of the APIs you use for these statements. The APIs are based on the data type of the
associated data items. MathCopy is used for math numeric fields, assignments are used for character fields,
Strncpy is used for strings, and Memcpy is used for dates. If you use Memcpy for dates, the system assigns
the characters directly.

Get the Form Data Structure ID from the SVRDTL Table
These lines ensure that the level break message is functional:

If (JDESPECRESULT_PASSED==jdeSpecOpenLocalIndexed(&hTam,hUser,

JDESPECTYPE_SVRDTL,SPECKEY2_SVRDTL))

{

jdeStrncpy((JCHAR *)lpDSwork->lpBlob->szForm,(const JCHAR *)(szForm),

DIM (lpDSwork->lpBlob->szForm)-1);

JdeStrncpy(Key.szForm,szForm,DIM(Key.szForm));

ASVRDtlData.DataType=JDESPECDATA_RAWBLOB;

JdeSpecFetchSingle(hTam,&ASVRDtlData,&Key,1);

If(ASVRDtlData.pSpecData !=(void *)NULL)

{

lpASVRdtl=ASVRDtlData.pSpecData;

JDBRS_GetSTMPLSpecs(hUser,(JCHAR*)lpASVRdtl->szFITemplateName,

&lpDSwork->lpBlob->lpFIDSMPL);

if(lpDSwork->lpBlob->lpFIDSMPL !=(LPDSTMPL)NULL)

{

lpDSwork->lpBlob->lpFITEXT=(PJSTR)AllocBuildStrFromDstmplName

(LPDSTMPL)

lpDSwork->lpBlob->lpFIDSMPL,(JCHAR*)lpASVRdtl->szFITemplateName,

(LPVOID)&dsFormData);

jdeStrncpy(lpDSwork->lpBlob->szDLLName,(const JCHAR *)(szDLLName),

DIM(lpDSwork->lpBlob->szDLLName));

}

jdeSpecFreeData(&ASVRDtlData);

}

jdeSpecClose(hTam);

}
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Function Clean Up
These lines ensure that the level break message is functional:

if(hUser)

{

JDB_FreeBhvr(hUser);

}

return (ER_SUCCESS); }

Understanding Work Center APIs
In the batch application, you must use APIs in event rules to initialize the work center, identify the level break
points, and terminate the batch message process.

Calling the Work Center Initialization APIs
In the batch application, you initialize the work center API in event rules, typically using the initialize section
event of the primary section.

Calling the Processing Work Center API
After the work center system has been initialized, you must determine the various level break points within the
report and call the work center system at each of these points to group the errors.

cAllowUserIdToChange Parameter
The cAllowUserIdToChange parameter on the initialize API works in combination with the szUserid parameter
on the ProcessErrorsToPPAT API. The cAllowUserIdToChange parameter enables you to set up the batch
application to send errors to the user who created the original records and not to the person who submitted
the job (such as the night operator). For example, if a single batch job contains 1,000 transactions that were
created by 50 users, then only those users who created transactions with errors receive error messages. The
night operator still receives a message, but it is a message such as Job completed normally or Job completed
normally with errors. Other users whose transactions contained no errors do not receive error messages.

To set up this functionality, you need to enter a 1 in the cAllowUserIDToChange parameter when you initialize
the batch error processing system. When you process the level 2 level break message and then call the
ProcessErrorstoPPAT API, you can still specify who receives the messages by using the szUserid parameter.
You can determine who should receive the message by reviewing the transaction record.

Terminating the Work Center Process
You must terminate the work center process before the batch job is finished and after all messages have been
sent to Work Center. When the batch program is about to terminate, call the work center error message
business function, ProcessErrorsToPPAT one last time, which will send it to level 1. (Level 1 indicates
the level of totaling is equal to 1 and that it is completed.) The system creates the job-completed message
and frees any workspace that the work center API created. This API is typically called on the End Section
event of the primary section.

Every report design that uses the work center API to process errors must call the API at the end of processing
using a 1 in the level of totaling field. This call should also be done by jobs that are monitoring for critical
errors and that need to terminate early.

When the system has finished processing the report, it creates work center messages, which can then be
reviewed in the Work Center. Batch errors are processed to the JDEM system. The system sends messages to
the user who runs the report unless you specify that the messages be sent to other users.
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If the system encounters no errors, the API sends a message to Work Center indicating that the job completed
successfully.

Prerequisites
Before you begin setting up batch error messages, ensure that you:

• Create a batch application object.

• Complete the design of the report template so that you can define batch error messages.

Creating Data Items for Level Break Messages
Access Object Management Workbench.

1. Add a data item to the project in which you want to include the level break message.
2. On the Data Dictionary Item Type form, select Yes to create a glossary data item.
3. On the Glossary Items form, enter the alias of the level break message in the Alias field.
4. Click the visual assist in the Glossary Group field and select glossary group Y.
5. In the Product Code field, enter a product code in the 55–59 range, which is reserved for clients.
6. In the Product Code Reporting field, enter a product code that represents the product in which the level
break message will be used.

7. In the Description field, enter a meaningful description.
If this is a text-substituted message, enter the description using ampersands and sequential numbers to
hold positions for substituted variables.

8. Click the visual assist in the Error Level field and select 2.
9. Select the Item Glossary tab and enter a cause and resolution in the text area.
10. Save the glossary data item.

Creating Business Function Data Structures
Access the appropriate project in Object Management Workbench.

1. Add a data structure to the same project in which you added the other level break message components.
2. Select the Design Tools tab and click Data Structure Design.
3. On the Data Structure:Level break message form, enter the alias of the required data item on the Dictionary
Items Alias field.

4. Double-click the data item to include it in the data structure.
You can also drag the data item to the Structure Members list.

5. Enter EV01 in the Alias field and include it in the data structure.
6. Change the structure member name of the cEverestEventPoint01 data item to cIncludeInterconnect.
7. Enter GENLNG in the Alias field and include it in the data structure.
8. Change the structure member name of the idGenericLong data item to idGenlong.
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Creating Level Break Message Business Functions
Access the appropriate project in Object Management Workbench.

1. Add a business function to the same project in which you added the other level break message components.
2. Select the Design Tools tab and click Start Business Function Design Aid.
3. On the Business Function Design form, click the visual assist in the Parent DLL field and select the DLL
that your company uses for creating custom business functions.
The system uses this DLL for building the business function.

4. In the grid, enter a unique name in the Function Name field.
This name cannot include any spaces and should be descriptive of the business function purpose.

5. Enter a description in the Description field.
This description can be the same as the name, however, you can use spaces in the description.

6. Tab through the remaining fields.
The system populates the F3 Code field with a 3 (Minor Business Rule).

7. Modify the F3 Code if appropriate.
8. Click the row header to highlight the row of data that you just entered, and select Parameters from the
Row menu.

9. Use the QBE line to locate the associated data structure, click the data structure, and then click Select.
This process attaches the business function data structure that was created for the level break message to
the business function.

10. On the Business Function Design form, verify that the name of the appropriate data structure appears in
the Template Name field in the grid.

11. From the Form menu, select Create to begin the creation of the business function.
12. Click Yes to answer the question Functions Not Found: Would you like skeletons created?
13. Click Yes to answer the question Function Prototypes Not Found: Would you like them to be created? and
click OK.
The last message that appears reminds you to create a TYPEDEF for the data structure.

14. On the Business Function Design form, click the row header to highlight the row and select Typedef
from the Row menu.
On the status bar, the message Your typedef is in the clipboard appears. This process creates the TYPEDEF
for the data structure attached to the business function.

15. From the Form menu, select Edit.
The system launches Microsoft Visual C ++.

16. From the Window menu, select to work with the .h file.
You can also select the .h file using the tabs.

17. Locate the DS Template Type Definitions section of the .h file and just below the heading, paste the
TYPEDEF using CTRL V.
This process copies the TYPEDEF for the data structure that is attached to the business function.

18. Save the business function and minimize Microsoft Visual C ++.
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19. On the Business Function Design form, save the business function.
If you are not using a test substituted error message, skip to step 23.

20. Return to Object Management Workbench and locate the level break message data structure for the text
substitution, enter design, select the Design Tools tab, and click Create a type definition.
On the status bar, the message Your typedef is in the clipboard appears.

21. Return to Microsoft Visual C ++, locate the Structure Definitions section of the .h file and just below the
heading, paste the TYPEDEF using CTRL V, and return to Object Management Workbench.
This process copies the TYPEDEF for the text substitution data structure into the business function.

22. Return to Object Management Workbench and add the associated application to the project, enter design,
select the Design Tools tab, click Start Form Design Aid, select the form to be launched, and select
Application Properties from the File menu.
If a link to an associated application is not required in the message, skip to step 26.

23. On the Application Properties form, select the Operations tab, click Generate Form Data Structures, and
in Notepad, highlight the entire form data structure for the appropriate form and copy the section using
CTRL C.

24. Return to Microsoft Visual C ++, locate the Structure Definitions section of the .h file and just below
the heading, paste the TYPEDEF using CTRL V.
This TYPEDEF resides above the TYPEDEF that was pasted from the level break message data structure
for the text substitution.

25. Locate the External Business Function Header Inclusions section of the .h file and enter a call to the
business function to process the message to work center.
Begin the call with #include (for example #include<B0100011.h >).

26. From the Window menu, select the .c file.
You can also select the .c file using the tabs.

27. Enter the appropriate code in the .c file as described in the Sample Source Code Highlights section below.
28. When the business function is complete, save the business function, and click Build Business Function
from the Design Tools tab.

Calling the Work Center Initialization API
Open a report in which you want to add batch error messaging in Report Design Aid.

1. Create a report scope event rule variable in Event Rules Design using data dictionary item GENLNG.

2. Call a Business Function and use the QBE line to select the work center initialization business function
B0100025 with a description of F01131 Edit JDEM Error Message.

Generally, this business function is called in the primary section of the report using the Initialize Section
event.

3. Refer to the Windows Help file of APIs to identify the appropriate parameters to pass.

Calling the Processing Work Center APIs
Access Report Design Aid for a report in which you want to add batch error messaging.

1. Define all appropriate level breaks for the report.
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You need to analyze the events that logically group all errors. This typically happens at events in which
all editing has been completed for a group of records or immediately after all editing for an individual
record has occurred.

2. For each level break established, call the business function for the level break message at the appropriate
level break.
The business function for the level break message should relate to the type of error grouping that you want
to capture at the particular level break. For example, SetLevel_SFVoucher groups errors that are related at
the voucher level break. For reports, this business function is typically called in the Do Section event. If
the interconnect is blank, then it is not calling an action message.

3. Call the Work Center error message business function immediately after the call to the level break message.
This name of this business function is B0100011 and the description is Process batch errors to JDEM
system.

4. Refer to the Windows Help file of APIs to identify the appropriate parameters to pass.
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CHAPTER 31

Working with Report Interconnects

This chapter provides an overview of report interconnects and discusses how to define report interconnects.

Understanding Report Interconnects
You can use report interconnects to launch a batch application or report from another batch application
or interactive application. How the batch application processes information is dependent upon whether
asynchronous processing is enabled. Synchronous is the default processing method. If you select synchronous
processing of the report interconnect, the initiating process waits until the batch application has completed
before it continues running the original application. If you select asynchronous processing, the initiating
process starts another process and continues to run the original application. The two processes run separately.

Defining Report Interconnects
This section provides an overview of report interconnects in batch applications, lists the prerequisites, and
discusses how to create report interconnects.

Understanding Report Interconnects in Batch Applications
You can use report interconnects in a batch application to automatically run another batch application when
certain criteria is met. You can use a report data structure along with the report interconnect to pass values
between the batch applications.

The report interconnection is defined in the primary batch application, which is the batch application that
calls the second batch application. Use the After Last Object Printed event if you want the secondary batch
application to process after the primary batch application is complete.

As part of the report interconnection, you must map parameters. These parameters associate data from the
primary batch application with data in the secondary batch application. As part of the parameter mapping, you
must also indicate the direction that the data should flow.

The data structure is defined in the secondary batch application, which is the batch application that the primary
batch application calls. This secondary batch application might not have a business view attached, but receives
data from the primary batch application based on the criteria you define. You select data items to include in the
data structure and then assign these fields to the data items included in the secondary batch application.

Report interconnects are beneficial when the secondary batch application provides further detail for the
records included in the primary batch application or when different data in the primary batch application are
required but different audiences.
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When the user runs the primary batch application, when the stated criteria is met, the system processes the
secondary batch application automatically.

Prerequisites
Before you begin creating report interconnects, ensure that you:

• Create two batch application objects.

• Complete the design of the first report template to serve as the primary batch application.

• Complete the design of the second report template to be called by the primary batch application and include
a report data structure.

Creating Report Interconnects
Open the primary report template in Report Design Aid.

1. From the detail section of the report, access Event Rules Design and select an event.
2. Click the Report Interconnection option on the toolbar.
3. On the Work with Applications form, select the batch application to which you are connecting.
4. On the Work with Versions form, select the appropriate version of the batch application to which you
want to connect.

5. In the Available Objects column, select the object that you want to pass and move it to the Data
Structure-Value Column.

6. Indicate the direction of data flow between Value and Data Items.
7. To run the report as a separate process, click the Asynchronously option.
8. To include the report interconnect for transaction processing, click the Include in Transaction option.
9. Click one of these buttons to add notes and then click OK:
• Structure Notes
• Parameter Notes
Event Rules Design displays the Report Interconnection with the Call (UBE <name> Version <name>)
statement.
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Creating Smart Fields

This chapter provides an overview of smart fields and discusses how to create custom smart fields.

Understanding Smart Fields
Smart fields are data dictionary items with attached business functions. Business functions require a data
structure to pass values. Smart field data structures include a named mapping that maps the source for each
parameter of the data structure. This simplifies the use of business functions because the parameters to pass are
held by the system. Instead of needing to know which business function to use and what parameters to pass,
the user selects a smart field that inherently includes this information. Smart fields can be used for deriving
column headings or populating values in a report section using Report Design Aid.

Smart fields are reusable objects that simplify the use of business functions in event rules. They are created in
data dictionary and are defined as glossary group K. The attached business function performs a specific task
for the smart field, such as a calculation.

For example, you can create a smart field to calculate sales for period 1, period 2, and period 3 to populate
sales for the first quarter in a report. This calculation is performed by the business function for each row of
data that is fetched by the report. Every time you use this smart field, it performs this calculation.

Without the quarterly smart field, you need to write an event rule to accumulate the three periods to populate the
quarterly sales column. To display a total for each quarter, you need to write four event rules. Additionally, to
display quarterly sales totals in multiple reports, you need to duplicate these event rules in each report template.

Smart fields can be used in columnar, group, and tabular sections. You must define a column heading and data
selection for each smart field column.

Before smart fields can be used in a report, you must add it to a smart field template and create a Report
Director template. Smart field templates organize smart fields that use the same fields for data selection.
For example, existing PeopleSoft EnterpriseOne smart field templates are organized by Financial Reports,
Fixed Assets, and 52-Period Accounting.

You attach the smart field template to the Report Director template. In the Report Director template you define
report processing options, business views, additional properties and the drill down feature. Information that is
included in the Report Director template guides the report developer through the process of creating a report
template using the associated smart fields. The smart field template and Report Director template enable you
to organize and present the smart fields in Report Design Aid.

This topic demonstrates how to create:

• Smart fields.
• Smart field templates.
• Report Director templates.
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• New reports using smart fields.

Creating Custom Smart Fields
This section provides an overview of smart field components and discusses how to:

• Create data dictionary items.

• Create data structures.

• Define named mappings.

• Perform calculations using named event rules.

• Create data dictionary smart field items.

• Create smart field templates.

• Create Report Director templates.

• Design reports using custom smart fields.

Understanding Smart Field Components
Smart fields are complex data items because they include business function logic. However, once the smart
field is created, you do not have to recreate frequently used logic

The basic components of a smart field are:

• Data dictionary items.
This data dictionary item is a standard data item that is defined as glossary group D.

• Data structures.
• Named mappings.
• Business functions.
Can use a C business function or a named event rule business function.

• Smart field data items.
• Smart field template.
• Report Director template.

Data Dictionary Items
The first component of most smart fields is a data dictionary item that serves as a user prompt for the report
developer. The prompt indicates how the logic should be processed if more than one option is possible. For
example, a quarterly sales smart field requires input from the report developer to indicate which quarter to
calculate. There are at least four options possible, one for each quarter, and each option results in a different
outcome. However, not all smart fields require a user prompt. A smart field used to concatenate two fields
does not require input as there are no decision points.
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The Report Director displays a Smart Field Parameters form to prompt the report developer. The description
of the prompt displays on this form (for example, Quarter to Display). The glossary that you enter when
creating the data item also appears on this form. The glossary explains the purpose of the data item and
assists the report developer in determining the appropriate value to enter in the prompt (for example, Enter
1 to print first quarter sales, Enter 2 to print second quarter sales, Enter 3 to print third quarter sales, and
Enter 4 to print fourth quarter sales).

Data dictionary items include a name, an alias, and a description. The data item name can be a maximum of 40
characters and cannot include spaces. The alias is a unique alphanumeric identifier. The software allows the
alias to be a maximum of 10 characters. However, not all databases support 10 characters so it is recommended
to limit the alias to eight characters. The description can be a maximum of 40 characters, including spaces.
The description is often the same as the name only with the spaces included.

See PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Data Dictionary.

Data Structures
The second component that is required for a smart field is a data structure. Data structures are a list of
parameters that pass values between the report and the database tables. You must include all of the data items
in the data structure that are required to complete the function of the smart field. For example, a quarterly
amount smart field requires twelve periods for calculating each month. Another field is required for the return
value, which is the result of the smart field calculation for each quarter.

All data items that are added to the data structure must reside in the same business view. If you find that you
need to add data items that are not included in a single business view, you must create a custom business
view that includes all of the required data items. Adding data items that reside in different business views
results in a nonfunctional smart field.

You can also define the direction of the flow of data in a smart field data structure. This eliminates the need for
the report developer to define the flow in Report Design Aid. This is another component that simplifies the
use of business functions for the report developer.

See PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Data Structure Design, “Creating
Data Structures,” Creating Business Function Data Structures.

Named Mappings
Named mappings are a component of the data structure and are used only for smart fields. Named mappings
define each of the data items that are included in the data structure. They can also hold default values for the
business function so that the values do not need to be manually defined in Report Design Aid.

Named mappings are also used to map the source for each parameter (or data item) of the data structure. For
example, source values are determined for the prompts, tables, and return values. This table details the
sources from which data structure data items originate:

Source Description

Literal Used to assign a specific value to the data item. If the
calculation needs to use a tax rate for instance, enter the tax
rate in the value field.

Prompt Indicates that the data item is the user prompt. For example,
the Quarter to Display data item is the prompt. In Report
Design Aid, the report developer must enter the quarter to
calculate and display in the report.
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Source Description

Table Indicates the data items that originate from a table. Browse
to locate the table name and associate the data item in the
data structure with the corresponding data item in the table.

Data Dictionary Item Used to pass values from a processing option into the data
structure. Values in smart fields can be identified to a
business function without requiring input. For example, the
desired fiscal year or period might already be specified in a
processing option that can be passed into the data structure.
If this is the case, the data item must be defined as both a
data dictionary item and a processing option in the named
mapping.

System Value Use to associate the system value as the origin of the data
item and browse for the appropriate system value. These
system values, such as system date, are used throughout the
system. System values are fetched from the F98VAR table.

Named mappings being with the letter M and use the same name as the data structure. If you are going to have
several named mappings for a single data structure, append a sequential letter of the alphabet to the named
mapping name. For example, the first named mapping for data structure D550101 would be named M550101A.

Business Functions
You use business functions to define the logic for the smart field. You can use either C business functions or
named event rule business functions. C business functions are written in C language, while named event rule
business functions are written in scripting language using the PeopleSoft EnterpriseOne toolset.

The advantage of using business functions is that they are reusable. The code is written once and can be used
in multiple events and reports. For example, for Quarterly Amount, without the named event rule, you would
write four event rules; one for each of the quarters adding together the appropriate periods. In contrast, using a
named event rule, you can write the criteria once and reuse it for each of the four columns that display quarterly
amounts. You can use this same named event rule in other reports that require quarter sale figures as well.

A named event rule is a business function object. When creating a business function, you have a choice of
the source language, C and NER. Your selection determines the tool that you use to create the business
function. For a named event rule, you select NER.

When a named event rule is created, as with any business function, you need to associated it with a data
structure.

You create the logic for a named event rule using the Named Event Rules Design form. This form is similar to
the Event Rules Design form used in Report Design Aid. In the Named Event Rules Design form, you can
create event rule logic for each valid user prompt value. It is good practice to also include a default statement.
For example, the logic for quarterly amount might state that if any value other than 1, 2, 3, or 4 is entered into
the user prompt, the first quarter is calculated by default.

See PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: APIs and Business Functions,
“Using Business Functions”.

Smart Field Data Items
The last component that is required for a smart field is a data dictionary item that is defined as a smart field.
Smart field data dictionary items differ from regular data dictionary items in two ways:
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• Glossary group.
Smart field data items are classified as glossary group K. The K classification enables the Smart Field
Criteria form.

• Smart Field Criteria form.
The Smart Field Criteria form defines the business function and named mapping that are associated with the
smart field and the event on which the logic is attached.
If you created the smart field for use in tabular sections, you might select the Column Inclusion event. If you
created the smart field for use in columnar or group sections, you might select the Do Variable event.

Smart Field Templates
PeopleSoft EnterpriseOne includes predefined smart field templates. Smart field templates group smart fields
that use the same data selection criteria so that you can include them collectively in a Report Director template.
For example, the S09001 - Financial Reporting smart field template contains all the smart fields for financial
reporting. Through the Smart Field Templates program (P91420), you can add new smart field templates or
modify existing smart field templates to meet your reporting needs.

You must add smart fields to a smart field template before they can be used in a report. Then the smart field
template must be attached to a Report Director template. When you use the Report Director template to create
a report, the smart fields in the attached template display in Available Smart Fields of the Select Columns form
of the Report Director. From this form, you can select any of the smart fields to include in the report.

When you select a smart field to include in the section layout, you are typically prompted for data selection
values. Data selection fields are defined within the smart field template. These fields appear on the Smart
Field Data Selection form of the Report Director.

Custom smart field template names should begin with SFT. The next two characters should be one of the
product codes that is reserved for clients (55–59) and the next characters should reflect the system that uses the
smart field template as recommend for PeopleSoft EnterpriseOne objects.

When you define a smart field template, you can select multiple smart fields to include in the template as long
as they all use the same data selection. You select from data item fields to be included in the data selection.
Select only data items that are included in the business view associated with the smart fields. Only five data
items can be included in the smart field data selection criteria.

You can define a data selection field as requiring a range of values, but it must be counted as two items. A
range of values takes up two lines on the Smart Field Data Selection form in Report Design Aid. For example,
if you include business unit as a data selection item, you might want the report developer to be able to include a
range of values. This option presents two fields on the Smart Field Data Selection form in the Report Director,
one for the beginning business unit and one for the ending business unit.

Report Director Templates
Report Director templates define a set of parameters to guide the report developer through the creation of
a batch application. Report Director templates are typically created to use smart fields. However, you can
use Report Director templates to define parameters for the development of batch applications without the use
of smart fields. These Directors are similar to the Report Director that you use when creating columnar or
group section report templates.

When you create a Report Director template, you define the appropriate business view to attach to the report
section. The business view that you select must include all of the data items included in the smart field data
structure. It is this business view that is used when the report developer selects the option, I’ll use the pre
defined business view from the Report Director.
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Custom Report Director templates should begin with DT. The next two characters should be one of the
product codes that is reserved for clients (55–59) and the next characters should reflect the system that uses
the Report Director template.

The Report Director template description displays in the Application Report drop-down list on the Report
Director Welcome form and on the Business View Selection Options form when you create the report
in Report Design Aid.

Report Templates
As the final step in the smart field creation process, you should test the smart field. It is helpful to review
the Report Director and see how all the information you defined is presented to the report developer. This
helps you to understand from where each of the options presented in the Report Director originate and how the
selections you make in defining the objects affect what the report developer sees.

Smart Field Logic
You can review the event rules that are created by the smart fields to understand how the smart field
components are implemented in the report. On the PeopleSoft Report Design Aid form, click the variable
portion of a smart field column. From the Edit menu, select Event Rules. Select the event that you defined on
the Smart Field Criteria form when you created the smart field data item.

The description of the business function that you created for the smart field appears on the event. Double-click
the business function to review the data structure parameters. The business function information is displayed
in the upper-left corner of the Business Functions form, and includes the: business function name, description,
and the name of the attached data structure. The data structure displays the parameters as you defined them
on the named mapping.

Notice that the data structure includes directional arrows as you defined them in the data structure. The
directional arrows for all data items, except the return value data item, point to the right. This is because each
of these fields are fetched from a source, such as the database or a user prompt. The system then processes the
logic using these fields and returns the result to the return value field to display on the report. This is the field
in which the directional arrow points to the left. Without the use of this smart field, the report developer would
have to know which business function to use and how to pass each of these values.

For example, if you select the first quarter variable that was created using the quarterly sales smart field, you can
see in the data structure the 1 that you entered on the Smart Field Parameters form when you created the report.

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Tables and Business Views

PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Data Structure Design

252 PeopleSoft Proprietary and Confidential



Chapter 32 Creating Smart Fields

Forms Used to Create Smart Fields
Form Name FormID Navigation Usage

WorkWith Smart Field
Templates,

W91420A EnterpriseOne Life Cycle
Tools, Report Management
(GH9111), Advanced Report
Setup, Smart Field Templates

Add, modify, and delete
Smart Field templates.

Smart Field Template
Revisions

W91420G Click Add on theWorkWith
Smart Field Templates form

Enter Smart Field template
name, description, and smart
field data item.

Smart Field Template
Criteria Revisions

W91420B Click OK on the Smart Field
Template Revisions form.

Enter fields to be used for
data selection.

WorkWith Report Director
Templates

W91400A EnterpriseOne Life Cycle
Tools, Report Management
(GH9111), Advanced Report
Setup, Report Director
Templates

Add, modify, and delete
Report Director templates.

Report Director Templates
Revisions

W91400B Click Add on theWorkWith
Report Director Templates
form.

Enter the Report Director
template name, description,
section type, default
business view, processing
options, smart field template
name (if appropriate),
default data sequencing and
level breaks, properties,
and drill down.

Creating Data Dictionary Items
From the Tools menu in Solution Explorer, select Object Management Workbench.

1. Select the project in which you want to add a new data dictionary item and click Add.

2. On the Add EnterpriseOne Object to the Project form, select Data Item and click OK.

3. On the Data Dictionary Item Type form, click No.

This is a regular data dictionary item, not a glossary data item.

4. On the Data Item Specifications form, enter the name of the data item in the Data Item field.

5. In theAlias field, enter a unique alphanumeric identifier.

6. In the Glossary Group field, enter D to indicate a primary data element.

7. In the Description field, enter a brief description of the data item.

8. In the Product Code field, enter a product code in the 55–59 range, reserved for clients.

9. In the Product Code Reporting field, enter a product code that represents the system associated with this
data item.

10. In the Data Type field, use the visual assist to select a value that indicates the type of data to be entered (for
example, character, string, numeric).

11. In the Size field, enter the field size of the data item.

This field is enabled based on the data type you select.
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12. In the File Decimals field, enter the number of stored positions to the right of the decimal place.
This field is enabled only if the data type is defined as numeric.

13. In the Class field, use the visual assist to select a class that defines the attributes and characteristics of the
data item (for example, CURRENCY).
This is an informational field only and is not required.

14. In the Display Decimals field, enter the number of decimals to display.
This field is enabled only if the data type is defined as numeric.

15. In the Control Type field, enter the type of control that is associated with the data item (for example,
check box, push button, generic edit, and so on).
The generic edit option is typically used when creating data items specifically for batch applications.

16. Leave the Item Occurrences field cleared.
Item Occurrences causes a number of identical data items to be created based off the template defined by
the active data item properties. For example, if a data item RDATEST is added with Item Occurrences set
to 2, the system creates two copies of the data item - RDATEST1 and RDATEST2.

17. In the Row Description field, enter the data item description as it should appear in group sections.
18. In the Column Title fields, enter the data item description as it should appear in columnar sections.
Split lengthy descriptions into two lines. Enter short descriptions in the top line.

19. Select the Item Glossary tab, enter a description of all the valid values for this prompt and click OK.
The item glossary displays on the Smart Field Parameters form in the Report Director. For example, for
a quarterly data item prompt, you might enter:
Enter 1 to display totals for first quarter.
Enter 2 to display totals for second quarter.
Enter 3 to display totals for third quarter.
Enter 4 to display totals for fourth quarter.

Creating Data Structures
Access the appropriate project in Object Management Workbench.

1. Add a data structure to the same project in which you added the other smart field components.

2. On the Add Object form, create a new regular data structure, naming it according to the recommended
naming conventions, and click OK.

3. On the Data Structure Design form, select the Design Tools tab and click Data Structure Design.

4. On the Data Structure form, under Dictionary Items, enter the alias of the data item prompt on the QBE line.

5. Double-click the data item prompt to include it in Structure Members.

6. Double-click in the Required field of the grid to define the data item prompt as Required.

This field displays a check mark for the prompt data item.

7. Under Dictionary Items, search for all required data items using the QBE line.

8. Double-click the required data items individually to include them in Structure Members.

9. Under Dictionary Items, search for a data item to serve as a return value using the QBE line.
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Use a data item that is formatted the same as you want the smart field to be formatted.
10. Double-click the return value data item to include it in Structure Members.
You can rename the return value data item in the Structure Member Name field.

11. Set up the arrows in the Input/Output field for each data item to reflect the flow of the data and click OK.
All arrows for prompts and data items should point to the right because these fields fetch data from
the database. The arrow for the return value should point to the left as the data is returned to this field
in the report section.

Defining Named Mappings
Select the Design Tools tab for the smart field data structure.

1. Click Named Mapping.

2. On the Named Mapping form, click Add.

The grid includes all data items included in the data structure.

3. On the Add Argument List form, enter the name of the named mapping using the recommended naming
conventions.

4. On the Named Mapping form, click the prompt data item and under Origin Types select the Prompt option.

The prompt is already set as a required data item from the data structure definition.

5. Click one of the data items to be fetched from a table and under Origin Types, select the Table option.

6. Click the Browse button to access the Select a Table form.

7. Use the QBE line to locate the table where the data item resides and click Next.

8. On the Select a Column form, select the field that matches the data item in the data structure and click
Finish.

9. On the Named Mapping form, define each of the data items that are fetched from a table as required, using
the Required option at the bottom of the form.

10. Define the return value data item using the Return Value option at the bottom of the form.

Note. When you select the Return Value option, the system automatically selects the Required option.

Performing Calculations Using Named Event Rules
Access the appropriate project in Object Management Workbench.

1. Add a business function to the same project in which you added the other smart field components.
2. On the Add Object form, create a new business function, naming it according to the recommended
naming conventions.

3. Under Source Language, select NER and then click OK.
4. On the Design Tools tab of the Business Function Design form, click Start Business Function Design Aid.
5. On the Business Function Design form, click the visual assist in the Parent DLL field and select the DLL
your company uses to create custom business functions.

6. In the grid, enter a unique name in the Function Name field.
This name cannot include any spaces and should be descriptive of the business function purpose.
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7. Enter a description in the Description field.
This description can be the same as the name, however, you can use spaces in the description.

8. Tab through the remaining fields.
The system populates the F3 Code field with a 3 (Minor Business Rule).

9. Modify the F3 Code if appropriate.
10. Click the row header to highlight the row of data that you just entered, and select Parameters from the
Row menu.

11. Use the QBE line to locate the associated data structure, click the data structure, and then click Select.
This process attaches the business function data structure that was created for the level break message to
the business function.

12. On the Business Function Design form, verify that the name of the appropriate data structure appears in
the Template Name field in the grid.

13. From the Form menu, select Edit.
14. On the Named Event Rules Design form, create the appropriate logic using If/While statements,
assignments, business functions, and system functions.
For example, for the quarterly amount smart field that calculates sales for each quarter, this logic is
appropriate:

If <user prompt> is equal to 2

<return value> = Sales for Period 4 + Sales for Period 5 + Sales for Period 6

Else

If <user prompt> is equal to 3

<return value> = Sales for Period 7 + Sales for Period 8 + Sales for Period 9

Else

If <user prompt> is equal to 4

<return value> = Sales for Period 10 + Sales for Period 11 + Sales for Period 12

Else

<return value> = Sales for Period 1 + Sales for Period 2 + Sales for Period 3

End If

End If

End If

15. When the logic is complete, save the event rules and click OK.

16. On the Design Tools tab, click Build Business Function.

Creating Data Dictionary Smart Field Items
Access the appropriate project in Object Management Workbench.

1. Add a data item to the same project in which you added the other smart field components.
2. On the Data Dictionary Item Type form, click No.
3. On the Data Item Specifications form, enter the name of the data item in the Data Item field.
4. In theAlias field, enter a unique alphanumeric identifier.
5. In the Glossary Group field, enter K to indicate smart field.
6. In the Description field, enter a brief description of the data item.
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7. In the Product Code field, enter a product code in the 55–59 range, reserved for clients.
8. In the Product Code Reporting field, enter a product code that represents the system associated with this
data item.

9. In the Data Type field, use the visual assist to select a value that indicates the type of data to be entered (for
example, character, string, numeric).

10. In the Size field, enter the field size of the data item.
11. In the File Decimals field, enter the number of stored positions to the right of the decimal place.
12. In the Class field, use the visual assist to select a class that defines the attributes and characteristics of the
data item (for example, CURRENCY).

13. In the Display Decimals field, enter the number of decimals to display.
14. In the Control Type field, enter the type of control that is associated with the data item (for example,
check box, push button, generic edit, and so on).
The generic edit option is typically used when creating data items specifically for batch applications.

15. Leave the Item Occurrences field cleared.
16. In the Row Description field, enter the data item description as it should appear in group sections.
17. In the Column Title fields, enter the data item description as it should appear in columnar sections.
18. Select the Item Glossary tab and enter information that describes all of the valid results.
For example, for a quarterly smart field, you might enter:
• 1 returns a total value for January, February, and March.
• 2 returns a total value for April, May, and June.
• 3 returns a total value for July, August, and September.
• 4 returns a total value for October, November, and December.

19. From the Form menu, select Smart Field to launch the Smart Field Criteria form.
20. In the Business Function field, click the visual assist and use the QBE line to locate the appropriate
business function, click the business function, and then click Select.

21. In the Event Name field, click the visual assist and select the event from which the smart field business
function will be called.

22. In the Named Mapping field, enter the name of the named mapping that you defined for the associated
data structure and click OK.

See Also
PeopleSoft EnterpriseOne Tools 8.95 PeopleBook: Development Tools: Data Dictionary

Creating Smart Field Templates
Access the Smart Field Template Revisions form.
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Smart Field Template Revisions form

Smart Field Template The name of the Smart Field template.

Description A meaningful description of the type of smart fields that are included in
the Smart Field template.

Data Item and Description The data item alias and description of all smart fields to be included in the
Smart Field template. The system populates the description based on the
alias that you enter.
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Smart Field Template Criteria Revisions form

Data Item The alias of the data items to be used as data selection in the report sections
created using the Smart Field template.

Description The description of the data items to be used as data selection in report sections
created using the Smart Field template. The system populates the description
based on the alias that you enter.

Display Seq Indicates the sequence in which the data selection fields display on the Smart
Field Data Selection form of the Report Director.

Range Values Indicates whether a field requires a range of values or a single value. For
example, if Units-Order Transaction Quantity requires a range of values,
enter a 1 in the field.

Creating Report Director Templates
Access the Report Director Templates Revisions form.
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Report Director Templates Revisions form

Report
Template/Description

The name of the Report Director template and a meaningful description.

The Report Template/Description information displays from all three tabs.

Section Type The type of report section the system creates when this Report Director
template is selected.

Business View The business view to be used by the report. You can override this business
view in the Report Director.

Processing Options This field is optional. The processing options to be used by the report. You can
override this business view in the Report Director.

Smart Field Template This field is optional. The smart field template to be used by the report. The
smart field template is dependent on the business view defined.

Default Sequence and
Level Breaks

The data sequence and level breaks to be used by the report. These fields
appear on the Data Sequencing Help form of the Report Director. The first two
data items appear in Report Grouping, and the subsequent data items appear in
Report Detail. You can override these fields in the Report Director.
The Default Sequence and Level Breaks information displays from all three
tabs.

260 PeopleSoft Proprietary and Confidential



Chapter 32 Creating Smart Fields

Designing Reports Using Custom Smart Fields
Create a new report in Report Design Aid.

1. On the Report Director, under Application Reports, select the appropriate Report Director template from
the pull-down menu, and click Next.
This information is derived from the description you entered when you created the Report Director
template.

2. On the Page Header Details form, accept the page header defaults and click Next.
3. On the Business View Selection Options form, select the option I’ll use the pre-defined business view
and click Next.
The predefined business view is the business view that you defined on the Building Blocks tab for the
Report Director template. You can select one of the other two business view selection options to override
this default.

4. On the Select Columns form, move the appropriate smart field from Available Smart Fields to Columns in
Report Section.
The available smart fields is derived from the smart field template that you associated with the Report
Director template. All smart fields in the attached smart field template are available to the report developer.

5. On the Smart Field Name form, change the Variable Name if appropriate.
Change the variable name to describe the smart field (for example, First Quarter).
• Change the Report Column Headings fields to describe the field on the report.
For example, to describe the first quarter data enter First Quarter on line 1 and Sales on line 2.
If you have selected a Report Director template that includes a smart field to display column headings,
the Smart Column Heading option is displayed. Instead of changing the column heading names, select
this option to allow the smart field to populate the column headings based on information that you
enter in the subsequent forms.
Subsequent forms are dependent on the selected Report Director template. For example, using the
quarterly sales scenario you might see these forms:

• Smart Field Parameters
This form displays the user prompt data item that you created. The information you entered in the item
glossary is displayed in the center of the form. Enter an appropriate value in the Enter the Literal
field based on the glossary information. If you created multiple user prompts, you are presented with
additional forms for each prompt. For quarterly sales, enter the quarter you want calculated and
displayed on the report. For first quarter sales, enter 1 in this field.

• Smart Field Data Selection
This form displays the data items you defined on the Template Criteria form when adding the smart field
to the smart field template. If you defined any of the data items as requiring a range of values, the data
item displays a From and a To field.
If you intend to define the same data selection for each smart field column, you can leave this form blank
and just fill in the data selection for the report.

6. When you have completed all smart field parameters, click Finish.
You can add additional smart field columns to the report by repeating steps. For example, for quarterly
sales, you can select the smart field again and enter 2 on the Smart Field Parameter form to calculate and
display sales for the second quarter.
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7. When you are finished adding smart field columns to the report, click Next.
8. On the Data Sequencing Help form, click Next.
The Data Sequencing Help form displays the data sequence and level break fields that you defined in the
Report Director template. The fields that appear under Report Grouping are defined as level break fields
and are the first two fields you entered into the grid in the Report Director template. You can remove
these fields as level breaks by clearing the option.
The fields that appear under Report Detail are the additional fields that you included in the Report Director
template and are also used for data sequencing. Click each field that you want to include as a level break
field so that they appear in the empty field directly above them.
You can override the predefined data sequencing and level breaks by selecting the I’d like to setup the
sequencing and level breaking myself option under Advanced. You can define data sequencing on the
Section Data Sequencing form. The fields listed in the Available Columns section are fields from the
attached business view. The subsequent Define Sort Properties form enables you to define level breaks.

9. On the Help with Section Data Selection form, select to create either a balance sheet or an income
statement and indicate whether you want to add to the data selection, and click Next.

Note. This form only displays if you defined the associated Report Director template to display financial
criteria.

10. On the Data Selection form, define the appropriate data selection.
This form displays if you defined the selected Report Director template to display generic criteria or if you
selected the option Set up data selection manually on the Help with Section Data Selection form.
you should define data selection here to enhance system performance even if you defined data selection
for each smart field.

11. On the Additional Properties form, select the appropriate options and click Next.
The options displayed on this form are defined on the Properties tab of the Report Director Template.

12. On the Finish form, click Finish and then save and preview the report.
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activity A scheduling entity in PeopleSoft EnterpriseOne Form Design Aid that represents a
designated amount of time on a calendar.

activity rule The criteria by which an object progresses from one given point to the next in a flow.

add mode A condition of a form that enables users to input data.

Advanced Planning Agent
(APAg)

A PeopleSoft EnterpriseOne tool that can be used to extract, transform, and load
enterprise data. APAg supports access to data sources in the form of rational databases,
flat file format, and other data or message encoding, such as XML.

application server A server in a local area network that contains applications shared by network clients.

as if processing A process that enables you to view currency amounts as if they were entered in a
currency different from the domestic and foreign currency of the transaction.

alternate currency A currency that is different from the domestic currency (when dealing with a
domestic-only transaction) or the domestic and foreign currency of a transaction.

In PeopleSoft EnterpriseOne Financial Management, alternate currency processing
enables you to enter receipts and payments in a currency other than the one in which
they were issued.

as of processing A process that is run as of a specific point in time to summarize transactions up to that
date. For example, you can run various PeopleSoft EnterpriseOne reports as of a
specific date to determine balances and amounts of accounts, units, and so on as of
that date.

back-to-back process A process in PeopleSoft EnterpriseOneWorkflowManagement that contains the same
keys that are used in another process.

batch processing A process of transferring records from a third-party system to PeopleSoft
EnterpriseOne.

In PeopleSoft EnterpriseOne Financial Management, batch processing enables you to
transfer invoices and vouchers that are entered in a system other than EnterpriseOne
to PeopleSoft EnterpriseOne Accounts Receivable and PeopleSoft EnterpriseOne
Accounts Payable, respectively. In addition, you can transfer address book
information, including customer and supplier records, to PeopleSoft EnterpriseOne.

batch server A server that is designated for running batch processing requests. A batch server
typically does not contain a database nor does it run interactive applications.

batch-of-one immediate A transaction method that enables a client application to perform work on a client
workstation, then submit the work all at once to a server application for further
processing. As a batch process is running on the server, the client application can
continue performing other tasks.

See also direct connect and store-and-forward.

business function A named set of user-created, reusable business rules and logs that can be called
through event rules. Business functions can run a transaction or a subset of a
transaction (check inventory, issue work orders, and so on). Business functions
also contain the application programming interfaces (APIs) that enable them to be
called from a form, a database trigger, or a non-EnterpriseOne application. Business
functions can be combined with other business functions, forms, event rules, and other
components to make up an application. Business functions can be created through
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event rules or third-generation languages, such as C. Examples of business functions
include Credit Check and Item Availability.

business function event rule See named event rule (NER).

business view Ameans for selecting specific columns from one or more PeopleSoft EnterpriseOne
tables whose data is used in an application or report. A business view does not select
specific rows, nor does it contain any actual data. It is strictly a view through which
you can manipulate data.

central objects merge A process that blends a customer’s modifications to the objects in a current release
with objects in a new release.

central server A server that has been designated to contain the originally installed version of the
software (central objects) for deployment to client computers. In a typical PeopleSoft
EnterpriseOne installation, the software is loaded on to one machine—the central
server. Then, copies of the software are pushed out or downloaded to various
workstations attached to it. That way, if the software is altered or corrupted through its
use on workstations, an original set of objects (central objects) is always available
on the central server.

charts Tables of information in PeopleSoft EnterpriseOne that appear on forms in the
software.

connector Component-based interoperability model that enables third-party applications and
PeopleSoft EnterpriseOne to share logic and data. The PeopleSoft EnterpriseOne
connector architecture includes Java and COM connectors.

contra/clearing account A general ledger account in PeopleSoft EnterpriseOne Financial Management that
is used by the system to offset (balance) journal entries. For example, you can use a
contra/clearing account to balance the entries created by allocations in PeopleSoft
EnterpriseOne General Accounting.

Control TableWorkbench An application that, during the installationWorkbench processing, runs the batch
applications for the planned merges that update the data dictionary, user-defined
codes, menus, and user override tables.

control tables merge A process that blends a customer’s modifications to the control tables with the data that
accompanies a new release.

cost assignment The process in PeopleSoft EnterpriseOne Advanced Cost Accounting of tracing or
allocating resources to activities or cost objects.

cost component In PeopleSoft EnterpriseOneManufacturing Management, an element of an item’s
cost (for example, material, labor, or overhead).

cross segment edit A logic statement that establishes the relationship between configured item segments.
Cross segment edits are used to prevent ordering of configurations that cannot be
produced.

currency restatement The process of converting amounts from one currency into another currency, generally
for reporting purposes. You can use the currency restatement process, for example,
when many currencies must be restated into a single currency for consolidated
reporting.

database server A server in a local area network that maintains a database and performs searches
for client computers.

Data SourceWorkbench An application that, during the InstallationWorkbench process, copies all data sources
that are defined in the installation plan from the Data Source Master and Table and
Data Source Sizing tables in the Planner data source to the System-release number data
source. It also updates the Data Source Plan detail record to reflect completion.
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date pattern A calendar that represents the beginning date for the fiscal year and the ending date for
each period in that year in standard and 52-period accounting.

denominated-in currency The company currency in which financial reports are based.

deployment server A server that is used to install, maintain, and distribute software to one or more
enterprise servers and client workstations.

detail information Information that relates to individual lines in PeopleSoft EnterpriseOne transactions
(for example, voucher pay items and sales order detail lines).

direct connect A transaction method in which a client application communicates interactively and
directly with a server application.

See also batch-of-one immediate and store-and-forward.

Do Not Translate (DNT) A type of data source that must exist on the iSeries because of BLOB restrictions.

dual pricing The process of providing prices for goods and services in two currencies.

edit code A code that indicates how a specific value for a report or a form should appear or be
formatted. The default edit codes that pertain to reporting require particular attention
because they account for a substantial amount of information.

edit mode A condition of a form that enables users to change data.

edit rule Amethod used for formatting and validating user entries against a predefined rule
or set of rules.

Electronic Data Interchange
(EDI)

An interoperability model that enables paperless computer-to-computer exchange of
business transactions between PeopleSoft EnterpriseOne and third-party systems.
Companies that use EDI must have translator software to convert data from the EDI
standard format to the formats of their computer systems.

embedded event rule An event rule that is specific to a particular table or application. Examples include
form-to-form calls, hiding a field based on a processing option value, and calling a
business function. Contrast with the business function event rule.

EmployeeWork Center A central location for sending and receiving all PeopleSoft EnterpriseOne messages
(system and user generated), regardless of the originating application or user. Each
user has a mailbox that contains workflow and other messages, including Active
Messages.

enterprise server A server that contains the database and the logic for PeopleSoft EnterpriseOne
or PeopleSoft World.

EnterpriseOne object A reusable piece of code that is used to build applications. Object types include tables,
forms, business functions, data dictionary items, batch processes, business views,
event rules, versions, data structures, and media objects.

EnterpriseOne process A software process that enables PeopleSoft EnterpriseOne clients and servers to
handle processing requests and run transactions. A client runs one process, and servers
can have multiple instances of a process. PeopleSoft EnterpriseOne processes can also
be dedicated to specific tasks (for example, workflow messages and data replication)
to ensure that critical processes don’t have to wait if the server is particularly busy.

EnvironmentWorkbench An application that, during the InstallationWorkbench process, copies the
environment information and Object Configuration Manager tables for each
environment from the Planner data source to the System-release number data source. It
also updates the Environment Plan detail record to reflect completion.

escalation monitor A batch process that monitors pending requests or activities and restarts or forwards
them to the next step or user after they have been inactive for a specified amount of
time.
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event rule A logic statement that instructs the system to perform one or more operations based
on an activity that can occur in a specific application, such as entering a form or
exiting a field.

facility An entity within a business for which you want to track costs. For example, a facility
might be a warehouse location, job, project, work center, or branch/plant. A facility is
sometimes referred to as a business unit .

fast path A command prompt that enables the user to move quickly among menus and
applications by using specific commands.

file server A server that stores files to be accessed by other computers on the network. Unlike
a disk server, which appears to the user as a remote disk drive, a file server is a
sophisticated device that not only stores files, but also manages them and maintains
order as network user request files and make changes to these files.

final mode The report processing mode of a processing mode of a program that updates or
creates data records.

FTP server A server that responds to requests for files via file transfer protocol.

header information Information at the beginning of a table or form. Header information is used to identify
or provide control information for the group of records that follows.

interface table See Z table.

integration server A server that facilitates interaction between diverse operating systems and applications
across internal and external networked computer systems.

integrity test A process used to supplement a company’s internal balancing procedures by locating
and reporting balancing problems and data inconsistencies.

interoperability model Amethod for third-party systems to connect to or access PeopleSoft EnterpriseOne.

in-your-face-error In PeopleSoft EnterpriseOne, a form-level property which, when enabled, causes the
text of application errors to appear on the form.

IServer service Developed by PeopleSoft, this internet server service resides on the web server and is
used to speed up delivery of the Java class files from the database to the client.

jargon An alternative data dictionary item description that PeopleSoft EnterpriseOne or
People World displays based on the product code of the current object.

Java application server A component-based server that resides in the middle-tier of a server-centric
architecture. This server provides middleware services for security and state
maintenance, along with data access and persistence.

JDBNET A database driver that enables heterogeneous servers to access each other’s data.

JDEBASE Database
Middleware

A PeopleSoft proprietary database middleware package that provides
platform-independent APIs, along with client-to-server access.

JDECallObject An API used by business functions to invoke other business functions.

jde.ini A PeopleSoft file (or member for iSeries) that provides the runtime settings required
for EnterpriseOne initialization. Specific versions of the file or member must reside
on every machine running PeopleSoft EnterpriseOne. This includes workstations
and servers.

JDEIPC Communications programming tools used by server code to regulate access to the
same data in multiprocess environments, communicate and coordinate between
processes, and create new processes.
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jde.log The main diagnostic log file of PeopleSoft EnterpriseOne. This file is always located
in the root directory on the primary drive and contains status and error messages from
the startup and operation of PeopleSoft EnterpriseOne.

JDENET PeopleSoft proprietary communications middleware package. This package is a
peer-to-peer, message-based, socket-based, multiprocess communications middleware
solution. It handles client-to-server and server-to-server communications for all
PeopleSoft EnterpriseOne supported platforms.

LocationWorkbench An application that, during the InstallationWorkbench process, copies all locations
that are defined in the installation plan from the Location Master table in the Planner
data source to the System data source.

logic server A server in a distributed network that provides the business logic for an application
program. In a typical configuration, pristine objects are replicated on to the logic
server from the central server. The logic server, in conjunction with workstations,
actually performs the processing required when PeopleSoft EnterpriseOne andWorld
software runs.

MailMergeWorkbench An application that merges Microsoft Word 6.0 (or higher) word-processing
documents with PeopleSoft EnterpriseOne records to automatically print business
documents. You can use MailMerge Workbench to print documents, such as form
letters about verification of employment.

master business function (MBF) An interactive master file that serves as a central location for adding, changing, and
updating information in a database. Master business functions pass information
between data entry forms and the appropriate tables. These master functions provide a
common set of functions that contain all of the necessary default and editing rules for
related programs. MBFs contain logic that ensures the integrity of adding, updating,
and deleting information from databases.

master table See published table.

matching document A document associated with an original document to complete or change a transaction.
For example, in PeopleSoft EnterpriseOne Financial Management, a receipt is the
matching document of an invoice, and a payment is the matching document of a
voucher.

media storage object Files that use one of the following naming conventions that are not organized into
table format: Gxxx, xxxGT, or GTxxx.

message center A central location for sending and receiving all PeopleSoft EnterpriseOne messages
(system and user generated), regardless of the originating application or user.

messaging adapter An interoperability model that enables third-party systems to connect to PeopleSoft
EnterpriseOne to exchange information through the use of messaging queues.

messaging server A server that handles messages that are sent for use by other programs using a
messaging API. Messaging servers typically employ a middleware program to perform
their functions.

named event rule (NER) Encapsulated, reusable business logic created using event rules, rather that C
programming. NERs are also called business function event rules. NERs can be reused
in multiple places by multiple programs. This modularity lends itself to streamlining,
reusability of code, and less work.

nota fiscal In Brazil, a legal document that must accompany all commercial transactions for tax
purposes and that must contain information required by tax regulations.

nota fiscal factura In Brazil, a nota fiscal with invoice information.

See also nota fiscal.
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Object ConfigurationManager
(OCM)

In PeopleSoft EnterpriseOne, the object request broker and control center for the
runtime environment. OCM keeps track of the runtime locations for business
functions, data, and batch applications. When one of these objects is called, OCM
directs access to it using defaults and overrides for a given environment and user.

Object Librarian A repository of all versions, applications, and business functions reusable in
building applications. Object Librarian provides check-out and check-in capabilities
for developers, and it controls the creation, modification, and use of PeopleSoft
EnterpriseOne objects. Object Librarian supports multiple environments (such as
production and development) and enables objects to be easily moved from one
environment to another.

Object Librarian merge A process that blends any modifications to the Object Librarian in a previous release
into the Object Librarian in a new release.

Open Data Access (ODA) An interoperability model that enables you to use SQL statements to extract
PeopleSoft EnterpriseOne data for summarization and report generation.

Output Stream Access (OSA) An interoperability model that enables you to set up an interface for PeopleSoft
EnterpriseOne to pass data to another software package, such as Microsoft Excel,
for processing.

package EnterpriseOne objects are installed to workstations in packages from the deployment
server. A package can be compared to a bill of material or kit that indicates the
necessary objects for that workstation and where on the deployment server the
installation program can find them. It is point-in-time snap shot of the central objects
on the deployment server.

package build A software application that facilitates the deployment of software changes and new
applications to existing users. Additionally, in PeopleSoft EnterpriseOne, a package
build can be a compiled version of the software. When you upgrade your version of the
ERP software, for example, you are said to take a package build.

Consider the following context: “Also, do not transfer business functions into the
production path code until you are ready to deploy, because a global build of business
functions done during a package build will automatically include the new functions.”
The process of creating a package build is often referred to, as it is in this example,
simply as “a package build.”

package location The directory structure location for the package and its set of replicated objects.
This is usually \\deployment server\release\path_code\package\package name. The
subdirectories under this path are where the replicated objects for the package are
placed. This is also referred to as where the package is built or stored.

PackageWorkbench An application that, during the InstallationWorkbench process, transfers the package
information tables from the Planner data source to the System-release number data
source. It also updates the Package Plan detail record to reflect completion.

PeopleSoft Database See JDEBASE Database Middleware.

planning family Ameans of grouping end items whose similarity of design and manufacture facilitates
being planned in aggregate.

preference profile The ability to define default values for specified fields for a user-defined hierarchy of
items, item groups, customers, and customer groups.

print server The interface between a printer and a network that enables network clients to connect
to the printer and send their print jobs to it. A print server can be a computer, separate
hardware device, or even hardware that resides inside of the printer itself.

pristine environment A PeopleSoft EnterpriseOne environment used to test unaltered objects with
PeopleSoft demonstration data or for training classes. You must have this environment
so that you can compare pristine objects that you modify.
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processing option A data structure that enables users to supply parameters that regulate the running of
a batch program or report. For example, you can use processing options to specify
default values for certain fields, to determine how information appears or is printed,
to specify date ranges, to supply runtime values that regulate program execution,
and so on.

production environment A PeopleSoft EnterpriseOne environment in which users operate EnterpriseOne
software.

production-grade file server A file server that has been quality assurance tested and commercialized and that is
usually provided in conjunction with user support services.

program temporary fix (PTF) A representation of changes to PeopleSoft software that your organization receives
on magnetic tapes or disks.

project In PeopleSoft EnterpriseOne, a virtual container for objects being developed in Object
Management Workbench.

promotion path The designated path for advancing objects or projects in a workflow. The following
is the normal promotion cycle (path):

11>21>26>28>38>01

In this path, 11 equals new project pending review, 21 equals programming, 26 equals
QA test/review, 28 equals QA test/review complete, 38 equals in production, 01 equals
complete. During the normal project promotion cycle, developers check objects out
of and into the development path code and then promote them to the prototype path
code. The objects are then moved to the productions path code before declaring
them complete.

proxy server A server that acts as a barrier between a workstation and the internet so that the
enterprise can ensure security, administrative control, and caching service.

published table Also called a master table, this is the central copy to be replicated to other machines.
Residing on the publisher machine, the F98DRPUB table identifies all of the published
tables and their associated publishers in the enterprise.

publisher The server that is responsible for the published table. The F98DRPUB table identifies
all of the published tables and their associated publishers in the enterprise.

pull replication One of the PeopleSoft methods for replicating data to individual workstations.
Such machines are set up as pull subscribers using PeopleSoft EnterpriseOne data
replication tools. The only time that pull subscribers are notified of changes, updates,
and deletions is when they request such information. The request is in the form of a
message that is sent, usually at startup, from the pull subscriber to the server machine
that stores the F98DRPCN table.

QBE An abbreviation for query by example. In PeopleSoft EnterpriseOne, the QBE line is
the top line on a detail area that is used for filtering data.

real-time event A service that uses system calls to capture PeopleSoft EnterpriseOne transactions as
they occur and to provide notification to third-party software, end users, and other
PeopleSoft systems that have requested notification when certain transactions occur.

refresh A function used to modify PeopleSoft EnterpriseOne software, or subset of it, such
as a table or business data, so that it functions at a new release or cumulative update
level, such as B73.2 or B73.2.1.

replication server A server that is responsible for replicating central objects to client machines.

quote order In PeopleSoft EnterpriseOne Procurement and Subcontract Management, a request
from a supplier for item and price information from which you can create a purchase
order.
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In PeopleSoft EnterpriseOne Sales Order Management, item and price information for
a customer who has not yet committed to a sales order.

selection Found on PeopleSoft menus, a selection represents functions that you can access
from a menu. To make a selection, type the associated number in the Selection field
and press Enter.

ServerWorkbench An application that, during the InstallationWorkbench process, copies the server
configuration files from the Planner data source to the System-release number data
source. It also updates the Server Plan detail record to reflect completion.

spot rate An exchange rate entered at the transaction level. This rate overrides the exchange rate
that is set up between two currencies.

Specification merge Amerge that comprises three merges: Object Librarian merge, Versions List merge,
and Central Objects merge. The merges blend customer modifications with data that
accompanies a new release.

specification A complete description of a PeopleSoft EnterpriseOne object. Each object has its own
specification, or name, which is used to build applications.

Specification Table Merge
Workbench

An application that, during the InstallationWorkbench process, runs the batch
applications that update the specification tables.

store-and-forward The mode of processing that enables users who are disconnected from a server to enter
transactions and then later connect to the server to upload those transactions.

subscriber table Table F98DRSUB, which is stored on the publisher server with the F98DRPUB table
and identifies all of the subscriber machines for each published table.

supplemental data Any type of information that is not maintained in a master file. Supplemental data is
usually additional information about employees, applicants, requisitions, and jobs
(such as an employee’s job skills, degrees, or foreign languages spoken). You can track
virtually any type of information that your organization needs.

For example, in addition to the data in the standard master tables (the Address Book
Master, Customer Master, and Supplier Master tables), you can maintain other
kinds of data in separate, generic databases. These generic databases enable a
standard approach to entering and maintaining supplemental data across PeopleSoft
EnterpriseOne systems.

table access management
(TAM)

The PeopleSoft EnterpriseOne component that handles the storage and retrieval
of use-defined data. TAM stores information, such as data dictionary definitions;
application and report specifications; event rules; table definitions; business function
input parameters and library information; and data structure definitions for running
applications, reports, and business functions.

Table ConversionWorkbench An interoperability model that enables the exchange of information between
PeopleSoft EnterpriseOne and third-party systems using non-PeopleSoft
EnterpriseOne tables.

table conversion An interoperability model that enables the exchange of information between
PeopleSoft EnterpriseOne and third-party systems using non-PeopleSoft
EnterpriseOne tables.

table event rules Logic that is attached to database triggers that runs whenever the action specified by
the trigger occurs against the table. Although PeopleSoft EnterpriseOne enables event
rules to be attached to application events, this functionality is application specific.
Table event rules provide embedded logic at the table level.

terminal server A server that enables terminals, microcomputers, and other devices to connect to a
network or host computer or to devices attached to that particular computer.
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three-tier processing The task of entering, reviewing and approving, and posting batches of transactions in
PeopleSoft EnterpriseOne.

three-way voucher match In PeopleSoft EnterpriseOne Procurement and Subcontract Management, the process
of comparing receipt information to supplier’s invoices to create vouchers. In a
three-way match, you use the receipt records to create vouchers.

transaction processing (TP)
monitor

Amonitor that controls data transfer between local and remote terminals and the
applications that originated them. TP monitors also protect data integrity in the
distributed environment and may include programs that validate data and format
terminal screens.

transaction set An electronic business transaction (electronic data interchange standard document)
made up of segments.

trigger One of several events specific to data dictionary items. You can attach logic to a data
dictionary item that the system processes automatically when the event occurs.

triggering event A specific workflow event that requires special action or has defined consequences
or resulting actions.

two-way voucher match In PeopleSoft EnterpriseOne Procurement and Subcontract Management, the process
of comparing purchase order detail lines to the suppliers’ invoices to create vouchers.
You do not record receipt information.

User Overrides merge Adds new user override records into a customer’s user override table.

variance In Capital Asset Management, the difference between revenue generated by a piece of
equipment and costs incurred by the equipment.

In EnterpriseOne Project Costing and EnterpriseOne Manufacturing Management, the
difference between two methods of costing the same item (for example, the difference
between the frozen standard cost and the current cost is an engineering variance).
Frozen standard costs come from the Cost Components table, and the current costs are
calculated using the current bill of material, routing, and overhead rates.

Version List merge The Versions List merge preserves any non-XJDE and non-ZJDE version
specifications for objects that are valid in the new release, as well as their processing
options data.

visual assist Forms that can be invoked from a control via a trigger to assist the user in determining
what data belongs in the control.

vocabulary override An alternate description for a data dictionary item that appears on a specific PeopleSoft
EnterpriseOne or World form or report.

wchar_t An internal type of a wide character. It is used for writing portable programs for
international markets.

web application server Aweb server that enables web applications to exchange data with the back-end
systems and databases used in eBusiness transactions.

web server A server that sends information as requested by a browser, using the TCP/IP set of
protocols. A web server can do more than just coordination of requests from browsers;
it can do anything a normal server can do, such as house applications or data. Any
computer can be turned into a web server by installing server software and connecting
the machine to the internet.

Windows terminal server Amultiuser server that enables terminals and minimally configured computers to
displayWindows applications even if they are not capable of runningWindows
software themselves. All client processing is performed centrally at theWindows
terminal server and only display, keystroke, and mouse commands are transmitted over
the network to the client terminal device.
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workbench A program that enables users to access a group of related programs from a single
entry point. Typically, the programs that you access from a workbench are used to
complete a large business process. For example, you use the EnterpriseOne Payroll
Cycle Workbench (P07210) to access all of the programs that the system uses to
process payroll, print payments, create payroll reports, create journal entries, and
update payroll history. Examples of PeopleSoft EnterpriseOne workbenches include
Service Management Workbench (P90CD020), Line SchedulingWorkbench (P3153),
PlanningWorkbench (P13700), Auditor’s Workbench (P09E115), and Payroll Cycle
Workbench.

work day calendar In EnterpriseOneManufacturing Management, a calendar that is used in planning
functions that consecutively lists only working days so that component and work order
scheduling can be done based on the actual number of work days available. A work
day calendar is sometimes referred to as planning calendar, manufacturing calendar, or
shop floor calendar.

workflow The automation of a business process, in whole or in part, during which documents,
information, or tasks are passed from one participant to another for action, according
to a set of procedural rules.

workgroup server A server that usually contains subsets of data replicated from a master network server.
A workgroup server does not perform application or batch processing.

XAPI events A service that uses system calls to capture PeopleSoft EnterpriseOne transactions as
they occur and then calls third-party software, end users, and other PeopleSoft systems
that have requested notification when the specified transactions occur to return a
response.

XMLCallObject An interoperability capability that enables you to call business functions.

XMLDispatch An interoperability capability that provides a single point of entry for all XML
documents coming into PeopleSoft EnterpriseOne for responses.

XMLList An interoperability capability that enables you to request and receive PeopleSoft
EnterpriseOne database information in chunks.

XML Service An interoperability capability that enables you to request events from one PeopleSoft
EnterpriseOne system and receive a response from another PeopleSoft EnterpriseOne
system.

XMLTransaction An interoperability capability that enables you to use a predefined transaction type to
send information to or request information from PeopleSoft EnterpriseOne. XML
transaction uses interface table functionality.

XMLTransaction Service
(XTS)

Transforms an XML document that is not in the PeopleSoft EnterpriseOne format into
an XML document that can be processed by PeopleSoft EnterpriseOne. XTS then
transforms the response back to the request originator XML format.

Z event A service that uses interface table functionality to capture PeopleSoft EnterpriseOne
transactions and provide notification to third-party software, end users, and other
PeopleSoft systems that have requested to be notified when certain transactions occur.

Z table Aworking table where non-PeopleSoft EnterpriseOne information can be stored and
then processed into PeopleSoft EnterpriseOne. Z tables also can be used to retrieve
PeopleSoft EnterpriseOne data. Z tables are also known as interface tables.

Z transaction Third-party data that is properly formatted in interface tables for updating to the
PeopleSoft EnterpriseOne database.
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A
absolute position, activating 89
accounting periods, assigning to column
headings 161
Acrobat Reader form 166
action messages
defining in business functions 237
definition 232
understanding 233

Add Argument List form 255
Add EnterpriseOne Object to the project
form 18
Add Object form 18
additional documentation xx
Additional Properties form 48
additional properties, defining for
application reports 48
Adobe Acrobat Reader, viewing
reports 49
Advance Section event
description 215
values held in the runtime
structures 222, 224, 228

Advanced Operations form 149
After Last Object Printed event
description 215
values held in the runtime
structures 224, 227

aggregates
descriptions 114
selecting operators and operands 115

Aggregations form 113, 115
Align Objects form 86
alignment
aligning fields within or across
sections 86
justifying text 99
setting the grid alignment 56

Alignment Grid form 56
alpha variables
description 66

alternative descriptions
setting up for business view
favorites 128

API

adding records to the subsystem
table 179, 180
definition 174

application fundamentals xix
Application Programming Interface, See
API
application reports
creating 43
creating calculation columns 47
creating with the Report Director 43
defining additional properties 48
defining level breaks 48
defining page breaks 48
defining sort properties 48
description 27
selecting records to include 48
selecting Report Director templates 45

Arabic 20
Assignment form 142, 143, 145
assignments
creating in event rules 142
understanding 140
using in level break footers 114

Associated Description Properties
form 115
associated descriptions
adding to level break headers 115
understanding 113

asynchronous
defining for report interconnects 246
processing subsystem jobs 177

asynchronous processing 245
attachments, adding and deleting 106
audit trails, reviewing 166
automatically generated rows 76, 79

B
bar code fonts, setting up 95
Batch Application Design form 18
batch error messages
calling Work Center APIs 233
first-level messages 232
second-level messages 232
third-level messages 233
understanding 231
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understanding components 234
using action messages 233
using level break messages 232
using text substituted messages 233

batch events
additional batch events 214
Do Section 214
report level events 214
section level events 215
understanding 214
using system functions 219

batch processes
creating as subsystem jobs 177
creating in Report Design Aid 201

batch processing
processing batch events 214
processing data selection and data
sequencing 209
processing events and attached event
rules 221
processing level break sections 211
processing report sections 202
processing sections 204
understanding 201
using database output to update the
database 173

batch runtime processing
objects available 221
understanding 221

batch versions
copying XJDE and ZJDE versions 19
creating from the Report Director 31,
35, 40, 48
definition 7
deleting from multiple locations 17
opening 17

Before Level Break event
description 215
values held in the runtime
structures 223, 225

boxes
associating with data fields 101
understanding 101

BrowsER
accessing for a report template 150
accessing for report templates 149
understanding 149

Browsing form 150
Business Function Design form 180
Business Function Search form 160

Business Functions form 160
business functions, creating for level break
messages 235
Business View Column Browser, showing
and hiding 56
business view columns
adding and removing in detail
sections 21
selecting for columnar sections 29
selecting for group sections 34
selecting for tabular sections 39
understanding 65

business view favorites
adding business views 126
adding notes 127
adding to favorites folders 124
adding to favorites subfolders 125
modifying and deleting notes 128
selecting 23, 46
setting up 123
setting up alternative descriptions 128
understanding 123
viewing alternative descriptions 130

Business View Selection Option form 29
business views
adding to favorites folders and
subfolders 126
selecting for columnar sections 29
selecting for detail sections 20, 23
selecting for group sections 34
selecting for tabular sections 39
selecting from favorites 23, 46
selecting from the Favorite Business
Views tab 23
selecting from the Select Business View
tab 23
setting up favorites 123
understanding business view
columns 65
using in subsection joins 135

C
calculation columns
creating in tabular sections 47
defining 74
removing calculations 74
understanding 73

Calculation Row Properties form 78
calculation rows
adding 78
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overriding variable properties 82
overriding variables 82
understanding 76

cAllowUserIdToChange parameter 239
Cell Properties form 81
cells
defining 80
defining in tabular sections 71
overriding calculation row variables 82
overriding constant row variables 82
overriding data row variables 81
overriding properties 80
overriding underline row variables 82

child sections
available events 196
understanding 135

colors
for fonts 93
supported for printing 93

Column Data Selection form 47
Column Heading Properties form 69
column headings
assigning account periods 161
changing text 68
in columnar sections 9
naming smart field columns 46
renaming the Row Description
column 43

Column Inclusion event
comparing to the Do Section event 147
using 147

column properties
understanding 59
viewing and modifying 62
viewing from the column tab 62

column spacing, changing 90
Column Variable Properties form 72
column width, changing 88
columnar section
changing the length of fields 88

Columnar Section form 60
Columnar Section Spacing form 91
columnar sections
adding and removing business view
columns 21, 65
adding and removing data fields 68
available events 196
changing the width of columns 88
characteristics of 9
creating level break headers 114

creating with the Report Director 28
deciding when to use 9
defining 28
defining data selection 21
defining data sequencing 21
defining sort order 21
defining sort properties 21
displaying conditionally 84
filtering data 21
hiding 84
modifying row spacing 90
processing 205
renaming 83
reprinting last line on next page 102
selecting business views 20
setting up totals 9
using in subsection joins 136

columns
adding and removing business view
columns 21
aligning within or across sections 85,
86
changing spacing 89
creating calculations 73
defining in tabular sections 71
defining percentages 75
modifying column width 87
understanding smart fields 119
using Row Description columns 74

comments
adding to reports 105
adding, modifying, and deleting on a data
field 106

comments, submitting xxiv
common elements xxv
company title
description 67
See Also runtime fields

constant events 218
Constant Row Properties form 79
constant rows
adding 79
overriding variable properties 82
overriding variables 82

constants
description 66

contact information xxiv
Copy Object form 18
Create New Report form 17
Create New Smart Field form 121
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Criteria Design form 142
cross-references xxiii
CSV
setting the grid alignment 55
showing the Tip Dialog box 54

custom sections
attaching logic 148, 209
available events 196
creating 148
understanding 148, 209

Customer Connection website xx

D
Data Dictionary Browser form 170
Data Dictionary Browser, showing and
hiding 56
data dictionary fields
creating for level break messages 234
description 67
showing and hiding text overrides 55
using to create event rule variables 146

Data Dictionary Item Type form 253, 256
data fields
adding and removing 68
aligning within or across sections 85
associating boxes and lines 101
changing colors 94
changing decimal scaling for 72
changing font properties 94
changing names of 69
inserting into columnar sections 68
inserting into page footers 109
inserting into page headers 109
inserting into report footers 109
inserting into report headers 108
justifying text (alignment) 99
modifying field length 87
types of 66
understanding 66

Data Item Specifications form 253, 256
Data Row Properties form 77
data rows
adding 77
overriding variable properties 81
overriding variables 81
understanding 76

data selection
defining in columnar, group, and tabular
sections 21
processing of 209

Data Selection form 25
data sequencing
defining in columnar sections 21, 30
defining in group sections 21, 34
defining in subsection joins 137
defining in tabular sections 21, 39
defining using the Advanced Option 48
processing of 209

Data Sequencing form 24
Data Sequencing Help form 43
Data Structure:Level break message
form 240
data structures
creating for level break message business
functions 235
creating for text substituted level break
messages 234
creating processing option data
structures 169

data, filtering in columnar, group, and
tabular sections 21
database maintenance
using database output 173
using table conversions 173
using table I/O (in event rules) 173

database output
description 174
updating the database using batch
applications 173
updating, inserting, and deleting
records 173
working with 173

Date Title Preview form 158
Date Title Revisions form 157
Date Title Search form 160
date titles
adding to financial reports 160
assigning accounting periods to column
headings 161
customizing 157
defining custom 157
description 133
previewing 158
shipped with the software 155
using in financial reports 156

date variable data fields 67
date variables
description 66

decimal scaling
changing for all fields in a report 73
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changing for all fields in a section 72
changing for individual fields 72
definition 72

default report settings 16
Define Calculation form 47
Define Sort Properties form 30, 35, 40
Define Sub Section Join form 137
Delete of form 19
dependent sections, See report sections
description columns, See Row Description
columns
descriptions, associating in level break
headers 115
detail sections
adding and removing business view
columns 21, 65
adding columns using Quick Section 24
adding from the menu 20, 23
adding in Report Design Aid 20
changing descriptions 84
definition 8
design capabilities 8
displaying conditionally 84, 85
hiding 84
joining 137
renaming 83
setting page breaks 102

Director, See Report Director
Director templates, See Report Director
templates
Director’s Finish form 31
display tree, showing and hiding 56
Do Balance Auditor event,
description 215
Do Initialize Printer event,
description 215
Do Section event
description 215
understanding 214
values held in the runtime
structures 223, 226

Do Tabular Break event, description 215
documentation
printed xx
related xx
updates xx

double byte fonts
aligning 99
understanding 93

drill down

activating 163
defining 164, 165
description 133
understanding 163

dynamic positioning
activating 96
applying font substitutions to report
templates 98
defining font substitutions 96
overriding font substitutions 98
understanding 95

E
edit codes
selecting 193
understanding 193

End Break Section event, description 216
End Lvl Brk Footer Section event 213
description 216

End Lvl Brk Header Section event 213
description 216

End Report event, description 215
End Section event, description 216
error messages, See batch error messages
event flow
processing the Advance Section
event 222, 224, 228
processing the After Last Object Printed
event 224, 227
processing the Before Level Break
event 223, 225
processing the Do Section event 226
processing the Initialize Section
event 222

event levels
object events for constants 199
object level events for variables 198
report level events 196
section level 196
understanding 196

event rule assignments, creating 143
event rule variables
creating 146
naming 146
understanding 146

event rules
calling system functions in 144
changing sequence 142
creating assignments 142
creating event rule variables 146
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creating for processing options 195
creating if/while statements 139
description 133
selecting from available fields 140
understanding 139
understanding events 195
using Column Inclusion or Do
Section 147
using text variables in 143

Event Rules Design form 142, 246
Event Rules Variables form 147
events
constants and variables 218
object level events for constants 199
object level events for variables 198
page footer section 217
page header section 216
report footer section 217
report header section 217
report level 196
section level 196, 215
understanding 195

Expression Manager form 74, 78, 82
expressions, understanding 140

F
favorite business views, See business view
favorites
selecting from the Favorite Business
Views tab 23

field length, changing 88
field properties, viewing 59
fields
aligning within or across sections 85,
86
changing font properties 94
descriptions of prefix codes 140
justifying text 99
modifying length 87
selecting for detail section layout 21

Fields tab, Columnar Section form 62
Financial Account Level of Detail Row
Generation form 79
financial report date titles 156
first-level messages, understanding 232
See Also level break messages

Font form 99
font properties
changing for all fields in a report 94
changing for all fields in a section 94

changing for an individual field 94
Font Substitution by Language Revisions
form 97
Font Substitution by Language Type
Revisions form 98
font substitutions
applying to report templates 98
defining 96
defining for language and line
printers 97
modifying 97
overriding 98
viewing by language type 97

fonts
activating dynamic positioning 95
aligning bar codes 99
aligning double byte 99
assigning by language 99
changing properties 91
changing when printing 95
selecting colors 93
setting up bar codes 95
understanding barcodes 94
understanding defaults 16
understanding double byte 93
understanding proportional and
nonproportional 91
using True Type 98

footer sections
characteristics of page footers 12
characteristics of report footers 12
creating 107
defining level break fields 8
understanding page footers 7
understanding report footers 7

Form Interconnections form 164, 165

G
general, description of system
functions 219
Glossary Items form 240
grid alignment, setting 56
Group Section form 60
group sections
adding and removing business view
columns 21, 65
adding using Report Design Aid 20
available events 196
characteristics 9
creating level break headers 114
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creating with the Report Director 33
deciding when to use 10
defining 33
defining data selection 21
defining data sequencing 21
defining sort order 21
defining sort properties 21
displaying conditionally 84
filtering data 21
hiding 84
processing 205
renaming 83
reprinting last line on next page 102
selecting business views 20
setting up totals 10
typical event flow 222
using in subsection joins 136

H
header sections
characteristics 12
creating 107
defining level break fields 8
populating page headers
automatically 29
understanding page headers 7
understanding report headers 7

Help with Section Data Selection form 48

I
if/while statements
creating in event rules 142
understanding 140

independent sections, See report sections
Init Break Section event, description 216
Init Lvl Brk Footer Section event
understanding 213

Init Lvl Brk Footer Section event,
description 216
Init Lvl Brk Header Section event
understanding 213

Init Lvl Brk Header Section event,
description 216
Initialize Report event, description 215
Initialize Section
values held in the runtime
structures 222

Initialize Section event
description 216

invisible sections
defining in properties 85
showing and hiding 55

J
JDE.DataItem Properties form 170
Job Submission form 95
joined sections
attaching logic 208
modifying and severing 137
processing 208
understanding the join 136

L
Language Font Revisions form 99
language, setting up alternative descriptions
for business view favorites 128
level break fields
defining 114
hiding in the detail section 115
in application reports 43
in tabular sections 38, 40

Level Break Footer form 115
level break footers
available events 196
creating 115
defining for group and columnar
sections 115
defining level break fields 8
inserting descriptions 116
modifying 114
reprinting at page break 116
selecting aggregates 115
selecting operators 113
understanding 113
using assignments in 114

Level Break form 114, 115
level break headers
associating descriptions 115
available events 196
creating 114
defining for group and columnar
sections 114
defining level break fields 8
modifying 114
understanding 111, 112

level break messages
creating business function data structures
for 235
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creating business functions for 235
creating data items for 234
creating data structures for 234
defining level of messages 232
understanding 232
understanding components 234
using action messages 233

level break processing
End Lvl Brk Header Section and End Lvl
Brk Footer Section events 213
understanding 211

level break section events
End Lvl Brk Header Section and End Lvl
Brk Footer Section 213
Init Lvl Brk Footer Section 213
Init Lvl Brk Header Section 213
understanding 213

level break sections
defining for columnar sections 9
defining for group sections 10
Init Lvl Brk Footer Section event 213
Init Lvl Brk Header Section 213
processing 211
processing events 213

level breaks fields
defining in application reports 48

levels, understanding 111
lines
associating with data fields 101
understanding 101

List of values form 23
logic 8
See Also event rules
creating for custom sections 148, 209
creating in joined sections 208
understanding processing option
logic 195

M
Mapping Targets form 175
Mappings form 175
margins, showing and hiding 55
media objects, description of system
functions 219
messages
action messages 233
batch error messages 231
level break messages 232
text substituted messages 233

understanding level break
messages 232

messaging
batch error messages 231
description of system functions 219

MMA Partners xx

N
Named Event Rules Design form 256
Named Mapping form 255
naming conventions
event rule variables 146
modifying batch versions beginning with
XJDE and ZJDE 19
naming report objects 15
Report Director templates 183

Navigation Assistant
showing and hiding 55
understanding user options for 54

notes xxiii
adding to favorites, folders, and
subfolders 127
modifying and deleting from favorites,
folders, and subfolders 128

Notes Revisions form 127
number of non optimized inclusion
rows 77
number of optimized inclusion rows 77
numeric fields
changing decimal scaling for 72
changing the appearance of 100
understanding formatting 100

numeric variable data fields 67
numeric variables
description 66
formatting 100

O
Object Design Properties form 62
Object Folder Revisions form 124
object level events
descriptions of constant and variable
events 218
events available for constants 199
events available for variables 198

Object Management Workbench form 18
Object Management Workbench, creating
report objects 18
objects
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batch runtime processing 221
creating in Object Management
Workbench 18
description of system functions 219
naming 15
understanding in PeopleSoft
EnterpriseOne 7
See Also report objects

working with 65
optimize rows, understanding 77

P
page breaks
defining in application reports 48
inserting manually 102
understanding manual page breaks 102

page footer events 217
Page Footer form 109
page footers
available events 196
characteristics 12
creating 109
example 12
understanding 107
using data fields in 109

Page Header Details form 29, 34, 38, 46
page header events, descriptions of
each 216
Page Header form 109
page headers
adding data fields 66
available events 196
characteristics 12
creating 108
populating automatically 29
understanding 107
using data fields 109

Page n of Total, description 67
See Also runtime fields

page number data fields 67
page number, description 67
See Also runtime fields

parent sections
understanding 135

parent/child relationships, subsection
joins 135
PeopleBooks
ordering xx

PeopleCode, typographical
conventions xxii
PeopleSoft application fundamentals xix
PeopleSoft Report Design Aid form 17
percent calculations, defining 76
percentages, calculating 75
performance enhancement in tabular
sections, row optimization 77
prefix codes, descriptions 140
prerequisites xix
preview
changing number of lines to display 55
previewing date titles 158
previewing reports from Report Design
Aid 50

printed documentation xx
printing
colors supported 93
printing text attachments on reports 152
repeating the last line of a page as the
first line on the succeeding page 102

Processing Option Design form 169
processing option logic
adding to the report 171
understanding 195

processing option template
adding logic to the report 171

processing option templates
adding tabs 170
attaching to report templates 170
creating 169
description 133
designing 168
guidelines for basic event rules 195
understanding 167

properties
changing fonts 91
changing fort properties 94
defining sort properties 21
overriding cell properties 80
understanding report object
properties 83
understanding report properties 60
understanding section properties 60
viewing column properties 62
viewing field properties 62
viewing row properties 63

Properties form 60, 180
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Purge Financial Reporting Drill Down
Work File form 166

Q
Quick Section form 21
Quick Section, using to add business view
columns to detail sections 24

R
Range of Values form 22
records
selecting to include in columnar
sections 30
selecting to include in group
sections 35
selecting to include in tabular
sections 40

Refresh Section event, description 216
related documentation xx
report components, understanding 6
Report Data Structure form 180
report date, description 67
See Also runtime fields

report design
adding and removing attachments and
comments 105
creating report models 13
determining report sections 14
guidelines 71
surveying stakeholders 13
understanding the process 13

Report Design Aid
configuring the design workspace 53
creating batch processes 201
understanding 5
understanding the design workspace 53

Report Director
creating application reports 43
creating columnar sections 28
creating detail sections using 20
creating group section reports 33
creating tabular sections 38
customizing directors 6
understanding 27
viewing results 50

Report Director forms
Column Data Selection 47
Define Calculation 47
Define Sort Properties 30, 35, 40

defining Smart Field Parameters 47
Page Header Details 46
Section Data Sequencing 48
Section Layout 29, 34, 39
Smart Field Data Selection 47
understanding 6

Report Director templates
adding 185
adding and modifying 183
description 134
selecting 45
understanding 27, 183

Report Director Templates Revisions
form 184
report footer events 217
Report Footer form 109
report footers
available events 196
characteristics 12
creating 109
example 12
understanding 107
using data fields 109

report header events 217
Report Header form 108
report headers
available events 196
characteristics 11
creating 108
example 11
understanding 107
using data fields 108

report interconnects
asynchronous and synchronous
processing 245
creating 246
in batch applications 245
understanding 245

report level events
descriptions of each 214
events available 196

report objects
available for batch processing 221
business view columns 65
creating from Object Management
Workbench 18
creating from Report Design Aid 17
data fields 65
definition 7
deleting 19
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deleting from multiple locations 17
description of alphabetical codes 221
descriptions of each type 66

report planning checklist 14
Report Preview form 50
report processing
asynchronous and synchronous report
interconnects 245
optimizing tabular row processing 77
overview 6
processing events 214
processing level breaks 211
processing sections 202, 204
understanding 201

report sections
adding and removing business view
columns 68
adding lines and boxes 101
aligning fields across 87
aligning fields within 87
changing decimal scaling in tabular
sections 72
changing font properties 94
characteristics of columnar sections 9
characteristics of group sections 9
characteristics of page footers 12
characteristics of page headers 12
characteristics of report footers 12
characteristics of report headers 11
characteristics of tabular sections 10
creating logic for custom sections 148
creating totals for columnar and group
sections 69
custom sections 148, 209
definition 7
dependent (level-two) sections 202
determining sections required 14
hiding unconditionally 84
independent (level-one) sections 202
inserting additional sections 6
joining 135
joining sections in a report 133
modifying column spacing 90
parent sections 202
processing 202
selecting smart fields 46
showing and hiding 84
showing and hiding conditionally 85
showing and hiding titles 55
showing and hiding unconditionally 85

understanding properties 60
viewing event rules 149

report templates
accessing BrowsER 149
applying font substitution 98
changing decimal scaling 73
changing font properties 94
default settings 16
definition 7
deleting 19
deleting from multiple locations 17
opening 17
reviewing event rules 150
reviewing results 49
saving 49

report time, description 67
See Also runtime fields

report title, description 67
See Also runtime fields

reports
section processing 204

reports, understanding default settings 16
See Also report templates

right margin, showing and hiding 55
Row Description columns
creating 75
deleting 75
including in application reports 43
including in tabular sections 11
working with 74

row optimization 77
row properties
viewing 59, 63
viewing from section properties 63

row spacing
changing in columnar sections 90
changing in tabular sections with added
rows 91

rows
adding calculation rows 78
adding constant rows 79
adding data rows 77
adding manually 77
adding sum rows 78
adding underline rows 79
changing spacing 90
defining in tabular sections 71
generating automatically 79
modifying spacing 91

rulers, showing and hiding 55
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runtime engine 222
runtime fields
company title 67
Page n of Total, 67
page number 67
report date 67
report time 67
report title 67

runtime structures
Do Section event 223
values held after processing the Advance
Section event 222, 224, 228
values held after processing the After
Last Object Printed event 224, 227
values held after processing the Before
Level Break event 223, 225
values held after processing the Do
Section event 226
values held after processing the Initialize
Section event 222

S
second-level messages,
understanding 232
See Also level break messages

section data selection, defining 25
See Also data selection

section data sequencing, defining 24
See Also data sequencing

Section Layout form 29, 34, 39
section level events
descriptions of each 215
Do Section 214
events available 196
level break section 213
page footer events 217
page header events 216
report footer events 217
report header events 217

section processing
processing data selection and data
sequencing 209
processing group and columnar
sections 205
processing joined sections 208
processing tabular sections 207
understanding 204

section properties, viewing 59
section titles, showing and hiding 55
sections

description of system functions 219
selecting for columnar section
reports 29
selecting for group section reports 34
selecting for tabular section reports 38
showing invisible sections 55
understanding 7
See Also report sections

Select a Column form 255
Select a Table form 255
Select Business View form 23
Select Columns form 46
Select Processing Option Template
form 171
Select User Defined Code form 169
Single Value form 160
Smart Field Criteria form 251
Smart Field Data Selection form 47
Smart Field Name form 46
Smart Field Parameters form 47
Smart Field Template Revisions form 257
smart field templates
creating 257

smart fields
adding and deleting in report
sections 121
adding to report sections 121
adding to reports 119
creating custom 248
creating templates 27
selecting templates 120
selecting to include in report
sections 46
understanding 119, 247
using in application reports 44

sort properties
defining 30, 35, 40
defining for an application report 48
understanding 21

Sub Section Join form 136
Submit Job-Submitted Job Search
form 166
Submit Job-Work With Batch
Versions-Available Versions form 166
subsection joins
creating 135, 136
defining data sequencing 137
description 133
joining existing detail sections 135
modifying and severing 137
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understanding parent/child
sections 135

subsystem jobs
adding API records to the subsystem
table 180
adding records to the subsystem table
using API 179
defining 180
processing asynchronously 177
understanding 177
understanding definitions 179

subsystem table, adding API records 179,
180
suggestions, submitting xxiv
Sum Row Properties form 78
sum rows
adding 78
understanding 76

Suspend Section event, description 216
synchronous processing 245
system functions
attaching to an event 144
descriptions of categories 219
understanding 140
using in batch events 219
using in event rules 145

System Functions form 145, 152

T
Tab Properties form 169
table conversions
description 173
using to maintain the database 173

Table I/O, description 174
tabs
adding to processing option
templates 170
showing and hiding in Report Design
Aid 55

tabular optimization 77
tabular reports
creating with the Report Director 38
defining 38

Tabular Section form 60
tabular sections
activating drill down 163
adding and removing business view
columns 21, 65
adding using Report Design Aid 20
advantages of using 11

automatic totalling 38
available events 196
changing decimal scaling 72
characteristics 10
deciding when to use 11
defining calculation columns 74
defining data selection 21
defining data sequencing 21
defining drill down 165
defining percent calculations 76
defining sort order 21
defining sort properties 21
design capabilities 11
filtering data 21
hiding 84
including RowDescription columns 11,
74
including totals 11
modifying column spacing 90
modifying row spacing 91
optimizing tabular row processing 77
overriding cells 81
overriding properties of cells 80
processing 207
renaming 83
reviewing audit trails 166
section properties 61
selecting business views 20
selecting records 40
understanding 37
understanding columns, rows, and
cells 71
using spreadsheet functionality 38
working with objects 71
working with objects unique to tabular
sections 71
working with rows 76

templates, See processing option templates,
Report Director templates, report
templates, smart field templates
text
default settings 16
disconnecting from variable in group
sections 69
justifying 99, 100
wrapping 89

text attachments
adding to reports 151
description 134
printing on reports 152
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text justification
changing for variables 100
understanding 99

text overrides, showing and hiding 55
text substituted messages
creating business function data structures
for 235
creating data items for 234
creating data structures for 234
understanding 233

text variables
adding and using 143
creating 143
description 67
understanding 143
using in event rules 144

Text Variables form 144
text wrapping, activating 89
See Also absolute position

third-level messages, understanding 233
See Also level break messages

titles, showing and hiding 55
totals
defining for columnar sections 9
defining for group sections 10
including in tabular sections 11
performing in-section totaling 69
selecting operators and operands 115

transaction processing
defining for report interconnects 246
description of system functions 219

typical event flow for group sections 222
typographical conventions xxii

U
UBE log file, locating number of optimized
rows 77
UBE, report object type 7, 16
Underline Row Properties form 79
underline rows
adding 79
overriding variables and variable
properties 82
understanding 76

User Defined Codes form 169
User Options form 50
user options, setting 55

V
variable events 218
Variable Options Selection form 147
versions, See batch versions
visual cues xxiii

W
warnings xxiii
Welcome to the Report Design Director
form 27
Work Center
APIs 233
calling initialization API for batch error
messages 239
calling processing API for batch error
messages 239

Work With Applications form 165, 246
Work With Column Headings form 161
Work With Favorites Description
Translation form 124, 128
Work With Favorites form 124
Work with Font Substitution by Language
Type form 97
Work with Fonts form 98
Work With Forms form 165
Work With Smart Field Templates
form 253
Work With Versions form 165, 246
workflow, description of system
functions 219
workspace, configuring 53
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